Score Layout and Printing
Table of Contents
# Table of Contents

## 7 How the Score editor works
- In this chapter you will learn:
  - Welcome!
  - How the Score editor operates
  - MIDI Notes vs. Score Notes
  - Display Quantize
  - Entering Notes by hand compared with Recording them

## 17 The Basics
- In this Chapter you will learn:
  - Preparations
  - Opening the Score editor
  - The Project cursor
  - Page Mode
  - Changing Magnification
  - The Active staff
  - Making Page Setup settings
  - Designing your Work Space
  - About dialogs in the Score editor
  - Setting key, clef and time signature
  - Working with Transposing Instruments
  - Working Order
  - Force Update

## 41 Transcribing MIDI recordings
- In this chapter you will learn:
  - About transcription
  - Getting the parts ready
  - Strategies: Preparing parts for score printout
  - Staff Settings

## 54 Situations which require Additional Techniques
- Inserting Display Quantize Changes
- Strategies: Adding Display Quantize changes
- The Explode Function
- Using “Scores Notes To MIDI”

## 61 Entering and editing notes using the mouse
- In this chapter you will learn:
  - Staff Settings
  - Note values and positions
  - Adding and editing notes
  - Selecting notes
  - Deleting Notes
  - Moving Notes
  - Duplicating notes
  - Moving using the bar handles
  - Cut, Copy and Paste
  - Editing Pitches of Individual Notes
  - Changing the Length of Notes
  - Splitting a Note in two
  - Working with the Quantize tool
  - Split (Piano) staves
  - Strategies: Multiple staves
  - Inserting and editing clefs, keys or time signatures

## 91 Staff Settings
- In this Chapter you will learn:
  - Staff Settings
  - Making Settings
235 Working with Layouts
236 In this chapter you will learn:
236 Background: Layouts
237 Creating a Layout
238 The Layout List
239 Using Layouts – An example
240 Marker Track to Form

241 Designing your Score - Additional Techniques
242 In this chapter you will learn:
242 Layout Settings
245 Staff Size
246 Hiding/Showing Items
249 Multiple Rests
251 Adding and Editing Bar Lines
253 Creating Upbeats
256 Setting the number of bars across the page
258 Moving Bar Lines
260 Dragging staves
263 Adding Brackets and Braces
264 Auto Layout
267 Clean Up Layout
268 Breaking Bar Lines

271 Scoring for Drums
272 In this chapter you will learn:
272 Background: The drum maps and Score edit
275 Setting up the Drum Map
278 Setting up a staff for Drum Scoring
279 Entering and Editing Notes
279 Using Single Line Drum staff

281 Creating Tablature
282 In this chapter you will learn:
282 Automatic Creation
286 Manual Creation
287 Tablature Number appearance
288 Editing
289 Note Head Shape

291 Printing and Exporting Pages
292 Printing
292 Exporting pages as image files

295 Troubleshooting
296 In this chapter you will learn:
296 How to use this Chapter
296 Adding and Editing Notes
299 Symbols and Layout

301 Tips and Tricks
302 In this chapter you will learn:

307 Index
1

How the Score editor works
In this chapter you will learn:

• How the Score editor and MIDI data relate.
• What Display Quantize is and how it works.

Welcome!

Welcome to scoring in Cubase SX! The Score editor has been created to allow you to get any possible piece of music displayed as a score, complete with all the symbols and formatting needed. It allows you to extract parts out of a full orchestra score, to add lyrics and comments, create lead sheets, score for drums, create tablature, etc. In other words: just about any type of notation you could ever desire! There are a few basic principles to how the Score editor works, which you just have to understand to make full use of it. So please bear with us during this chapter, we’ll try to be as concise as possible.

How the Score editor operates

The Score editor basically does the following:

• Reads the MIDI notes in the MIDI parts.
• Looks at the settings you have made.
• Decides how the MIDI notes should be displayed according to the settings.

Score edit takes MIDI data and settings as input and produces a Score as output.

Score edit does all this in real time. If you change some of the MIDI data (for example by moving or shortening a note) this is immediately reflected in the score. If you change some of the settings (for example the time signature or key signature) this is also immediately apparent. You should not think of Score edit as a drawing program, but rather as an “interpreter” of MIDI data.
MIDI Notes vs. Score Notes

MIDI tracks in Cubase SX hold MIDI notes and other MIDI data. As you may know, a MIDI note in Cubase SX is only defined by its position, length, pitch and velocity. This is not nearly enough information to decide how the note should be displayed in a score. The program needs to know more: What type of instrument are we talking about, Drums? Piano? What key is the piece in? What is the basic rhythm? How should the notes be grouped under beams? etc. You provide this information by making settings and working with the Tools available in the Score editor.

An example of the MIDI/Score relation

When Cubase SX stores a MIDI note’s position it makes the measurement in an absolute value, called ticks. There are 480 ticks to a quarter note. Have a look at the example below.

A quarter note at the end of a 4/4 measure.

The note is on the fourth beat of the measure. Now, let’s say you change the time signature to 3/4. This shortens the length of a “measure” to only three quarter notes - 1440 ticks. Suddenly our quarter note is in the next measure:

The same note in 3/4.

Why? Because by changing the time signature you are not changing the MIDI data in the track/part (since that would ruin your recording!), the note is still at the same absolute position. It’s just that now each “measure” is shorter, which effectively moves the note in the score.

What we are trying to get across here is that Score editor is an “interpreter” of the MIDI data. It follows rules that you set up by making settings in dialog boxes, on menus, etc. And this interpretation is “dynamic”, or in other words, it is constantly updated whenever the data (the MIDI notes) or the rules (the Score settings) change.
Display Quantize

Let’s say you used the Project window to record a figure with some staccato eighth notes. When you open the Score editor it displays it like this:

This doesn't look anything like what you intended. Let’s start with the timing - obviously, you were off at a couple of places (the third, fourth and last note all seem to be a 1/32nd note late). You could solve this by quantizing the figure, but this could make the passage sound too “stiff”, and not fit in the musical context. To resolve this problem the Score editor employs something called “Display Quantize”.

Display Quantize is a setting which is used to tell the program two things:

- How precise Score edit should be when displaying the note positions.
- The smallest note values (lengths) you want displayed in the score.

In the example above, the Display Quantize value seems to be set to 1/32nd notes (or a smaller note value). When reading the following chapters you will find out how to set the Display Quantize value yourself.

Let’s say we change the Display Quantize value to sixteenth notes in the example:

With Display Quantize set to sixteenth notes.
OK, now the timing looks right, but the notes still don’t look like you intended. Maybe you can understand that from a computer’s point of view, you did play sixteenth notes, which is why there is a lot of pauses. But that’s not how you meant it. You still want the track to play back short notes, because it is a staccato part, but you want something else “displayed”. Try setting the Display Quantize value to eighth notes instead:

With Display Quantize set to eighth notes.

Now we have eighth notes, as we wanted. All we have to do now is to add staccato articulation which can be done with one simple mouse click using the Pen tool (you will find out about this in “Working with symbols”).

How did this work? By setting the Display Quantize value to eighth notes you give the program two instructions, that would sound something like this in English: “Please, display all notes as if they were on exact eighth note positions, regardless of their actual positions” and “Please, don’t display any notes smaller than eighth notes, regardless of how short they are”. Please note that we used the word display, which leads us to one of the most important messages of this chapter:

*Setting a Display Quantize value does not alter the MIDI notes of your recording in any way, as regular quantizing does. It only affects how the notes are displayed in Score edit (and nowhere else)!*
Choose your Display Quantize values with care

As explained above, the Note Display Quantize value puts a restriction on the “smallest” note value that can be displayed. Let’s for a second look what happens if we set it to quarter notes:

![Quarter Note Example]

With Display Quantize set to quarter notes.

Oops, this doesn’t look too good. Well of course it doesn’t! We have now instructed the program that the “smallest” note that occurs in the piece is a quarter note. We have explicitly told it that there are no eighth notes, no sixteenths, etc. So when the program draws the score on screen (and on paper) it quantizes the display of all our eight notes to quarter note positions, which makes it look like above. But again, please note that when you hit Play, the passage will still play as it originally did. The Display Quantize setting only affects the score image of the recording. One last important note:

- Even if you enter notes using the mouse and input perfect note values, it is very important that you have your Display Quantize settings right! These values are not just used for MIDI recordings! If you for example set Note Display Quantize to quarter notes and start clicking in eight notes, you will get eighth notes in the track (as MIDI data), but still only quarter notes in the display!

Using Rest Display Quantize

Above we use Display Quantize for notes. There is a similar setting called “Rest” Display Quantize which is used to set the smallest rest to be displayed. Often, this setting is very effective:

What if the original note example looked like this:

![Rest Example]
As you see, the first note is moved one sixteenth note later. If we change the Display Quantize value for the notes to eighth notes, the score will be displayed like this:

With Note Display Quantize set to eighth notes.

Unfortunately, this moves the first note to the same position as the second, since sixteenth note positions aren’t allowed. We could solve this by inserting extra Display Quantize values within the bar with the Display Quantize tool, but there is a much easier way: Change the Display Quantize value for notes back to sixteenths, but set the Display Quantize value for rests to eighth notes! This tells the program not to display any rests smaller than eighth notes, except when necessary. The result looks like this:

With Note Display Quantize set to sixteenth notes, but Rest Display Quantize set to eighth notes.

How did this work? Well, you instructed the program not to display any rests smaller than eighth notes, except when “necessary”. Since the first note appeared on the second sixteenth note position, it was necessary to put a sixteenth rest at the beginning of the figure. All other rests, however, could be hidden by displaying the notes as eighth notes, and were therefore not “necessary”.

This leads us to the following general guidelines:

• **Set the Note Display Quantize value according to the “smallest note position” you want to be shown in the score.**
  For example, if you have notes on odd sixteenth note positions, the Note Display Quantize value should be set to sixteenth notes.

• **Set the Rest Display Quantize value according to the smallest note value (length) you want to be displayed for a single note, positioned on a beat.**
  A common setting would be to have Note Display Quantize set to 16 (sixteenth notes) and Rest Display Quantize set to 4 (quarter notes).
Handling exceptions

Unfortunately, the guidelines above won't work perfectly in every situation. You may for example have a mix of straight notes and tuplets of different types, or you may wish to display equally long notes with different note values depending on the context. There are several methods you could try:

Automatic Display Quantize

If your score contains both straight notes and triplets, you can use Auto Display Quantize. When this is activated, Cubase SX tries to “understand” whether the notes should be Display Quantized to straight notes or triplets (see page 47).

Using the Display Quantize tool

With the “Q” tool, you can insert new Display Quantize values anywhere in the score. Inserted Display Quantize affect the staff from the insertion point onwards. See page 56.

Permanent Alteration of MIDI Data

As a last resort, you could resize, quantize or move the actual note events. However, this would result in the music not playing back like it originally did. Often, it is possible to get the score to look like you want without altering any MIDI data.

Summary

This closes our discussion on the basic concept of Display Quantizing. There are a number of other special situations which require more advanced techniques, which you will find out about in the next chapters. You will also read about other settings which work along the same lines as Display Quantize but each with its own application. These are called “Interpretation Flags”.
Entering Notes by hand compared with Recording them

Sometimes you will enter and edit notes by hand (or rather using the mouse and computer keyboard) and at other times you will record them from a MIDI keyboard. Most of the time, you will do a combination of both. In “Transcribing MIDI recordings” you will find out how to make a recorded score as legible as possible without performing any permanent changes to the MIDI data. “Entering and editing notes using the mouse” shows how to enter and edit notes using the mouse. In real life, even if you have recorded the piece perfectly, you will often have to do some permanent editing to your recording before printing. Which leads to this conclusion:

☑ You will have to read both chapters in order to understand how to produce legible scores!
2
The Basics
In this Chapter you will learn:

- How to open the Score editor.
- How to set up the page size and margins.
- How to switch between Page and Edit mode.
- How to hide and show the symbol palettes, the toolbar and extended toolbar.
- How to set up the ruler.
- How to set a magnification factor.

Preparations

1. In the Project window, create a MIDI track for each Instrument.
   Please note that you can prepare a piano (split) staff from a single track, there’s no need to create one track for the bass clef and one for the treble clef.

2. If you like, name each track after the Instrument.
   This name can later be used in the score if you like.

3. Record into the tracks or create empty parts on all tracks.
   You can make very long parts that cover the entire piece, or you can start out with shorter parts to begin with. If you choose the latter option, you can always go back and add new parts or copy existing parts later.
Opening the Score editor

Editing one or several parts

To open one or several parts in the Score editor you proceed as with the other editors: select the parts (on the same or different tracks) and select “Open Score Editor” from the MIDI menu. The default key command for this is [Ctrl]/[Command]-[R].

- You can also select the Score editor as your default editor, allowing you to open it by double clicking parts.
  This is done with the Default Edit Action pop-up menu in the Preferences dialog (event Display - MIDI page).

Editing whole tracks

When you are preparing a score for printing, you probably want to open the whole MIDI tracks in the Score editor. This could be done by selecting all parts on the desired tracks and opening the editor, or by using the Select All function on the Edit menu to select all parts on all tracks for editing. However, there is a setting that makes this easier:

1. Open the Preferences dialog on the File menu and select the Scores page.

2. Activate the option “Edit All Parts on Track”.

3. Select any part on the track you want to edit and open the Score editor as usual.
   Now, all parts on the track are automatically opened for editing. If you select parts from several tracks, all parts on these tracks are opened.

About editing parts on different tracks

If you have selected parts on two or more tracks and open the Score editor, you will get one staff for each track (although you can split a staff in two, e.g. when scoring for piano). In this way you can think of the Project windows as an overview of your entire score and the tracks as representing one instrument each.

Editing predefined combinations of tracks

On page 238 you will find out how to open Score edit with a certain combination of tracks you have been editing before.
The Project cursor

The Project cursor appears as a vertical line across the staff. When you open the Score editor, the view is automatically scrolled so that the Project cursor is visible in the window. This means you don’t always see the beginning of the edited part when you first open Score edit.

- You can move the Project cursor by dragging it around.
- You can also hold down [Alt]/[Option] and [Shift] and click anywhere in the score to move the Project cursor there. This is handy if the Project cursor pointer isn’t visible.

Page Mode

When you are preparing a score for printout, you should set the Score editor to Page Mode. This is done by selecting Page Mode from the Scores menu (if it doesn’t already say “Page Mode”).

When you do this, the window switches to show you one page at a time, as it will appear on printout.

Page Mode vs. Edit Mode

All you can do in Edit Mode, you can also do in Page Mode. But Page Mode offers lots of additional features that are not available in Edit mode, typically because they are directly related to how the score is displayed and printed.

This section of the manual assumes you are in Page Mode. It will be mentioned explicitly if something in this text specifically relates to Edit Mode.
Using the Scroll Bars in Page Mode

In Page Mode, the scroll bars are used to scroll the image of the page inside the window.

Moving between pages in Page Mode

If your score takes up more than one page, you can skip between the pages in two ways:

• By using the page number indicator in the lower right corner. The number can be adjusted using the standard value editing techniques.

![Page Number indicator — adjust it to move to another page.](image)

• By assigning key commands to the functions “Move to Next Page” and “Move to Previous Page” in the Key Commands dialog – Scores category.

Also, if Auto scroll is activated on the toolbar, the score display will follow the Project cursor position. This way you can scroll the score by using fast forward or rewind.

Playing Back and Recording

You can play back and record MIDI in the Score editor using the standard transport commands, just like in the other MIDI editors. See the Operation Manual for details.
Changing Magnification

There are two general ways to change the magnification in Page Mode: by setting a magnification factor on the Scale pop-up menu or by using the Magnifying Glass tool.

Using the Scale Pop-up Menu

Above the vertical scrollbar to the right you will find a pop-up allowing you to set the zoom factor.

By zooming in you will be able to make detailed adjustments to symbols etc. By zooming out you will get a better overview.

• If you select “Fit Page”, the magnification factor will be adjusted according to the window size, so that the whole page is visible.

• If you select “Fit Width”, the magnification factor will be adjusted according to the window width, so that the full width of the page is visible.

This pop-up menu can also be opened by right-clicking in the ruler.
Using the Magnifying Glass tool

The Magnifying Glass tool in Score edit works much like in the Project window:

- Click once with the Magnifying Glass to zoom in one step.
- Hold down [Alt]/[Option] and click once with the Magnifying Glass to zoom out one step.
- Drag a rectangle with the Magnifying Glass tool to set a custom magnification.
  The section encompassed by the rectangle is magnified to fill the window.

The Active staff

One thing to note when you are working with multiple staves is the Active staff. Only one staff at a time can be active, and is indicated by a black rectangle to the left of the clef symbol.

This staff is active.

Later on you will find out how to make settings that apply specifically to the active staff.

- To make a staff active, click anywhere in it.
  By default, you can also use the up and down arrow keys on the computer keyboard to step between staves.
Making Page Setup settings

Before you start preparing the score for printout, you will want to make some page settings for your Project. You don’t have to do this as the first thing you do, but it’s a good working habit, because it affects how the score is displayed on screen too.

1. Select Page Setup from the File menu.
   The Page Setup dialog box appears. This is the regular Windows Page Setup dialog box, described in detail in the Windows documentation. The only things that Cubase SX adds to this are the margin settings.

2. Select the preferred printer, paper size, orientation, etc.

3. If you need to, change the margins by setting the Left, Right, Top and Bottom settings.

- To make the Settings permanent, save the Project.
  If you want new Projects to always start with certain Page Setup settings, you can make Project templates with these or create a default Project (see the Operation Manual).

Designing your Work Space

Some of the areas in the window can be hidden or revealed. Exactly which areas you wish to see depends on what kind of work you are doing, and how big a monitor you have.
The Info Line

The Info line displays information about the currently selected note. It can be hidden/revealed by clicking the Info (i) button on the toolbar, or by using the key command for “Show/Hide Infoview” (set in the Key Commands dialog–Editors category; by default [Ctrl]/[Command]-[I]).

The extended toolbar

The extended toolbar can be revealed/hidden by clicking the “T” button on the main toolbar.

The display filter bar

This area contains checkboxes for determining which indicators, handles and other non-printed elements should be shown in the score. You hide and show the filter bar by clicking the “F” button on the toolbar.

The ruler

In Score edit there are no Meter/Time Position Rulers as in the other editors. Instead, there are horizontal and vertical “graphic rulers” in Page Mode. These help you position symbols and graphical objects in the scores.
• To set which units should be used on the rulers, bring up the Scale pop-up menu above the vertical scrollbar to the right, and select one of the options. Choose between points, inches or centimeters. You can also bring up this pop-up menu by right-clicking in the ruler.

• To hide the rulers, select “Off” from the pop-up menu.

The Position Window

To help you further when positioning objects in the scores, Page Mode has a special Position Window, in which you can view and adjust object positions numerically, in the unit selected for the Rulers. To show or hide the Position Window, click in the Ruler.
The symbol palettes

The symbol palettes, which are used to add symbols to the Score, can be displayed by selecting any of the “Symbol Palettes” options from the Scores menu.

You can move symbol palettes around on the screen by clicking and dragging their title bars. Right-clicking in a symbol palette brings up a pop-up menu with the following options:

- Select "Toggle" to switch between a vertical and horizontal palette.
- Selecting one of the symbol palettes on the pop-up menu brings up that palette, replacing the current.
- If you hold down [Ctrl]/[Command] and select a palette from the pop-up menu, the selected palette will open in a new window (without replacing the existing one).

To close a symbol palette, click its close button as usual.
Showing and hiding “invisible” elements

Some of the elements in the score will not be printed, but rather serve as indicators for layout changes, handles, etc. These elements can be hidden or shown in any combination by using the display filter bar.

- If the filter bar isn’t shown, click the “F” button on the toolbar.

The checkboxes on the filter bar determine whether an element should be visible (checkbox ticked) or not. The following options are available:

<table>
<thead>
<tr>
<th>Option:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar Handles</td>
<td>Reveals the bar handles, used for copying bars (see page 191).</td>
</tr>
<tr>
<td>Hidden Notes</td>
<td>Reveals any notes you might have hidden (see page 246).</td>
</tr>
<tr>
<td>Hide</td>
<td>Displays markers in the score for each hidden element (notes excepted). See page 246.</td>
</tr>
<tr>
<td>Quantize</td>
<td>Displays markers in the score where you have made Display Quantize “exceptions” (see page 56).</td>
</tr>
<tr>
<td>Layout tool</td>
<td>Displays markers in the score where you have made adjustments with the Graphic Move tool (see page 148).</td>
</tr>
<tr>
<td>Grouping</td>
<td>Displays markers in the score where you have made beam groupings (see page 136).</td>
</tr>
<tr>
<td>Cutflag</td>
<td>Displays markers in the score where you have inserted Cutflag events (see page 146).</td>
</tr>
<tr>
<td>Split Rests</td>
<td>Displays markers in the score wherever you have split multiple rests (see page 249).</td>
</tr>
<tr>
<td>Stems/Beams</td>
<td>Displays markers in the score where you have made any stem or beam adjustments (see page 125 and page 144).</td>
</tr>
</tbody>
</table>
About dialogs in the Score editor

There are two basic types of dialogs available in the Score editor:

- Non-modal dialogs can remain open while you continue working in the score. In a non-modal dialog, you click the Apply button to apply the settings in the dialog to the selected objects in the score. This means you can select different elements in the score and change their settings, without having to close the dialog in between. The dialog is closed by clicking the standard close button in the window title bar. Examples of non-modal score dialog include Staff Settings and the Chord dialog.

- Regular dialogs have an OK button instead of an Apply button. Clicking OK applies the settings you’ve made and closes the dialog. You cannot continue working in the score (or select other objects) until you close the dialog.

- If the option “Apply closes Property Windows” is activated in the Preferences (Scores page), clicking the Apply button in a non-modal dialog closes the dialog. In other words, this makes a non-modal dialog work a bit more like a regular dialog.
Setting key, clef and time signature

When preparing for entering notes into a score, you will probably want to start out by setting the desired key, clef and time signature for the staff. The text below assumes you are working on one track only. If you have multiple staves, you either make this setting independently for each staff or for all staves at once. See page 44 for details.

Normally, all these symbols appear at the beginning of each staff. However, you can control this by using the Real Book option (see page 243) and by Hiding (see page 246).

Setting the initial time signature

From within the score

1. Double click on the time signature symbol at the beginning of the staff.
   A dialog box opens.

   ![Time Signature Dialog]

   The time signature dialog with a 4/4 signature.

2. If the piece is in 4/4 or 2/2, you can select common time/cut time directly by clicking one of the two symbols at the right side.
   This will set the time signature to 4/4 or 2/2, respectively, but also give you a common/cut time symbol on the staff.

3. If the piece is in any other time, set the numerator and denominator above and below the line, respectively.
   The numerator can consist of several numbers for composite time signatures. However, if the piece is in a simple time signature you only need to fill in the first number above the line. The more advanced options are described below.
• The “Pickup Bar” option is described on page 253.

4. Click OK or press [Return].

- All tracks share the time signature! In other words, when you set the time signature, you do this for all tracks in the Arrangement.

If you need to enter half a bar somewhere (for example) you have to make a time signature change (for example from 4/4 to 2/4 and back again). On page 88 you will find out how to input time signature changes.

Composite time signatures and the Grouping option

For composite signatures, the Numerator can be made up of up to four groups. For example, "4+4+3+/" on the upper line and 8 on the lower, means the time signature is 11/8.

The reason for dividing the Numerator into several numbers is to get beaming and tied notes displayed correctly automatically. This does not affect the Metronome or anything else, only beams and ties. For more information on Beaming, see page 136.

If “For Grouping Only” is not activated, the numerator will show all the numbers entered. If it is activated, it will show the sum of the numbers entered, as for “simple” time signatures.

"For Grouping Only", Off and On.

Note that Cubase SX tries to preserve the denominator when you insert a composite signature with “For Grouping Only” activated. This means that if you have a 4/4 time signature, and change it to a composite value (3+3+2 eighths for example), the time signature will still be displayed as 4/4 instead of 8/8.
Setting the time signature from the Transport Bar

You can also set the time signature directly on the Transport Bar, as described in the Operation manual. Please note the following:

• The time signature box on the Transport Bar always displays the first time signature event on the Tempo track. When you change this value you are in fact editing the first time signature event on the Tempo track.
• You can not create composite time signatures from the Transport Bar.

Setting the time signature by editing the Tempo track

You can also add, edit and delete time signatures by editing the Tempo track (described in its own chapter in the Operation Manual). Please note the following:

• The score always shows the time signature events on the Tempo track, regardless of whether or not the Master button is activated. Likewise, any time signatures you create in the Score editor will be shown in the Tempo track.
• You can not create composite time signatures from the Tempo track.

Setting the initial clef

Directly in the Score

1. Double click on the current clef.
   A dialog appears.

   Double clicking on a clef brings up the clef dialog.
2. Use the scroll bar to select one clef.

- This does not work if Auto Clef is activated in the Staff Settings dialog box, see below.

3. Repeat the steps above for all staves in the system.

In the Staff Settings dialog

1. Click in the staff to make it the active staff.

2. Double click just to the left of the staff, or select Setup from the Staff Settings submenu on the Scores menu.

   The Staff Settings dialog appears, showing the current settings for the active staff.

3. Locate the Key/Clef section.

4. Use the left scroll bar to select one of the available clefs.

   You will find out how to insert clef changes on page 88.

5. Click Apply.

   - You can select another staff in the score and make settings for that, without having to close the Staff Settings dialog first.
In a split system

If you have a split system (see page 85 and page 109) you can of course set different clefs for the Upper and Lower staff.

1. Open Staff Settings.
2. Select a clef for the upper staff.
3. Activate the “Lower staff” check box.
4. Set a clef for the lower staff.

Using Auto Clef

![Auto Clef activated in Staff Settings.]

In the Staff Settings dialog you will also find an option called Auto Clef. If this is activated, the program will automatically select a treble clef or a bass clef for the staff, depending on in which range the notes in the part fall.
Setting the initial key

In the Staff Settings dialog

1. Make sure the desired staff is the active staff and bring up the Staff Settings dialog from the Scores menu.
   Or, you can double click just to the left of the staff - this makes the staff active and brings up the Staff Settings, in one go.

   ![Key/Clef section of Staff Settings](image)
   
   The Key/Clef section of Staff Settings.

2. Use the right scroll bar in the Key/Clef section of the dialog box to select one of the keys.

3. Click Apply.
   - You can select other staves in the score and make settings for these, without having to close the Staff Settings dialog first.

Setting the key for a split system

You might have a split system (see page 85 and page 109) with two staves.

1. Click in the system to make one of its staves the active staff.
2. Open Staff Settings.
3. Set a key for the upper staff.
   This will make the Lower staff automatically be set to the same key.
4. If you need to set a different key for the Lower staff, activate the “Lower staff” check box and set a key for this.

![The Lower staff check box.](image)

**Directly in the score**

If the current key is anything but C major/A minor (no accidentals) you can set the key directly in the score:

1. Double click on one of the current accidentals at the beginning of a staff.

   ![Double click in this area](image)

   A dialog appears.

2. Use the scroll bar to select a key and click OK.

   - If you wish, you can set a Display Transpose value in this dialog.

3. Repeat for all staves.
   
   You will find out how to insert key changes on page 88.
Working with Transposing Instruments

Some instruments, for example a lot of brass instruments, are written transposed. For this purpose, there is a Display Transpose function in the Score editor. By setting this, you transpose the notes in the score, without affecting how the notes play back. This allows you to record and play back a multi staff arrangement, and still score each instrument according to its own transposition.

Setting Display Transpose

1. Make the desired staff active and bring up the Staff Settings dialog.
2. Select your instrument from the transpose pop-up or adjust the value directly in the semitones field.
3. Click Apply.

Display Transpose does not affect MIDI Playback!

Display Transpose in the Key dialog

If you want to change the Display Transpose setting in the middle of the score, you can do this by inserting a Key change (see page 88). In the Key dialog you will find a Display Transpose field, in which you can enter a transposition value in semitones. This is useful if you are writing a saxophone part and want the player to switch from alto to tenor saxophone, for example.

- Note that you should enter the absolute Display Transpose value that should be used from this point on.
  In other words, this setting is not relative to any Display Transpose you have set up in the Staff Settings.
Working Order

When you prepare a Score we suggest you do things in the following order, because it will minimize the time needed if you make a mistake somewhere and need to redo a step. Try our suggestion first, and if you think another method suits your particular working situation better, go ahead and do it!

• Preferably work on copies of recorded tracks.
  If the parts are fairly complex you might need to make permanent editing after which they don’t play back as they originally did.
• If memory is short, break the score up into segments.
  You might for example use Split to Locators to split the parts across all tracks.
• Put the tracks in the Project window in the order you want them in the score.
  You can not rearrange the order of systems in the Score editor. However, you can go back and change the order in the Project window at any time.
• When you open Score edit, start by making the adjustments described in this chapter.
  You should always begin by setting page margins, etc.
• If you have recorded music into tracks already, try adjusting the score “picture” as much as possible without permanently editing the notes.
  Use Staff Settings, Display Quantize, Grouping etc.
• If the tracks are empty, make basic Staff Settings, enter the notes and then make detailed adjustments, add Display Quantize etc.
• If needed, use Polyphonic Voicing to resolve overlapping notes, to create piano systems, to handle crossing voices etc.
• When all this is done, decide if you need to perform “destructive” editing.
  You might for example have to permanently alter the length or position of some of the recorded notes.
• Hide unwanted objects and add note dependant and note related symbols.
  This includes accents, dynamic symbols, crescendo, slurs, lyrics, “graphic rests” etc.
• Work through the score and adjust the number of bars across the page.
• Adjust the vertical spacing between staves and grand staves.
  Both the steps above can be performed automatically by the program using the Auto Layout features.
• Add Layout symbols like endings, page text, etc.
• Print.
• Go back and create alternative Layouts to extract voices etc.
Force Update

If for some reason the screen isn’t redrawn properly (as a result of the computer’s recalculation of the page’s appearance), you can select “Force Update” from the Global Functions submenu on the Scores menu or click the Update button on the toolbar. This forces a total re-draw of the whole page.

The Update button
Transcribing MIDI recordings
In this chapter you will learn:

- How to make initial Staff Settings to make a Score as legible as possible.
- How to use the Display Quantize tool to handle “exceptions” in the score.
- How to resolve parts that contain mixed notes and triplets.

About transcription

This chapter assumes you have a MIDI recording that you want to transform into a printable score. However, if the parts are fairly complicated, you will probably need to perform some manual editing of the notes. Hence you will need to read the next chapter too!

Before starting, make sure you understand the basic principles behind the score notes/MIDI notes relationship and also what Display Quantize is, as described in “How the Score editor works”.

Getting the parts ready

1. Record the music.
   You must definitely play in time with the click.

2. Play back to check that the music got recorded as intended.
   If not, you might need to re-record or perform some editing.

3. Decide how much permanent alteration to the recording you can accept to make the score look good.
   If the answer is “none”, you should prepare your score from a copy of the track. See the “Strategies” section below.

4. Select all parts (on all tracks) that you wish to work on.

5. Select Open Score Editor from the MIDI menu.

6. Switch to Page Mode.
Strategies: Preparing parts for score printout

Below follow a few tips that you might want to refer to when preparing a piece for printout:

• If a part is complex, you might possibly have to do some “manual” editing of notes, like for example moving them or changing their lengths (see next chapter). This means that the recording will then not play back exactly as it originally did. If this is a problem, we suggest you work on a copy of the recording. Use the Duplicate Track function on the Track list’s Quick menu to create a version of the track for scoring. Rename the track and mute the original track while you are preparing the score. You could of course also work on a copy of the entire Project file.

• For reasons described in the previous chapter, quantizing the track might be a good idea. This will reduce the amount of detailed adjustments needed in Score edit. Remember that you can always prepare the score from copies of the original tracks, as described above.

• If you need to quantize, always play back your tracks afterwards to make sure timing wasn’t disrupted due to inappropriate quantize settings. You might have to quantize some sections with one value and others with another.

• If the piece contains many repetitions, it might be quicker to initially just record one instance of them each. If you then finish the score work on each section, you can assemble the entire piece by working with parts in the Project window. This might save you some time since you might only have to perform detailed adjustments to each section once.

• A similar approach can also be used when you are creating sections where several instruments play the same rhythm (a horn section, for example): Record the first instrument and make adjustments so that it looks like it should in the Score editor. Then copy the part to the other tracks, and change the pitches of the notes using MIDI input. Finally, go through the copied parts and make fine adjustments, change Display Transpose settings, etc. This can be a very fast way to create polyphonic parts with complicated rhythms.

• There may also be situations when the quickest way to record a part for several instruments, is to simply record it in one go, by playing the chords on your MIDI instrument. If you later want to split the recording into separate tracks or Polyphonic Voices, you can use the Explode function, as described on page 58.
Staff Settings

The first thing you do after opening the Score editor is to make some initial Staff Settings. There are three ways to open the Staff Settings dialog:

- Make the staff active, pull down the Scores menu and select “Setup” from the Staff Settings submenu.
- Double click to the left of the staff.
- Make the staff active and click the “i” button on the extended toolbar. For this to work, make sure no notes or symbols are selected - otherwise, clicking the “i” button may open a dialog with settings for the selected object instead.

Either way, the Staff Settings dialog appears and shows the current settings for the staff:

The Main tab in the Staff Settings for a track called “MIDI 01”.

Applying settings and selecting other staves

The Staff Settings dialog is non-modal (see page 29). This means you click Apply to apply the settings you’ve made to the active staff.
To make settings for another staff, simply make it active in the score (by clicking anywhere in the staff or by using the up/down arrow keys on the computer keyboard). However, please note:

- Remember to click Apply before making another staff active - otherwise your settings will be lost!

**Staff presets**

When you know you will reuse settings made for one track in other tracks, you will save some time by creating a staff preset. This is described on page 94.

- There are a number of pre-made Staff presets available, set up to suit various instruments, etc.

  The presets are accessed from the Presets pop-up menu in the Staff Settings dialog, or from the Staff Setting submenu on the Score menu. Use them as they are, or as starting points for your own settings.

**Staff names**

Allows you to specify a “long” and a “short” name for the staff. The long name is shown for the very first system for the staff in the score (at the start of the song), while the short name is shown for the remaining systems.

- Whether the names should be shown at all is set in the Layout Settings (see page 231).
  
  There, you can also opt to use the names of the edited MIDI tracks instead.

- If you only want the “long name” to be shown (i.e. if you don’t want a name shown for each system in the score), simply delete the short name.

**Key and clef**

The basic key and clef track Staff Settings are described in detail on page 30. There is also a Lower Staff check box which is only used in conjunction with Piano (Split) staves and Polyphonic Voicing. This is described on page 34.
Display Quantize

The Display Quantize settings.

This is where you give the program basic information about how to interpret your playing. There are “fixed” Display Quantize values plus an “Auto” option which should only be used when your music contains mixed straight notes and triplets. For background information about Display Quantize, see page 10.

If your music only contains “straight” notes or triplets:

1. Set the Note Quantize value according to the “smallest note position” you want to be shown in the score.
   For example, if you have notes on odd sixteenth note positions, the Note Display Quantize value should be set to 16 (sixteenth notes). The “T” values on the pop-up are for triplets.

2. Set the Rest Quantize value according to the smallest note value (length) you want to be displayed for a single note, positioned on a beat.
   For example, if you want a single short note on a beat (quarter note position) to be displayed as a quarter note, set the Rest Quantize value to 4 (quarter notes).

3. Deactivate the Auto Quantize option.

4. Set all the Interpretation Flags.
   These are described in detail below.

5. Examine the score.

6. If necessary, use the Quantize tool to insert “exceptions” to the Staff Settings.
   See page 56.
If your music contains mixed straight notes and triplets

1. Examine the score and decide if it mainly contains triplets or mainly “straight” notes.

2. Set the Note Quantize value accordingly.
   If the score is mainly triplets, select the smallest triplet note position used in the score.
   If it is mainly straight notes, select the smallest “ordinary” note position.

3. Set the Rest Quantize value.
   This is done according to the same rules as above.

4. Activate the Auto Quantize option.

5. Turn on the Deviation (“Dev.”) and Adapt flags if you need them.
   When Deviation is activated, triplets/straight notes will be detected even if they are not exactly “on the beat”. However, if you know your triplets/straight notes are perfectly recorded (quantized or entered by hand), turn this off.
   When Adapt is activated, the program “guesses” that when one triplet is found, there are probably more triplets surrounding it. Turn this on if not all of your triplets are detected.

Interpretation Flags

- Clean Lengths
- No Overlap
- Syncopation
- Shuffle

The Interpretation Flags

Clean Lengths

When this is turned on, the program interprets the length of your notes differently than otherwise. A note’s length (in the display only) might be extended to the beginning of the next note or to the next Rest Quantize “position”. An example:

- If a note is too short, you may get a rest just after it.
• When Clean Lengths is turned on, the rest will disappear.

![A slightly short eighth note with Clean Lengths off and on.]

If using Clean Lengths doesn’t help in a particular situation, you will have to manually resize the offending note(s) or use the Display Quantize tool (see page 56).

**No Overlap**

When notes starting at the same position have different lengths, the program generally adds more ties than you may want. This can be avoided by using No Overlap.

![This recording in Key Edit...](image)

...will be displayed like this when No Overlap is off...

![This recording in Key Edit...](image)

...and like this when No Overlap is On.

You can insert “exceptions” to the No Overlap setting in Staff Settings, by using the Display Quantize tool.

⚠️ Please note that there will probably be situations when neither of these alternatives is ideal. If you run into such a situation, it can probably be resolved by using Polyphonic Voices, see page 101.
Syncopation

When syncopation is off, the program generally adds ties to long notes crossing beats. There are a few exceptions to this. For example, a half note starting at “2” in 4/4 is always displayed as a half note, never as two tied quarter notes.

If you want more “modern” notation of syncopated notes, turn on Syncopation.

\begin{music}
\begin{staff}
\begin{musicnotes}
\rarefraction{\time 4/4}
\notes
\half\eight\six\half
\end{musicnotes}
\end{staff}
\end{music}

Syncopation off, and on.

\begin{music}
\begin{staff}
\begin{musicnotes}
\rarefraction{\time 4/4}
\notes
\quarter\quarter\quarter\quarter\quarter\quarter\quarter
\end{musicnotes}
\end{staff}
\end{music}

\begin{music}
\begin{staff}
\begin{musicnotes}
\rarefraction{\time 4/4}
\notes
\half\half\half\half\half\half\half
\end{musicnotes}
\end{staff}
\end{music}

Again, Syncopation off, and on.

Please note that you can insert “exceptions” to the Syncopation setting in Staff Settings, by using the Display Quantize tool. You could also create tied notes in various combinations by using the Cutflag tool.
Shuffle

In jazz it is very common to score a shuffled beat as straight notes, simply to make it more legible.

When the Shuffle flag is turned on, the program searches for eighth note or sixteenth note pairs where the second note is played late (with a “swing feel” or as the third note in a triplet). Such pairs are displayed as regular eighth or sixteenth notes instead of triplet-based figures.

Shuffle Off and On.

Display Transpose

This is used when preparing parts for instruments that are not scored at the actual concert key. For example, if you want the note C3 to be played by an alto sax, you have to score it as an A3 - nine semitones up. Luckily, the Display Transpose setting takes care of this for you:

• Use the pop-up menu to select the instrument for which you’re scoring.
• If the pop-up menu doesn’t list the needed instrument, you can set the desired transposition with the Semitones value field.

• The Display Transpose setting doesn't affect playback or the actual pitch of the notes - it only changes how they are displayed and printed.

More details on page 37.
The Options tab

The Options tab selected in the Staff Settings dialog.

The Options tab contains additional settings for the staff. Below follows a brief description of these, with references to more detailed explanations:
## Switches

**Activate This:** | **When:**
--- | ---
Flat Beams | When you want the beams over notes to be flat (as opposed to slanted). See page 143.
No Beams | When you don’t want any beaming at all on the staff (for example for vocal scoring). See page 136.
Beam Subgroups | When you want sixteenth notes displayed under a beam to be divided into groups of four notes. See page 142.

![Beam Subgroups Off](image1)

![Beam Subgroups On](image2)

**16th Subgroups Off and On**

When you want even smaller subgroups of sixteenth notes. This setting has no effect if Beam Subgroups is turned off.

As above, but with 16th Subgroups activated.

**Consolidate Rests Off and On.**

When you want small consecutive rests joined into one (an eight note rest and a sixteenth note rest joined to a dotted eighth note rest for example).
Drum Map Options

These settings are all described in the chapter “Drum Scoring”.

System Sizes

This section allows you to set the number of system lines and to control spacing between the lines. See page 286 for an example of how this can be used with Tablature.

Fixed Stems

Activate this if you want all note stems to end at the same vertical position. The Up and Down fields let you specify the desired positions for stems in the respective direction, using the graphic figure to the right as a guideline.

The Polyphonic tab

This is where you activate and set up split (piano) systems or polyphonic voices (several independent score lines in the same staves). See page 102.

The Tablature tab

This contains settings for creating tablature scores. See “Creating Tablature”.

Situations which require Additional Techniques

The notes may not always appear in the score as you expect them to, initially. This is because there are a number of situations which require special techniques and settings. Below follows a list of some of these and where to find more information about handling them:

• Notes at the same position are considered parts of a chord. To get independent voicing (for example notes with different stem directions), such as for vocal material, you need to use the special Polyphonic Voicing feature described on page 101.

Without and with Polyphonic Voicing.

• If two notes beginning at the same position have different lengths, the longer one will be displayed as a number of tied notes. To avoid this, you will either have to use the "No Overlap" feature (see page 48) or polyphonic voicing (see page 101).

• One note will often be displayed as two notes with a tie. This is only how the program displays the note, there is still only a single note “stored”.

This single note in the Key editor is displayed as two tied notes in the Score editor.

• Generally the program adds ties where necessary (if a note stretches over a beat), but not always. For more “modern” notation of syncopated notes (less ties), you will need to use the Syncopation feature described on page 49.

The same note, without and with Syncopation.

• If you find that you want a long note to be displayed as two or more tied notes, you can achieve this with the Cut Notes tool. See page 146.
- If two notes on the same position are too close to each other or if you want their order in the part reversed, you can do this without affecting playback. See page 148.
- If a note has the wrong accidental, this can be changed. See page 129.
- Stem direction and length is automatic, but you can change it manually if you wish. See page 124.
- If you are scoring for piano and therefore (or for other reasons) need a split staff, there are special techniques for this - see page 85 and page 101.

If you run into Trouble

Below follow a few simple troubleshooting steps that will help you pinpoint other common problems:

- The note I recorded is displayed with the wrong length. For example, I recorded a sixteenth and got a quarter note. You probably have the wrong Display Quantize value set, see page 46 for details. If you feel uncertain about what Display Quantize is, and how it works, please read “How the Score editor works”. Also, you might want to check the No Overlap setting.

- There is a pause after a note that I don’t want. The note is probably too short. This can be adjusted in two ways, by using Clean Lengths (see page 47) or by manually lengthening it (see page 82). If this problem occurs a lot in your score, try selecting a larger Rest Display Quantize value (see page 12).

- There is no pause after the note although there should be one. Either the note is too long (use Clean Lengths or change the current note’s length). Or, your Rest Display Quantize value is set too high. Open Staff Settings and lower it.

- The note has an accidental when it shouldn’t, or it doesn’t when it should. Enharmonic shifting is discussed on page 129.

- Notes are not grouped under beams the way I want it. Normally the program groups eighth notes, sixteenths etc. under beams. This can be turned off. There is also detailed control of which notes are grouped under a beam. This is all described on page 136.
Inserting Display Quantize Changes

There are instances when you will want different Staff Settings on different sections of the track. The Staff Settings are valid for the entire track, but you can insert changes wherever you like:

1. Select the Display Quantize tool from the toolbar or Quick menu.

2. When you select the tool, the Quantize Settings dialog appears.

3. Activate the flags you need and set the quantize values as desired. Details are found on page 46 and page 47. Additional hints below.

4. If you want to restore the settings to the ones used in the Staff Settings, click on “Restore to staff”.

5. Move the mouse over the staff where you want to insert a new Display Quantize value.
   Use the mouse position box to find the exact location. The vertical position is of no relevance as long as you click somewhere in the staff.
6. Click the mouse button to insert a Display Quantize event. The new quantize settings are now inserted into the staff at the position where you clicked. The settings are valid until a new change is inserted.

- If you are using polyphonic voices (see page 101), you can insert a Display Quantize event for all voices by pressing [Alt]/[Option] and clicking with the tool. If the option Display Quantize Tool affects all Voices is activated in the Notation Style-Switches dialog (Scores-Global Settings submenu), Display Quantize events will always be inserted for all voices.

**Viewing and editing Display Quantize changes**

If you activate the “Quantize” checkbox on the display filter bar (see page 28), a marker will be shown under the staff for each Display Quantize setting you have entered with the tool.

This allows you to edit your settings in the following ways:

- To edit a Display Quantize change event, double click on its marker. This opens the Quantize Settings dialog again - adjust the settings and click Apply.

- If the Quantize Settings dialog is already open, you can select any Display Quantize change event, adjust its settings in the dialog and click Apply.

- To remove a Display Quantize change, either click its marker to select it and press [Backspace] or [Delete], or click on it with the Eraser tool.

**Strategies: Adding Display Quantize changes**

Very often, the score will be fine except for a few bars somewhere. To remedy the problem, insert two Display Quantize changes with the tool (one at the beginning of the section, one after it to restore to Staff Settings).

If you have mixed triplets and straight notes, it can be tempting to insert many Display Quantize changes. Before you do so, try the Auto Quantize options and their additional settings. See page 47.
The Explode Function

This function allows you to “split” the notes on a staff into separate tracks. It is also possible to use this function to convert a polyphonic staff into Polyphonic Voices - this is described on page 113.

CTRL You may want to create a copy of the original track first, since this will be changed by the operation.

1. Pull down the Scores menu and select “Explode...” from the Global Functions submenu.

![The Explode dialog, set to create tracks.](image)

2. Make sure “To New tracks” is selected at the top of the dialog.

3. Enter the desired number of new tracks.
   Note that this is the number of new tracks to be created! For example, if you have a three-part polyphonic section and want to split this into three separate tracks, you should specify 2 new tracks, since the original track will hold one of the parts.
4. Use the lower half to set up the criteria for the split. 
Choose from the following options:

<table>
<thead>
<tr>
<th>Option:</th>
<th>Explanation:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split Note</td>
<td>Use this to move all notes below a certain pitch to another track. When this</td>
</tr>
<tr>
<td></td>
<td>is selected, it is pointless to specify more than 1 new track.</td>
</tr>
<tr>
<td>Lines To tracks</td>
<td>Use this when you want all musical &quot;lines&quot; to be put on one track each. The</td>
</tr>
<tr>
<td></td>
<td>notes with the highest pitch will remain on the original track, the notes</td>
</tr>
<tr>
<td></td>
<td>with the second highest pitch will be put on the first new track, and so</td>
</tr>
<tr>
<td>Bass To Lowest</td>
<td>When this is activated, the lowest notes will always end up on the lowest</td>
</tr>
<tr>
<td></td>
<td>track.</td>
</tr>
</tbody>
</table>

5. Click OK. 
A number of new tracks are now added to the Score and the Project window.

**Using “Scores Notes To MIDI”**

For very complicated scores, there might be situations where you have tweaked the parameters for Display Quantize and Interpretation best you can, and you still can’t get the score exactly as you want it. Perhaps one setting works fine in one section of the track and another is needed for another section.

In this case, “Score Notes To MIDI” will help you out. It changes the lengths and position of some or all the MIDI notes in the edited parts so that they have exactly the values currently shown on screen.

1. For safety, go back to the Project window and make a copy of the track.

2. Open the part(s) again, in the Score editor. 
If you only want some sections of your score to be “converted”, make sure to only open those parts.

3. Make sure the notes you want to affect are not hidden (see page 246).
4. Select “Scores Notes To MIDI” from the Global Functions submenu on the Scores menu. The notes are now “converted”.

5. Make whatever adjustments needed to make the score read back as intended.

Now that the notes have the exact lengths and positions that were previously only displayed, you can probably turn off many of the options in Staff Settings and delete Display Quantize settings etc.

If you find the operation didn't give you the result you were after, you can undo your settings or go back to the original track, make a copy of that, and start over.
Entering and editing notes using the mouse
In this chapter you will learn:

• How to make various settings for how notes are displayed.
• How to enter notes by using the mouse.
• How to use tools and settings to make the score as legible as possible.
• How to set up a split (piano) staff.
• How to work with multiple staves.

Staff Settings

Before you start entering notes, you need to make some initial Staff Settings in addition to those described in “The Basics”. In order for you to understand why, and how these settings and the note data in the score interact, please read “How the Score editor works”.

There are three ways to open the Staff Settings dialog:

• Make the staff active, pull down the Scores menu and select “Setup” from the Staff Settings submenu.
• Double click to the left of the staff.
• Make the staff active and click the “i” button on the extended toolbar.
  For this to work, make sure no notes or symbols are selected - otherwise, clicking the “i” button may open a dialog with settings for the selected object instead.

  Either way, the Staff Settings dialog appears and shows the current settings for the staff.
Applying settings and selecting other staves

The Staff Settings dialog is non-modal (see page 29). This means you click Apply to apply the settings you’ve made to the active staff.

To make settings for another staff, simply make it active in the score (by clicking anywhere in the staff or by using the up/down arrow keys on the computer keyboard). However, please note:

• Remember to click Apply before making another staff active - otherwise your settings will be lost!

Staff presets

When you know you will reuse settings made for one track in other tracks, you will save some time by creating a staff preset. This is described on page 94.

• There are a number of pre-made Staff presets available, set up to suit various instruments, etc.
  The presets are accessed from the Presets pop-up menu in the Staff Settings dialog, or from the Staff Setting submenu on the Score menu. Use them as they are, or as starting points for your own settings.
Suggested initial settings

When you start out entering notes using the mouse, you should set up the Staff Settings to make your score display the notes as entered. We suggest the following:

<table>
<thead>
<tr>
<th>Parameter:</th>
<th>Setting:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Names</td>
<td>As desired.</td>
</tr>
<tr>
<td>Display Quantize: Notes</td>
<td>64</td>
</tr>
<tr>
<td>Display Quantize: Rests</td>
<td>64</td>
</tr>
<tr>
<td>Auto Quantize</td>
<td>Activated.</td>
</tr>
<tr>
<td>Clean Lengths</td>
<td>Off.</td>
</tr>
<tr>
<td>No Overlap</td>
<td>Off.</td>
</tr>
<tr>
<td>Syncopation</td>
<td>Off.</td>
</tr>
<tr>
<td>Shuffle</td>
<td>Off.</td>
</tr>
<tr>
<td>Key</td>
<td>As desired.</td>
</tr>
<tr>
<td>Clef</td>
<td>As desired.</td>
</tr>
<tr>
<td>Auto Clef</td>
<td>Activate this if you want the program to select a treble or bass clef automatically.</td>
</tr>
<tr>
<td>Display Transpose</td>
<td>0</td>
</tr>
<tr>
<td>Option tab settings</td>
<td>As is.</td>
</tr>
<tr>
<td>Polyphonic tab settings</td>
<td>Staff Mode: Single (for split staves, see page 85).</td>
</tr>
<tr>
<td>Tablature tab settings</td>
<td>Tablature Mode deactivated.</td>
</tr>
</tbody>
</table>

You will later find out how to adapt these settings in detail to make the score read as you want it to.

• **It is very important that you understand how Note and Rest Display Quantize interact with the score. If you select too large a note/rest value, the notes you “click in” may not appear as intended.**

Please read the chapter “How Score edit works”. If you have mixed triplets and straight notes, please refer to page 46.
Note values and positions

Two of the most important settings for entering notes (and the ones you will change most often) are the length of the note (the note value) and the minimum spacing between notes (the Quantize value).

Selecting a note value for input

This can be done in one of three ways:

- By clicking the note symbols on the extended toolbar. You can select any note value from 1/1 to 1/64th and turn on and off the dotted and triplet options by clicking the two buttons to the right. The selected note value is displayed in the Length value field on the toolbar and in the Note tool cursor shape.

The Note Value is reflected in the extended toolbar, the Length value field and the Note tool shape.

- By selecting an option from the Length pop-up menu on the toolbar.

- By assigning key commands to the different Length values. This is done in the Key Commands dialog on the File menu, under the category "Set Insert Length".

About unusual Note Values

Not all note values can be selected directly, for example double dotted notes. Such notes are created by changing the length of the note after you have put it in (see page 82), by gluing notes together (see page 83) or by using the Display Length feature.
Selecting a Quantize Value

When you move the mouse pointer over the score, you will see that the position box on the toolbar tracks your movement and shows the current position in bars, beats, sixteenth notes and ticks. As described later, when drawing and moving notes, the positions on screen are restricted in the same way.

Positioning on screen is controlled by the current Quantize value. If you for example set this to “1/8 Note” you can only insert and move notes to eighth note positions, at quarter notes, at half bars or at bar positions. It is a good strategy to set the Quantize value to the smallest note value in the piece. This doesn’t stop you from inputting notes at “coarser” positions. However, if you set the Quantize value to too small a note value, it is easier to make mistakes.

The Quantize value is set on the toolbar:

- You can also assign key commands to the different Quantize values. This is done in the Key Commands dialog on the File menu, under the category “MIDI Quantize”.
- Just like in the other MIDI editors, you can use the Quantize Setup dialog to create other quantize values, irregular grids, etc. However, this is not often used when inputting score notes.
The “Mouse Position Box”

While you might most often use the graphical position in the actual score to determine where the notes go, there are instances when you will want to verify the position numerically by looking at the mouse position box:

The upper field shows the pitch according to the vertical position of the pointer in a staff. The lower field shows the “musical position” in bars, beats, sixteenth notes and ticks:

- The relation between beats and bars depends on the time signature: In 4/4 there are 4 beats to a bar. In 8/8 there are eight, in 6/8 there are six, etc.
- The third number is the sixteenth note within the beat. Again, the time signature determines the number of sixteenth notes to each beat. In a quarter note based time signature (4/4, 2/4, etc.) there are four sixteenth notes to each beat, in an eighth note based time signature (3/8, 4/8, etc.), there are two sixteenth notes, etc.
- The last value is in ticks, with 480 ticks per quarter note (and thus 120 ticks per sixteenth note).

The figures below show some note positions and their corresponding position values:

- Eighth Note positions.

- Eighth Note Triplet positions.

- Sixteenth Note positions.

Entering and editing notes using the mouse
Adding and editing notes

Entering one note by dragging

To add a note to the score, proceed as follows:

1. Make the staff active.
   Notes are always put in on the active staff. See page 23 for details.

2. Select the type of note by selecting a note value.
   This is described in detail above.

3. If you selected the note value by clicking on a symbol on the extended toolbar, the Note tool was automatically selected - otherwise select the Note tool from the toolbar or Quick menu.

4. Select a Quantize value.
   Described above. The Quantize value will determine the spacing between notes. If you have Quantize set to “1/1 Note” you will only be able to add notes at downbeats. If you set Quantize to “1/8 Note” you will be able to add notes at all eighth note positions etc.

5. Click in the staff and keep the mouse button pressed.
   A note appears under the mouse pointer.

6. Move the mouse horizontally to find the correct position.
   Check the mouse position box - the position is “magnetically” attracted to the grid defined by the current Quantize value. This allows you to easily find the correct position.

7. Move the mouse vertically to find the correct pitch.

   The Pitch is shown here.

   • If the option “Show Note Info by the Mouse” is activated in the Preferences - Scores dialog, the position and pitch of the note will also be shown in a “tool tip” next to the pointer while you’re dragging.
     If you find that screen redraws are too sluggish, you may want to deactivate this option.

8. Release the mouse button.
   The note appears in the score.
Clicking directly

When you get better acquainted with the Score editor and find it easy to aim at the right position directly, you don’t need to drag the note around as described above. Simply aim at the correct position and click once.

If you have problems getting the pitch right

- Normally, you are allowed to “draw” notes with any pitch. But if the option “Keep moved notes within key” is activated in the Preferences – Scores dialog, the pitches are restricted to inside the current key only.

- When you drag the mouse up and down before releasing the button, accidentals are shown beside the note to indicate the current pitch. This helps you verify the vertical position before releasing the mouse button.

Adding more notes

1. If the next note is of another note value, select a new note value.

2. If you need finer positioning, or if the current is too fine, change the Quantize value.

3. Move the mouse to input the new note, and click.
   Notes input at the same position are automatically interpreted as chords, see below.

About the interpretation

The notes may not always appear in the score as you expect them to, initially. This is because there are a number of situations which require special techniques and settings. Below follows a list of some of these and where to find more information about handling them:

- Notes at the same position are considered parts of a chord. To get independent voicing (for example notes with different stem directions), such as for vocal material, you need to use polyphonic voicing - see page 101.

Without and with Polyphonic Voicing
• If two notes beginning at the same position have different lengths, the longer will be displayed as a number of tied notes. To avoid this, you will either have to use the “No Overlap” feature (see page 48) or polyphonic voicing (see page 101).

• One note will often be displayed as two notes with a tie. This is only how the program displays the note, there is still only a single note “stored”.

![Single note display example]

This single note in Key Edit is displayed as two tied notes in Score edit.

• Generally the program adds ties where necessary (if a note stretches over a beat), but not always. For more “modern” notation of syncopated notes (less ties), you will need to use the syncopation feature described on page 49.

![Syncopation example]

The same note, without and with Syncopation.

• If you specifically want a long note to be displayed as two (or more) tied notes, you can use the Cutflag tool for this.

• If a note has the wrong accidental, this can be changed. See page 129.

• If two notes on the same position are too close to each other or if you want their “graphical order” in the score reversed, you can do this without affecting playback. See page 148.

• Stem direction and length is normally automatic, but you can set it yourself. See page 124.

• If you are scoring for piano and therefore (or for other reasons) need a split staff, there are special techniques for this, described on page 85 and page 101.
If you run into Trouble

Below follow a few simple troubleshooting steps that will help you pinpoint some common mistakes:

• The note I put in has the wrong length. For example, I added a sixteenth and got a quarter note.
You probably have the wrong Display Quantize value set. Open the Staff Settings. If Auto Quantize is on, turn it off, unless you have mixed triplets and regular notes. Also check the Note and Rest Quantize. If the settings are too “coarse”, change them to a smaller note value. If you for example need the program to display an eighth note rest, Rest Quantize must be set to “8” or a smaller note value (please refer to “How the Score editor works”). If Overlap is on, you might want to turn it off.

• There is a pause after a note that I don’t want.
You probably added a note with the wrong note value. Either lengthen the note (physically or graphically - see page 82) or delete the one you have (see page 74) and add a new one with the correct note value.

• There is no pause after the note although there should be one.
Either the note is too long (delete and enter a new one or change the current note’s length, physically or graphically). Or, your Rest Display Quantize is set to too large a note value. Open Staff Settings and lower it.

• The note has an accidental when it shouldn’t, or it doesn’t when it should.
Maybe the note is simply of the wrong pitch? Click on it (using the arrow tool) and look at the info line (if this is shown, see page 25). Move it to the correct pitch (see page 80). If this is not the reason, maybe you have the wrong key set? And last, enharmonic shifting is described on page 129.

• Notes are not grouped under beams the way I want it.
Normally the program groups eighth notes, sixteenths etc. under beams. This can be turned off. There is also detailed control of which notes are grouped under a beam. This is all described on page 136.
Selecting notes

In the operations described in the rest of this chapter, you will often work on selected notes. The text below describes how to select notes in various ways:

By clicking

To select a note, click on its note head with the Arrow tool. The note head gets inverted to indicate that it is selected.

• To select more notes, hold down [Shift] and click on them.

• To deselect notes, hold [Shift] down and click on them again.

• If you hold down [Shift] and double click on a note, this note and all the following notes in the same staff are selected.

Using a Selection Rectangle

1. Press the mouse button with the Arrow tool in some free (white) space in the score.

2. Drag the mouse pointer

A rectangle with a dotted outline appears. You can drag to select voices on several voices or staves if you wish.

3. Release the mouse button.

All notes with their note heads inside the rectangle get selected.

If you want to deselect one or more of the notes, hold down [Shift] and click as described above.


Using the Keyboard

By default, you can step through the notes in the staff using the left and right arrow keys. If you press [Shift], you will select the notes as you step through them.

- If you have Polyphonic Voices turned on, you will only step through the notes in the current Voice.
- If you want to use other keys for selecting notes, you can customize the settings in the Key Commands dialog on the File menu (in the Navigate category).

Selecting Tied Notes

Longer notes are often displayed in the score as one note with a tie. When you intend to select the entire note for deleting etc., you should select the first note, not the tied note.

There is a preference for this in the Preferences–Scores dialog: If you activate “Tied notes selected as Single Units”, the whole note will be selected, even if you just click on one of the tied notes.

Deselecting Everything

To deselect everything, simply click with the Arrow tool in some “free” (white) space in the score.
Deleting Notes

Notes can be deleted in two ways:

Using the Eraser tool

1. Select the Eraser tool from the toolbar or Quick menu.

   ![Quick menu with Eraser tool highlighted]

   The Eraser tool on the Quick menu.

2. Click on the Note(s) you want to erase, one at a time or drag over them with the mouse button pressed.

Using the keyboard or delete menu item

1. Select the notes you want to delete.

2. Select Delete from the Edit menu, or Press [Delete] or [Backspace] on the computer keyboard.
Moving Notes

About the Lock Layers

When you are moving and editing notes in the score, you might accidentally move other objects near by. To avoid this, you can assign different types of objects to different “Lock Layers” (up to three) and instruct Cubase SX to “lock” one or two of these layers, making them unmovable.

There are two ways to set up which type of object should belong to which Lock Layer:

• Open the Preferences dialog from the File menu and select the Scores–Event Layer page.
  This page lets you adjust the layer setting for each object type.

• Right-click on one of the Layer buttons (1-2-3) in the extended toolbar to bring up a pop-up menu, showing which object types are associated with that layer. A checkmark for an object type means it belongs to that layer. If no checkmark is shown, you can select the object type from the pop-up menu, thereby moving it to that layer.

To lock a layer, click on its number on the Lock Layer button, so that it goes dark. You can only select or move objects whose layer number is lit. For more detailed information, see page 186.

• There are also “L” and “G” layer buttons, for the layout and global layer, respectively.
  Clicking these buttons allow you to lock the layout layer and global layer in the same way. See page 160.
Activating auditioning

Auditioning activated

If you want to hear the pitch of the note while moving, activate the speaker icon on the toolbar. When it is on, you will hear the current pitch of the “dragged” note, as described below.

Moving by dragging

1. Set the Quantize value.
   The Quantize value will restrict your movement in time. You can not place the notes on positions smaller than the Quantize value. If Quantize for example is set to “1/8 Note”, you will not be able to move the notes to a sixteenth note position. However, you will be able to put them on any eighth note, quarter note, half note or whole note position.

2. Select the note(s) you plan to move.
   You can select across several staves if you wish.

3. Click one of the selected notes and drag it to a new position.
   The horizontal movement of the note is “magnetically attracted” to the current Quantize value. The position boxes on the toolbar show what the new position and pitch for the dragged note will be.

   • If the option “Show Note Info by the Mouse” is activated in the Preferences - Scores dialog, the position and pitch of the note will also be shown in a “tool tip” next to the pointer while you’re dragging.
     If you find that screen redraws are too sluggish, you may want to deactivate this option.

4. Release the mouse.
   The notes appear at their new position.

   • If you press [Ctrl]/[Command] and drag, movement is restricted to vertical or horizontal only (depending on in which direction you drag).

   • If you move notes vertically and the option “Keep moved notes within key” is activated in the Preferences–Scores dialog, the notes will be transposed within the current key only.
Moving by using key commands

Instead of dragging the note with the mouse, you can assign key commands for this:

- The commands for which you should assign keys are found in the Nudge category in the Key Commands dialog. The commands are listed as “Left”, “Right”, “Top” and “Bottom”.
- When moving notes to the left or right using key commands, the notes will be moved in steps according to the current Quantize value. The keys assigned for up/down nudging will transpose notes in semitones steps.

Moving across staves - the Lock button

If you are editing several tracks, you may want to move notes from one staff to another. Proceed as follows:

1. Set Quantize and select the notes as described above. You may select notes from several staves, but only the ones on the stave from which you actually dragged will be moved, so this is probably best avoided.

2. Make sure the “L” (Lock) button on the extended toolbar is deactivated.

3. Click on one of the notes and drag them to the new system. The Active staff rectangle indicates on which staff the dragged note(s) will appear.
Duplicating notes

1. Set the Quantize value and select the notes, as for moving.
   You can duplicate any block of notes, even on several systems at the same time.

2. Press [Alt]/[Option] and drag the notes to their new position.
   • If you want to restrict movements to one direction only, press [Ctrl]/[Command].
     This works just as for moving, as described above.
   • If you want to restrict the pitch to inside the current key only, make sure the option “Keep moved notes within key” is activated in the Preferences–Scores dialog.
   • [Alt]/[Option] is the default modifier key for copying/duplicating. If you like, you can change this in the Preferences dialog (Editing–Tool Modifiers page).
     The entry for this is found in the Drag & Drop category (“Copy”).

Moving using the bar handles

You can move or copy whole bars by dragging the bar handles. This is described on page 191.
Cut, Copy and Paste

- To cut notes, select them and select Cut from the Edit menu (or use a key command, by default [Ctrl]/[Command]-[X]). The notes are now removed from the score and put on the clipboard. Below we describe how to insert notes from the clipboard into the score.

- To copy notes, select them and select Copy from the Edit menu (or use a key command, by default [Ctrl]/[Command]-[C]). A copy of the notes is made, and put on the clipboard. The original notes remain where they were.

The Clipboard can only hold one set of notes. If you cut or copy and then cut or copy again, the notes that first were on the clipboard will be lost.

Notes that you have put on the clipboard by cutting or copying can be inserted into the score again, in the following way:

1. Make one staff active.
2. Move the Project cursor to the position where you want the first note to appear.
3. Select Paste from the Edit menu (or use a key command, by default [Ctrl]/[Command]-[V]). The notes are pasted in, beginning at the Project cursor. If the cut or copied notes come from different staves, they will be pasted into their original staves. Otherwise, the notes are put in on the active staff. They keep the pitch and relative positions they had when you cut or copied them.
Editing Pitches of Individual Notes

By dragging

The most basic way to edit the pitch of a note would probably be to drag it up or down. Remember to hold down [Ctrl]/[Command] to avoid moving the note sideways as well.

- If the option “Keep moved notes within key” is activated in the Preferences–Scores dialog, notes will be transposed within the current key only.
- To avoid accidentally moving the note into another staff, activate the Lock button as described on page 77.

Using key commands

Instead of transposing the note with the mouse, you can assign key commands for this.

- The commands for which you should assign keys are found in the Nudge category in the Key Commands dialog. The commands are listed as “Top” (transpose one semitone up) and “Bottom” (transpose one semitone down).

Using the info line

You can use the Info Line to change the pitches (and other properties) of one or several notes numerically, as described in the Operation manual.

- If you have several notes selected and change the pitch on the info line, the changes will be relative. That is, all selected notes will be transposed by an equal amount.
- If you have several notes selected, hold down [Ctrl]/[Command] and change the pitch on the info line, the changes will be absolute. That is, all selected notes will be set to the same pitch.
**Via MIDI**

1. On the toolbar, activate the MIDI in button and the pitch (note) button to the right.
   If you also want to change the note-on and/or note-off velocity of the notes via MIDI, this can be done by also activating the corresponding velocity buttons, as described in the chapter about MIDI editing in the Operation Manual.

   ![MIDI Buttons](image)

   To edit pitches only, via MIDI, set up the buttons like this.

2. Select the first note you want to edit.

3. Press a key on your MIDI keyboard.
   The note takes on the pitch of the key you pressed. The program then selects the next note.

4. To change the pitch of the now selected note, simply press the corresponding key as for the first note.
   In this manner you can change the pitches of as many notes as you wish, by simply pressing the relevant keys. You can also use key commands (by default the left and right arrow key) to step around among the notes. If you for example made a mistake, you can step back to the previous note by pressing the left arrow key.
Changing the Length of Notes

When it comes to note lengths, Score edit is special in that it doesn't necessarily display the notes with their actual length. Depending on the situation, you may want to change the “physical length” of the notes or the “display length”.

Changing the “physical” length

This will change the actual length of the notes. The change will be reflected when you play back the music.

Remember that the appearance of notes and rests in the Score is determined by the Display Quantize settings in the Staff Settings dialog. Depending on the Display Quantize “Notes” and “Rests” values, notes may be displayed as if they were longer than they really are (see page 10).

By using the Note tool

1. Select a Note value that you wish to apply to the Note. This can be done by clicking a note value icon in the extended toolbar, by selecting a new Length value or by pressing keys on the computer keyboard.
2. Select the Note tool if it isn’t already selected.
3. Hold down [Alt]/[Option] and click on the notes you wish to set to this length.

By using the extended toolbar

Using the extended toolbar is another quick way to set a number of notes to the same length:

1. Select the notes you want to change.
2. Hold down [Ctrl]/[Command] and click on one of the note icons on the extended toolbar. All the selected notes are now given the length of the clicked note.
By using the info line

You can also edit length values numerically on the info line. The same rules apply as when changing the pitch of notes (see page 80).

Lengthening a note by gluing two notes together

You can create unusual note length values by gluing notes of the same pitch together.

1. Insert the notes you want to glue together (if they don’t already exist).

2. Select the Glue tool from the toolbar or Quick menu.

3. Click on the first note.
   This note will now be tied to the first note after it, that has the same pitch.

   Make sure you have a display note/rest quantize value that allows you to display notes of the created note value.

4. If you want to glue more notes, click again.

   By gluing together a quarter note, an eighth note and a sixteenth note...

   ...you get a double dotted quarter note.
**Changing the Display Length**

If you want to change the displayed length of notes without affecting how they play back, the first thing to try is to adjust the Display Quantize, either for the whole staff or for a separate section, using the Quantize tool (see page 56). But you can also make length adjustments to individual notes in the Note Info dialog:

1. Double click on the head of the note.
   The Note Info dialog opens.

2. Locate the “Displ. Length” setting.
   By default, this is set to “Auto”, meaning that the note will displayed according to its actual length (and the Display Quantize settings).

3. Set a new length value (displayed in bars, beats, sixteenth notes and ticks).
   To set the Display Length to “Auto” again, scroll the value down to zero.

4. Click OK to close the dialog.
   The note will now be displayed according to its Display Length setting. However, the Display Quantize settings still apply!

**Splitting a Note in two**

If you have two notes strung together by a tie, and click on the “tied” note head with the scissor tools, the note will be divided into two, with the respective length of the “main” and the tied note.

Before and after splitting a tied note.

**Working with the Quantize tool**

There are instances when you will want different Staff Settings on different sections of the track. The settings in the Staff Settings dialog are valid for the entire track, but by using the Display Quantize tool you are able to insert changes and exceptions wherever you like. This is described in detail on page 56.
Split (Piano) staves

Setting up the Split staff

1. Make a staff active.

2. Open the Staff Settings dialog for the staff and select the Polyphonic tab.

3. From the Staff Mode pop-up, select Split.

4. Set the Splitpoint value to a suitable note.
   All notes below this will be put on the lower clef, all above will be put on the upper clef.

5. Click the Main tab and select a clef and key.
   When you set a key for the upper staff, this setting is automatically copied to the lower staff. To set a separate key for the lower staff, activate “Lower staff” and then change the key.

6. Make whatever additional Staff Settings you need.
   These will apply to both the upper and lower clefs.

7. Click Apply.

Before and after setting a Split at C3.
Adding notes

This is done just as on a single system, see page 68. Please note the following:

• When you enter a note, use the pitch box (on the toolbar) to determine the pitch. Whether it winds up on the upper or lower staff has nothing to do with where you aim with the mouse. The Splitpoint setting always decides if a note goes on the upper or lower clef. If you change the split point, this will affect existing notes, see below.
• Sometimes a fixed split point isn’t good enough. You might want to put two notes with the same pitch on different staves in different parts of the piece. To achieve this you need to use Polyphonic Voicing, see page 101.

Changing the Split Point

1. Open the Staff Settings dialog for the system you are working on.
2. Select the Polyphonic tab.
3. Change the Splitpoint value.
4. Click Apply.

Now, some notes that were previously on the lower staff will be on the upper, or vice versa.
Strategies: Multiple staves

As described above, when you have parts on several tracks selected in the Project window, these will be put on one staff each, when you open the Score editor. This allows you to work on several staves in parallel.

Working with several staves is not much different from working with one. Below follow some guidelines that apply specifically to working with multiple staves.

Staff Settings

- As described above, the settings in the Staff Settings dialog are local to each staff. You can have the Staff Settings dialog open and select each staff in turn to make settings - just remember to click Apply before selecting another staff, otherwise your changes will be lost.
- If several staves share settings, you will save some time by using Staff Presets. Set up the Staff Settings for the first staff, then make those settings a Preset. This Preset can then be applied to any of the other staves, one at a time. See page 94 for details.

Selecting Notes

- You can select notes from one or several staves at the same time, using any method of selection, as described on page 72.

Adding Notes

- You can add notes to any staff by just clicking inside it. The active staff rectangle will move to the staff where you input the note.
- If you need to put in a note with a very high or low pitch, which makes it wind up on the wrong staff when you click, first enter a note with the wrong pitch, and then edit its pitch as described on page 80.
Inserting and editing clefs, keys or time signatures

It is possible to insert a change of key signature, clef, or time signature anywhere in the score:

Inserting a Symbol on one staff

1. Select “Clef etc.” from the “Symbol Palettes” menu on the Scores menu
   This opens up the “Clef etc.” Palette, which contains clef, key and time signature symbols.

2. Click in the palette to select the symbol you wish to insert.
   The Pencil tool is automatically selected (see also page 170).

3. Move the mouse over the staff where you want to insert a new symbol.
   Use the mouse position box to find the exact location. The vertical position is of no relevance as long as you click somewhere in the staff. Time signature changes can only be inserted at the beginning of a bar.

4. Click the mouse button.
   A dialog appears, allowing you to select the desired clef, key or time signature. For details on the Time Signature dialog, please see page 30.

5. Select an option from the dialog and click OK.
   The symbol appears. If there is room for it in the bar, the notes are moved to make room for it. If not, you will have to use Auto Layout or make manual adjustments (see Moving Clefs below).

- Inserting a symbol at position 1.1.1.0 is the same as changing the Staff Settings which are stored in the track. Inserting anywhere else adds the change to the part.
Inserting a symbol on all staves

If you hold down [Alt]/[Option] when you click with the Pencil tool to insert a symbol, it will be inserted at this position on all staves currently being edited in the Score editor. Note:

• **Time signature changes are always inserted on all tracks in the score.**
  Or rather, they are inserted on the Tempo track, which affects all tracks.

• **For key changes, Display Transpose is taken into account.**
  This allows you to set all staves to a new key and the staves set to Display Transpose will still show the correct key after the key change.

• **If some of the staves are bracketed (straight brackets only, as set up in the Layout Settings dialog - see page 263), inserting a symbol for one of these staves will insert it for all other staves within the bracket.**
  Staves outside the bracket will not be affected.

Editing Keys, Clefs and time signatures

If you double click on a symbol, the same dialog appears as when you inserted it. This allows you to change the settings for it.

If you hold down [Alt]/[Option] when double clicking, all symbols at the same position are changed accordingly. With key signatures, the Display Transpose value is taken into account as described above.

• You will find several options for how key, clef and time signature changes should be displayed in the Notation Style - Switches dialog on the Scores - Global Settings menu.
  You can also adjust the automatic spacing between these symbols in the Spacings dialog on the same menu. See the dialog help for details.
Moving Clefs

Clefs inserted into the score have an effect on how notes are displayed. If you for example insert a bass clef in the middle of a treble staff, the staff switches to show bass pitches. Therefore it is very important where you insert the clef.

However, you might want to move the clef graphically, without disturbing this relation between the clef and the notes. Proceed as follows:

1. Select the Graphic Move tool.
   This is available in Page Mode only.

   ![Object Selection 1
   Erase 5
   Zoom
   Insert Note
   Split 3
   Glue 4
   Display Quantize
   Graphic Move
   Cut Notes
   Draw 8
   Line

2. Click and move the clef just as with the normal Arrow tool.
   Now the clef is moved, but the score is still interpreted as if it remained in its original position.
5

Staff Settings
In this Chapter you will learn:

- How to make Staff Settings.
- How to work with staff presets.

Staff Settings

Below follows a run-through of all Staff Settings, more detailed information about the ones already described and references to other places in the manual for some options.

This is where you enter the name for the staff. Normally, the long name is shown at the beginning of the score, while the short name is shown for the remaining systems.

The dialog has four tabs - here, the Main tab is selected.

Use this section to select keys and clefs.

Use this section to set up how the display should be quantized - the displayed spacing and length of notes.

This section contains additional settings for how the notes are displayed.

Use this section to select and apply presets, or turn the current settings into a preset.

This is where you specify the Display Transpose, for instruments that are not scored in concert key.
Making Settings

1. Open the Staff Settings dialog.

2. With the Staff Settings dialog open, make the desired staff active.
   Click anywhere in a staff to make it active, or use the up and down arrow keys to step
   from staff to staff.

3. Select the desired tab in the dialog and make whatever settings you
   need to do.
   The settings for regular staves are found on the Main and Options tab, the Polyphonic
   tab contains settings for split systems and polyphonic voices while the Tablature tab
   lets you set up tablature scores.

4. When you have made the desired settings, click Apply.
   The settings are applied to the active staff.
   • If the option “Apply closes Property Windows” is activated in the Prefer-
     ences (Scores page), clicking Apply will also close the dialog.

5. Select another staff, make settings for this and click Apply.
   Repeat this until all staves have the right settings.

6. If you want to close the dialog, click its close box as usual.
Working with staff presets

You will spend some time making Staff Settings for your scores. Staff presets allow you to reuse those settings whenever you work with a staff similar to one you have worked on before. A staff preset contains all the settings in the Staff Settings dialog except the key.

• To store the current settings (including the settings on the Options tab, see below) click the Store button in the Presets section of the dialog.
  Enter a name for the preset in the name dialog that appears, and click OK. The preset will now be available on the staff presets pop-up menu (in all Projects).

• To load a preset, select it on the Presets pop-up menu.
  Note that this loads the settings in the preset into the dialog - to apply these to a staff you must click the Apply button as usual. You can also apply staff presets directly in the score - see below.

• To remove a preset, select it from the pop-up menu and click the Remove button.

Applying a preset directly in the score

If you right-click directly to the left of a staff, a pop-up menu will appear, listing all available presets. Select one to apply it to the staff.

How staff presets are stored

The staff presets are stored as individual files in the Presets-Staff Settings folder within the Cubase SX program folder. The presets are available for selection in any Project you create or edit.
Staff names

These fields allow you to specify a “long” and a “short” name for the staff. The long name is shown for the very first system for the staff in the score (at the start of the song), while the short name is shown for the remaining systems.

- Whether the names should be shown at all is set in the Layout Settings (see page 231). There, you can also opt to use the names of the edited MIDI tracks instead.
- If you only want the “long name” to be shown (i.e. if you don’t want a name shown for each system in the score), simply delete the short name.
- If the option “Show Long Track Names on new Pages” is activated in the Notation Style dialog (Scores-Global Settings menu), the long name will be shown at the beginning of each new page.

Key and Clef

The basic key and clef settings are described in detail on page 30. There is also a Lower staff check box which is only used in conjunction with split (piano) staves and Polyphonic Voicing. This is described on page 34.
Display Quantize and interpretation flags

These two sections of the dialog contain a number of settings used to determine how the notes should be interpreted. While these settings are more critical to making MIDI recorded music appear as legible as possible it is still important to have them set correctly when entering notes using the mouse. Below you will find a brief summary of the settings - for more details, see page 46.

Notes and Rests Quantize values

• Generally, the Note Quantize value should be set to a value equal to, or smaller than, the "smallest note position" you want to be shown in the score.
• The Rest Quantize value should be set to a value equal to, or smaller than, the smallest note value (length) you want to be displayed for a single note, positioned on a beat.
• If the score contains only triplets, or mostly triplets, select one of the Triplet options.

Auto

• If the piece contains no triplets or only triplets, deactivate this option.
• If the piece contains mixed triplets and straight notes, activate this option (the additional options are described in detail on page 47).
Interpretation Flags

<table>
<thead>
<tr>
<th>Activate This</th>
<th>When</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean Lengths</td>
<td>When you find the program generally interprets your notes as shorter than you expect. See page 47.</td>
</tr>
<tr>
<td>No Overlap</td>
<td>When notes starting at the same position, but having different lengths, give you more ties than you want. See page 48.</td>
</tr>
<tr>
<td>Syncopation</td>
<td>When the program adds more ties to notes crossing beats and bar lines than you prefer. See page 49.</td>
</tr>
<tr>
<td>Shuffle</td>
<td>When you have played a shuffle beat and want it displayed as straight notes (no triplets). For details see page 50.</td>
</tr>
</tbody>
</table>

Display Transpose

This is used when preparing parts for instruments that are not scored at the actual concert key. For example, if you want the note C3 to be played by an alto sax, you have to score it as an A3 - nine semitones up. Luckily, the Display Transpose setting takes care of this for you:

- Use the pop-up menu to select the instrument for which you’re scoring.
- If the pop-up menu doesn’t list the needed instrument, you can set the desired transposition with the Semitones value field.
- The Display Transpose setting doesn’t affect playback or the actual pitch of the notes - it only changes how they are displayed and printed.

You can also insert Display Transpose changes anywhere in the score, by inserting a key change symbol and using the Transpose setting in the Key dialog (see page 37).
The Options tab

Clicking the Options tab in the dialog brings up another page with additional settings (which can be made part of a staff preset just like the other settings). Below follows a brief description of these, with references to more detailed explanations.
Switches

<table>
<thead>
<tr>
<th>Activate This:</th>
<th>When:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flat Beams</td>
<td>When you want the beams over notes to be flat (as opposed to slanted). See page 143.</td>
</tr>
<tr>
<td>No Beams</td>
<td>When you don’t want any beaming at all on the staff (for example for vocal scoring). See page 136.</td>
</tr>
<tr>
<td>Beam Subgroups</td>
<td>When you want sixteenth notes displayed under a beam to be divided into two groups of eight notes. See page 142.</td>
</tr>
<tr>
<td>16th Subgroups</td>
<td>When you want even smaller subgroups of sixteenth notes. This setting has no effect if Beam Subgroups is turned off.</td>
</tr>
<tr>
<td>Consolidate Rests</td>
<td>When you want two rests joined to one (for example an eighth note and a sixteenth note rest displayed as a dotted eighth note rest). See page 52 for an example.</td>
</tr>
</tbody>
</table>

System Sizes

This section allows you to set the number of system lines and to control spacing between the lines:

<table>
<thead>
<tr>
<th>Setting:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Lines</td>
<td>The number of lines in a system. For regular scoring, this should be set to 5.</td>
</tr>
<tr>
<td>Add Space</td>
<td>Allows you to increase or decrease the space between the lines in a system.</td>
</tr>
<tr>
<td>Size</td>
<td>Allows you to set a size for the systems, as a percentage (with 100% being the default value). In effect, this setting scales the score vertically.</td>
</tr>
</tbody>
</table>

See page 286 for an example of how this can be used with Tablature.

Drum Map settings

These settings are all described in the chapter "Scoring for Drums".
Fixed Stems

If you activate this checkbox, the stems of all notes will end at the same vertical position. This feature is perhaps most often used when scoring for drums (see page 278).

A drum pattern with Fixed Stem Length activated.

The Up and Down parameters determine which position (relative to the top of the staff) should be used for up and down stems, respectively. The graphical display helps you get your settings right.

The Polyphonic and Tablature tabs

These are described in the chapters “Polyphonic Voicing” and “Creating Tablature”, respectively. For now, just note that the Polyphonic tab contains the Staff mode pop-up, which determines whether the staff should be a single system, a split (piano) staff or use polyphonic voices.
6 Polyphonic Voicing
In this chapter you will learn:

- How to decide when to use polyphonic voicing.
- How to set up voices.
- How to automatically convert your score to polyphonic voicing.
- How to enter and move notes into voices.

Background: Polyphonic Voicing

Polyphonic voicing allows you to resolve a number of situations impossible to score properly otherwise:

- Notes starting at the same position, but with different lengths. Without polyphonic voicing you get unnecessary amounts of ties.

Without and with polyphonic voicing.

- Vocal scoring and similar. Without polyphonic voicing, all notes starting at the same position are considered parts of a chord. With Polyphonic voicing you can give each voice a stem direction, you can have individual rest handling for each voice etc.

Without and with polyphonic voicing.

- Complicated piano systems. Without polyphonic voicing you have to resort to a fixed split note setting to decide which notes go on which clef. With polyphonic voicing the split point can be "floating". The program can even automatically put a bass line on the lower clef for you!

With a Split system and with polyphonic voicing.
How voices are created

There are eight voices. The first thing you do is to set them up. This includes “telling” the program which voices belong to the upper clef and which belongs to the lower, how you want rests displayed for each voice, etc.

The second thing you do is to move or enter notes into the voices. If you have a recording done already, the program can do much of this work for you, automatically. You might then want to fine tune by moving one or more notes into another voice, or you might want to add notes to a certain voice.

Each voice is polyphonic. In other words, one voice can contain chords.

Overlapping notes

Throughout this chapter you will encounter the term “overlapping notes”. Two notes are considered overlapping when they are on the same staff and:

• They start at the same position, but have different note values (for example a whole note and a quarter note both at the beginning of a bar), or...

\[
\begin{array}{c}
\text{Notes starting at the same position, without polyphonic voices.} \\
\end{array}
\]

• One note starts before another has ended. For example a half note at the beginning of a bar and an eight note at the second beat.

\[
\begin{array}{c}
\text{A note that starts before another has ended, without and with polyphonic voices.} \\
\end{array}
\]
Voices and MIDI channels

Internally the program organizes the notes into voices by changing their MIDI channel values. Normally you set it up so that notes with MIDI channel 3 belong to voice 3 etc. Most of the time the link between MIDI channels and voices will be totally transparent to you as a user. But sometimes you can take specific advantage of this relation, as described later in this chapter. There are also a few other important things to note:

- When you make a note part of a voice, you are in fact changing its MIDI Channel value.
  However, when you change the voice's MIDI channel values in the setup dialog, this does not affect the notes' MIDI channel setting. This can lead to serious confusion, since the relation between the notes and the voices is affected. It might even make notes disappear (the program will warn if this happens). In other words, don't change the MIDI channels in the polyphonic voices dialog after you have put your notes into voices, unless you are absolutely sure of what you are doing.
  Also please note that when you open a part that contains notes on different MIDI channels, these notes are de facto already assigned to voices (since notes are assigned to voices using their MIDI channel setting). While this fact can be put to good use, it can also create confusion, and even disappearing notes, as described above.
Setting up the voices

This text describes the Polyphonic Settings dialog, in general. Below you will find more detailed explanations on how to select from the multitude of options.

- You can also convert existing tracks into polyphonic voices automatically, using the Merge All staves function.

1. Open the Staff Settings dialog for the staff.
2. Select the Polyphonic tab.
3. Pull down the Staff Mode pop-up and select Polyphonic.

This makes the voice list in the lower part of the dialog available. It consists of eight rows with one voice in each. They are numbered and therefore we refer to them as voices 1 to 8.

- Do not confuse the voice numbers with the MIDI Channel setting for each voice.
4. To activate a voice, click in its "On" column, so that a tick mark appears.
There are four voices on each staff, for a total of eight. If you activate at least one "upper" voice and one "lower" voice, you will get a split (piano) staff.

5. If you have particular reasons to use specific MIDI channels, change the "Chan" settings for the voices.
The program automatically sets each voice to a different MIDI channel. If you don’t have good reasons to make changes, leave the settings as they are.

Please note the warnings about changing the MIDI Channel settings, on page 104. Also note that if two voices are set to the same MIDI Channel, the lower will be treated as if it was turned off.

6. Click in the “Rests–Show” column to decide for which voices you want rests displayed.
A tick mark indicates that rests will be shown for a voice. Often you will only want rests to be shown for one voice per staff, see below.

7. If you have activated “Rests–Show” for a voice, but don’t want rests to be shown in empty bars, click in the “Rests–Reduce” column for that voice.
This is especially useful for cue voices, see page 150.

8. Click in the “Rests–Center” column to determine at which vertical positions rests should be shown (for voices with “Rests–Show” activated).
When this option is activated for a voice, the rest will be put in the vertical center of the staff, when it is not, the rest will get a vertical position based on the pitch of the notes.

9. Decide for a stem direction for each voice, by selecting from the pop-up in the Stems column.
If you select Auto, the program will make decisions about which stems go in which direction (just as when not using polyphonic voices). Regardless of which option you show, you can always force stem direction for individual notes by using the Flip Stem function, see page 125.

There is a special Stem feature for voice 1: If you set this to Auto, the stem direction will depend on the pitch of the note as usual - except if there are voice 2 notes in the bar, because then the voice 1 stems will automatically be set to Up!
10. If you want the notes in a voice to be smaller than regular notes, put a tick mark in the Cue column for the voice.

11. Click Apply.
   The staff is changed to polyphonic voicing, and the program distributes the existing notes into voices according to their MIDI channel values.

- At this point you may want to use the Explode function to automatically move notes into the proper voices. See page 113.

If the “Some Notes Do Not Belong To Voices...” dialog appears

When you click Apply, a warning may appear saying “Some notes do not belong to any voice and may be hidden. Correct these notes?”.

This warning appears when the staff contains notes with MIDI Channel settings which do not match any of the active voices.

If you click the “Correct” button, these notes will be moved to active voices. If you click “Ignore”, nothing will be changed, and some notes will be hidden. However, they are not lost, they appear in all other editors and can be made to appear again in Score edit if you change the channel settings for the notes or voices, activate more voices, etc.
About the Polyphonic Presets

The Presets pop-up menu on the Polyphonic Settings tab contains three very useful setups. Instead of making settings by hand, you can select one of the presets, thereby saving some time. The presets are:

Variable Split

This sets up the dialog for two voices, one on each staff, each with auto stem direction. This is a good starting point for a piano staff when the fixed split option doesn’t suffice.

Optimize two voices

In this preset, only voices 1 and 2 are activated, and set up like this:

<table>
<thead>
<tr>
<th>Properties</th>
<th>Rests</th>
<th>Stems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Num</td>
<td>Chan</td>
<td>Cue</td>
</tr>
<tr>
<td>1</td>
<td>✓</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>✓</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>

This way the first voice behaves as in Single staff mode, but if there are notes in the second voice, the stems of the first one are set to up.

Optimize four voices

This is like “Optimize Two Voices”, but with two staves. Voices 5 and 6 are activated as well, with the same settings as voices 1 and 2. This is the recommended way to write piano music.
Strategies: How many voices do I need?

Well, it depends...

- If you are scoring for vocals, you simply need one voice for each voice, so to speak.
- Often you will use voices for resolving the problem of overlapping notes (see page 103), for example when scoring for piano. In this case, you will need two voices each time two notes overlap. If three notes overlap, you will need three voices. In other words you will need to check for the “worst case” (largest number of overlapping notes at a certain position) and activate that many. If you don’t know how many notes you need when starting out to prepare a score, don’t worry, you can add more voices later.
- Voices 1 and 2 on the upper staff and 5 and 6 on the lower are special. These handle “collisions” (notes with small intervals, accidentals that otherwise would come too close, etc.) automatically which the other voices don’t. Always use these voices first!
- An example: in the situation below, three voices are required. The lowest note overlaps both the “melody” and the chords, so it can’t share a voice with the chords. The chords overlap the melody, so they can’t share a voice either.
**Entering Notes into Voices**

When you add new notes, you need to decide which voice they go into:

1. Make sure the extended toolbar is visible.
2. Select the Arrow tool.
3. If you have a split system, check the Voice Insert buttons. These are displayed after the text “Insert” on the left side to the extended toolbar. Only the Voices that are activated in the Polyphonic Settings dialog are shown. If the upper staff is active, the Voice Insert buttons are numbered 1, 2, etc., otherwise they are numbered 5, 6, etc.

![Voice Insert Buttons](image)

The Voice Insert buttons – here three voices are activated on the upper staff.

4. If you need to switch the voice icons to the right “clef”, click somewhere in the system you want to insert notes in.
5. Select one of the voices by clicking on the corresponding button. Any notes you enter from now on will now be inserted into that voice.

![Voice 3 Activated](image)

Voice 3 activated for insertion.

6. Insert the notes as usual.
7. If you want to switch to another voice, click on the corresponding button.
8. If you want to insert notes into a voice on the other clef, click on that clef and then select a voice using the buttons.

**Symbols and Voices**

Later in this manual you will learn about symbols that can be added to the score. Many of these symbols must also put into a particular voice. See page 169.
Checking which Voice a Note belongs to

When you select one (and only one) note, the corresponding Voice button on the extended toolbar gets selected. This allows you to quickly find out which voice a certain note is in (after a Move To Voice for example).

- When you step through the notes using the arrow keys, you will only step through the notes in one voice at a time. This can be used as quick way to check which notes belong to the same voice as some other note.
Moving notes between voices

Manually

To manually move notes to a particular voice, proceed as follows:

1. Select the Note(s) you want to move to a particular voice.
2. Select Move to Voice from the Scores menu.

3. On the submenu, select the voice to which you want to move the notes.
   Voices not activated are shown in grey.

   • Alternatively, you can press [Ctrl]/[Command] and click a Voice Insert button on the extended toolbar to move the selected notes to the corresponding voice.
   You can also assign key commands for this in the Score Functions category of the Key Commands dialog on the File menu.
Automatically - the Explode function

The Explode function distributes notes, either into new tracks (see page 58) or into polyphonic voices:

1. Pull down the Scores menu and select “Explode...” from the staff Functions submenu.

The Explode dialog, set to create tracks.

2. Make sure “To Polyphonic Voices” is selected at the top of the dialog.

3. Use the lower half to set up the criteria for the split.
   Choose from the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split Note</td>
<td>Use this to move all notes below a certain pitch to another voice.</td>
</tr>
<tr>
<td>Lines To tracks</td>
<td>Use this when you want all musical “lines” to be put in one voice each. The notes with the highest pitch will go to the first voice, the notes with the second highest pitch will go to the second, and so on.</td>
</tr>
<tr>
<td>Bass To Lowest Voice</td>
<td>When this is activated, the lowest notes will always end up in the lowest voice.</td>
</tr>
</tbody>
</table>

4. Click OK.
   The notes are distributed to different voices.
Alternative Ways of handling Voices

Below we suggest some other “advanced” ways of putting notes into Voices. This is based on the relation between voices and MIDI Channels, so please make sure you understand how this connection works.

• You can use the Logical editor (described in its own chapter in the Operation Manual) to put notes into voices, based on other more complex criteria, like for example their pitch and length. This is done by setting up Logical Edit so that the notes that meet the criteria get their MIDI Channel changed to that of their Voice.

• When you enter notes using Step Input you can change the MIDI Channel on your input device and thereby directly enter notes into separate Voices.

• You can play back each Voice on a different MIDI Channel, simply by setting the track to Any. This can for example be used as a convenient way of “proof-hearing” each voice separately.

• You can use the Input Transformer to assign a certain key range to a MIDI Channel, and thereby automatically put notes into voices when recording.

• For brass and vocals, you might record each voice on its own track, and use the “Merge All staves” function to automatically copy each recording to a separate voice on a new track (see page 120).

• When you have assigned parts to voices, you can use the Extract Voices function to create one track out of each voice (see page 121).
Handling Rests

With Polyphonic Voices, you often get more rest symbols than you desire.

• If a Voice doesn’t need any rests at all, you can turn off rests for each voice individually in the Polyphonic Voices dialog.

• If you only need rests from one voice on a staff, turn Rests–Center on for that voice (this is done in the same dialog). If two or more voices have rests, turn Rests–Center off. The program then automatically makes sure the rests don’t “collide” in the score, by adjusting their vertical position.

• To avoid having several rests displayed in empty bars, you can activate the Rests–Reduce option for all voices (that have rests) except one. This option causes the program to hide Rests in empty bars.

• You can use Hide (see page 246) to totally remove individual superfluous rests from the Score.

• You can use the Arrow tool to manually move rests up/down or sideways to adjust the “picture”.

• If needed you can add “rest symbols” (rests that don’t affect the playback data in any way) by using the symbol palette.
Voices and Display Quantize

When you insert Display Quantize changes (see page 56), you can either apply the settings to all voices (by [Alt]/[Option]-clicking with the tool) or to the current voice only.

If the option “Display Quantize tool affects all Voices” is activated in the Notation Style-Switches dialog (Scores-Global Settings submenu), the Display Quantize settings will always affect all voices (even if you don’t press [Alt]/[Option] and click).

Making Display Quantize settings affect one voice only (by clicking without pressing [Alt]/[Option]) allows you to do two things:

• Make each voice have its own Display Quantize settings by inserting a Display Quantize event for each voice, at the beginning of the staff. This will then be valid for the entire staff, until another Display Quantize event is inserted.
• Insert Display Quantize “exceptions” anywhere in the score, independently for each Voice. Proceed as follows:

1. Make sure the option “Display Quantize tool affects all Voices” is deactivated in the Notation Style-Switches dialog.

2. Select the Voice for which you wish to insert a Display Quantize event.
   This is done by clicking at the corresponding Voice button on the extended toolbar as described above, or by selecting a note that belongs to this Voice.

3. Select the Display Quantize tool.
4. Click at the position you want to insert the event. The Display Quantize dialog appears.

5. Fill out the dialog as described on page 46.

6. Click Apply.
Creating crossed voicings

Often, for example in vocal scoring, you will have crossed voicings on one system. You can of course move notes manually into voices to get the stem direction and other note properties right, but there's a quicker way. Let's explain how to do this by example. Without using polyphonic voicing, you have entered this:

1. Open the Staff settings dialog and select the Polyphonic tab.
2. From the Staff Mode pop-up menu, select Polyphonic.
3. Activate voice 1 and 2 only, and make settings for them as in the picture below.

![Staff Mode Settings](image)

4. Click Apply.
The staff is in Polyphonic mode, but all notes are still in the same voice.
5. Pull down the Scores menu and select “Explode” from the Global Functions submenu.
6. In the dialog that appears, select the “To Polyphonic Voices” option and activate “Lines To Tracks”.
Leave the other options off.
7. Click OK.
The notes have now been split in two “lines”, each in a separate voice. However, from the middle of the bar, notes that are in voice 1 should be in voice 2 and vice versa.
8. Select the two notes that should be moved from voice 1 to voice 2.

![Two notes in Voice 1 selected.](image1)

9. Move the notes to voice 2.

This is quickest done by pressing [Ctrl]/[Command] and clicking the Voice Insert [2] button on the extended toolbar.

![Two notes moved to the right voice.](image2)

10. Select the two notes that should be moved to voice 1 and move them too.

![All notes in the right voices.](image3)

The voicing is now correct, as you can tell from the stem directions. However, there's still some work to do on the notes graphical positions (see page 148) and the display of stems and beams for some of the notes (see page 144). When you have made those adjustments, the score may look like this:

![After graphical adjustments.](image4)
Automatic polyphonic voicing - Merge all staves

If you have already created some tracks which look and play back as they should, and you want to combine these into one track with polyphonic voices, there is a special function on the Scores menu for this:

1. Open the tracks (up to four) in Score edit.
2. Pull down the Scores menu and select “Merge All staves” from the Global Functions submenu.

Now a new track is created and shown in the score. The track will have Polyphonic Voices activated, and the four original tracks will be assigned to one voice each (voices 1, 2, 5 and 6 will be used).

Furthermore, all non-linked symbols, that belongs to the staff that will become the first polyphonic voice in the merged staff, will be copied. They will have same positions as the original symbols.

☐ When you later play back the music, you need to mute the four original tracks, or you will get double notes.
Converting Voices to tracks - Extract Voices

This function does the opposite of “Merge All staves” – it extracts polyphonic voices from an existing track and creates new tracks, one for each voice. Proceed as follows:

1. Open a track containing 2-8 Polyphonic Voices in Score edit.

2. Pull down the Scores menu and select “Extract Voices” from the Global Functions submenu.

A number of new tracks are created and added to the Score edit display. Each track will contain the music from one polyphonic voice. If there were non-linked symbols in the original track, each new track will get a copy of these symbols.

Each new track will also automatically get a Layout (a copy of the original Layout for the Polyphonic Voicing track, with Size set to 100% and Multi Rests set to 1). For more info on Layouts, see page 236.

When you later play back the music, you need to mute the original track (the one with polyphonic voices), or you will get double notes.
CUBASE SX
6 – 122  Polyphonic Voicing
7

Additional Note and Rest Formatting
In this chapter you will learn:

- How to control stem direction.
- How to control beaming, and create cross staff beaming.
- How to make detailed adjustments to note appearance.
- How to perform "graphic moving" of notes.
- How to create grace notes.
- How to create tuplets.

Background: note stems

The direction of stems is governed by six things:

- How notes are grouped under beams.
- Any manual manipulation of beams.
- The Flip Stems function.
- How the Note Info is set for each note.
- How the Polyphonic tab in the Staff Settings dialog is set up (if you use polyphonic voices).

Also, there is a priority system with these steps, as they are listed above. In other words, if you have adjusted the beam slant “by hand" (see below), it doesn’t matter if you previously flipped the stems, or how the note was set up. If you have flipped the stems it doesn’t matter how the notes or voices were set up, etc.

- If you have edited the stem length of a note and then flip it, the stem will be reset to default length.

- If you have activated the “Fixed Stems” option in the Staff Settings dialog (Options tab, see page 100), a lot of the automatic stem length settings are ignored. However, you can still edit the stem length and direction of individual notes.
Setting Stem Direction

In polyphonic voices

Stem direction can be set separately for each voice. This is the stem setting with the lowest priority. It is only valid if no other settings were made specifically.

In the Note Info dialog you find stem direction settings for each voice (see page 127):

Select this: When:

- Up When you want the stems in the voice to point upwards.
- Down When you want the stems in the voice to point downwards.
- Auto When you want the program to take decisions about stem direction, based on the other voices, the notes' pitches etc.

Using Flip Stems

Flipping the stem of a single note

1. Select the note.
2. Click the Flip icon on the extended toolbar.

- You can also assign a key command for this.
  In the Key Commands dialog on the File Menu, the command is called “Tools : Flip” and is found in the Score Functions category.
Flipping the stem of a number of selected notes

1. Select the Notes.

2. Invoke Flip Stems as described above.
   All the stems in the selection are now flipped. Those that pointed up now point down and vice versa.

Flipping the stems of notes grouped under a beam

1. Select any note in the group.

2. Invoke Flip Stems as described above.
   The entire group is now flipped.

Before and after the flip. No matter which note you select, the entire group is flipped.

☐ This will not work if you have adjusted the slanting of the beam by dragging. If you have, you must first reset the beam as described on page 128.

Independent Stem Direction under a Beam

If you need stems attached to the same beam to go in different directions, this is achieved by dragging the beam’s start and end points, as described on page 144. This feature is available in Page Mode only.

Independent stem direction under a beam.
Stem Direction in the Note Info Dialog

The Note Info Dialog can be opened by double clicking on a note head, as described below. In its lower left corner you will find a pop-up for setting stem direction.

- Setting this to Up or Down is the same as using Flip Stems, see above.
- Setting it to Auto makes the program take decisions about stem direction, as described above.

![The Note Info dialog with the Stem pop-up.](image)
Stem length

Adjusting stem length (Page mode)

1. To change the Stem Length, proceed as follows:
2. Click on the end of the stem so that a handle appears.

![Stem handle selected]

3. If you want to change the lengths of several stems at the same time, hold down [Shift] and select these stems as well.
4. Drag the stem handle (on one of the selected stems) up or down. All selected stems will be lengthened or shortened by the same amount.

Resetting stem length and beam slants

1. Make sure the display filter bar is visible (if not, click the F button in the toolbar).
   For more about the filter bar, see page 28.
2. Make sure the “Stems/Beams” checkbox is activated on the filter bar. Now, below the notes where stems have been changed or beam slant adjusted manually, the word “Stem” will appear.
3. Click on the “Stem” text to select it.
4. Press [Backspace] or [Delete] to remove it.

![Before and after deleting the “Stem” item]
Accidentals and Enharmonic Shift

Making Global Settings

In the Accidentals dialog on the Scores-Global Settings submenu, you will find a number of options for how accidentals are displayed in the score. Once set, these are valid for all tracks in the Project. Proceed as follows:

1. Pull down the Scores menu and select “Accidentals” from the Global Settings submenu.

2. Activate one of the four main options by clicking on the graphics:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Notes outside the scale get accidentals. In this mode, accidentals are not repeated within a measure.</td>
</tr>
<tr>
<td>Help</td>
<td>As above, but if a note outside the scale is followed by one inside the scale (in a following measure), this second note will also be displayed with an accidental.</td>
</tr>
<tr>
<td>Force</td>
<td>As Normal, but accidentals get repeated even within the same measure.</td>
</tr>
<tr>
<td>Force all</td>
<td>Every single note in the score gets an accidental.</td>
</tr>
</tbody>
</table>
3. With the radio buttons to the right, you can decide how five of the most common intervals outside the scale should be displayed, as sharps or as flats.

- In the Notation Style dialog (Options tab) on the Scores-Global Settings menu, there is a further option for accidentals, called “Accidentals for Each Note”. When this is activated, all notes get accidentals -even tied notes.

**Enharmonic Shift**

If one or several notes are not displayed with the accidentals you wish, you can perform an Enharmonic Shift on them.

1. Select the notes to be shifted.
2. Click the desired option on the extended toolbar.

<table>
<thead>
<tr>
<th>Select this:</th>
<th>When:</th>
</tr>
</thead>
<tbody>
<tr>
<td>✩ ✩ ✩ ✩ ✩</td>
<td>You want regular Enharmonic Shifting (select one option).</td>
</tr>
<tr>
<td>off</td>
<td>You want to turn off Enharmonic Shifting for the note(s).</td>
</tr>
<tr>
<td>No</td>
<td>You want to Hide the accidental completely.</td>
</tr>
<tr>
<td>?</td>
<td>You want to create a “help accidental” for the selected note(s) only. For more info see the global Help option described above.</td>
</tr>
<tr>
<td>{ }</td>
<td>You want to enclose the accidental in parentheses. To remove these, select “Off”.</td>
</tr>
</tbody>
</table>
Changing the Note Head Shape

1. Select the notes whose note head shape you want to change.
   Make sure not to select the stems, only the note heads.

2. Double click one of the notes or click the “i” button on the extended toolbar.
   The Note Info dialog opens.

3. Pull down the “Note Head” pop-up menu at the top left corner of the dialog.
   The pop-up menu contains all the available head shapes and an “Auto” option, which selects the normal default shape for the note.

4. Select one of the note heads.

5. Click Apply.
   The settings are applied to the selected note(s).

6. If you like, select other notes and make settings for them.
   When you are done, close the dialog by clicking its Close box.

   • You can also select note head shapes directly in the score by right-clicking a note head and selecting an option from the pop-up menu that appears.
Other note details

Each note has a number of settings accessed in the Note Info dialog.

- To open the Note Info dialog, double click on a note head or select one or several notes and click the “i” icon on the extended toolbar.
- If the Note Info dialog is already open, you simply select the desired notes, adjust the settings in the dialog and click Apply. The settings are applied to all currently selected notes.
The Note Info dialog contains the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note Head</td>
<td>Used for selecting custom note head shapes (see page 131).</td>
</tr>
<tr>
<td>Tablature On/Off and number</td>
<td>Used for creating or editing Tablature (see page 281). This feature can be used for individual notes or together with the automatic “Make Tablature” function.</td>
</tr>
<tr>
<td>Bow Up/Bow Down</td>
<td>Used for adding bow up/bow down articulation.</td>
</tr>
<tr>
<td>Display Length</td>
<td>This allows you to change the displayed length of notes, without affecting playback. Note that the Display Quantize settings still apply (see page 96). To reset this value to “Auto” (so that notes are displayed according to their actual length), scroll the value down to zero.</td>
</tr>
<tr>
<td>Accidental Distance</td>
<td>Use this to specify how far from the note, horizontally, you want the accidental. The higher the number the further away.</td>
</tr>
<tr>
<td>No Help lines</td>
<td>Turns off help lines for notes with high or low pitches.</td>
</tr>
<tr>
<td>No Stem</td>
<td>Hides the note stem completely</td>
</tr>
<tr>
<td>Bracket Head</td>
<td>When this is activated, notes will be displayed with brackets:</td>
</tr>
<tr>
<td>X-stem (spoken)</td>
<td>When this option is activated for a note, it is displayed with an x across its stem. This is normally used to indicate spoken words.</td>
</tr>
</tbody>
</table>
### About colored notes

If you have activated the option “Use Colors for Additional meanings” in the Preferences–Scores dialog, some objects will automatically be displayed in color, to indicate that they are “special” in any way. For example, slurs and note symbols that are moved from their default positions (see page 194) will be displayed in red.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Note</td>
<td>Ticking this checkbox will hide the selected note(s).</td>
</tr>
<tr>
<td>Stem pop-up</td>
<td>Determines the stem direction, as described above.</td>
</tr>
<tr>
<td>Tie pop-up</td>
<td>Determines the direction of ties. When this is set to “Auto” (the default setting) the program will choose a tie direction depending on the stem direction of the tied notes.</td>
</tr>
<tr>
<td>Type pop-up</td>
<td>Determines the note type. There are four options:</td>
</tr>
<tr>
<td></td>
<td>• Normal. This is how notes usually are displayed.</td>
</tr>
<tr>
<td></td>
<td>• Grace. When this is selected, notes will be displayed as grace notes. This is described in detail on page 152.</td>
</tr>
<tr>
<td></td>
<td>• Cue. When this is selected, notes will be displayed as cue notes (smaller notes, often used as “guide notes” or optional lines). See page 150.</td>
</tr>
<tr>
<td></td>
<td>• Graphic. These are special notes, useful for example for guitar notation (pull-offs) and trills (as “help notes”, indicating which notes to trill between). In both these cases the “No Stems” option could be useful. Graphic notes are not included in the “automated cutting” (see page 146). They are positioned after the note(s) they “belong to” (as opposed to grace notes).</td>
</tr>
<tr>
<td>Grace Note options</td>
<td>These options are enabled when Grace is selected on the Type pop-up menu. See page 152.</td>
</tr>
</tbody>
</table>

---

CUBASE SX
7 – 134  Additional Note and Rest Formatting
Copyng Settings between Notes

If you have made various settings in the Note Info dialog for a note, and want to use these settings for other notes as well, there is an easy way to do this:

1. Set up the first note as desired. This includes the Note Info settings, but also any note-related symbols (such as accents, staccato, articulation, etc. - see page 171).

2. In the score, select the note and select “Copy” from the Edit menu.

3. Select the notes to which you want to copy the attributes.

4. Pull down the Scores menu and select “Paste Note Attributes” from the Staff Functions submenu. The selected notes will now get the attributes of the first, copied note, but their pitches and note values will remain unchanged.
Handling beaming

Turning Beaming on/off

Beaming is turned on/off independently for each staff.

1. Open the Staff Settings dialog.
   See page 44 and page 91 for details.

2. Click the Options tab.

3. To turn off beaming, activate No Beams and click Apply.
   Even if beaming is turned off for the staff, you can put some notes under beams, as described below.

Grouping

When beaming is on, the program automatically groups notes under beams. However, there are a number of ways to determine how notes are grouped.

Using the time signature dialog

The time signature for the piece naturally affects grouping. But you can control this yourself by creating a composite time signature used only for grouping:

1. Open the time signature dialog.

2. Set up the Numerator with the grouping you desire.
   If you for example want eighth notes in two groups of three and one group of two, enter 3+3+2.

3. Set the Denominator, if needed.
4. Activate “For Grouping Only”.

![Edit Time Signature]

The time signature dialog with “For Grouping Only” activated.

5. Click OK.

- Please note that the “For Grouping Only” only refers to how the numerator is divided. Any changes you make to the “sum” of the Numerator number or the denominator will result in a change of actual time signature in the piece. If you need a grouping which can’t be entered in the current time signature, you will have to group notes manually, see below.

Grouping a number of notes

If the grouping the program assigns isn’t the one you want, you can put any selection of eighth notes or smaller under a beam:

1. Select at least two notes, where you want the beam to begin and end. You can also select notes in between these two if you wish, it doesn’t matter.

2. Group the notes, either by selecting “Group Notes” on the Scores-Staff Functions menu or by clicking the Group icon on the extended toolbar.

![The Group icon]

Before and after Grouping.
Group Options

You can choose individually for each group whether you want it to be shown with regular beaming or as “Repeats”:

1. Display the display filter bar in the Score window (by clicking the “F” button on the toolbar) and make sure the “Grouping” checkbox is activated.
   Now, you will see the text “Grouping” below all created groups.

2. Double click on the “Grouping” text for the Group you want to make settings for.
   A dialog box appears.

3. Use the two radio buttons to the left to select whether you want regular beaming (“None”) or Repeats.

   ![Diagram](image)

   In this example, the “Repeat” feature is used to display two pairs of sixteenth notes, as two eighth notes with “repeat bars”. Note that the second and fourth sixteenth note have been hidden - the playback is not affected!

4. If you selected “Repeat”, use the radio buttons to the right to select the note value for the repeats.

5. Click OK to close the dialog.
Grouping quarter notes (or larger)

It is possible to use the grouping feature for notes that are not displayed with beams (quarter notes, half notes, etc.). The result is “spectacle bass” symbols, commonly used for indicating tremolo, etc.

- Double clicking on the “Grouping” text opens the Grouping dialog, allowing you to adjust the “note value” for the symbols.

Removing groups

If you have made a grouping as described above, and wish to remove this, proceed as follows:

1. Display the display filter bar in the Score window (by clicking the “F” button on the toolbar) and make sure the “Grouping” checkbox is activated.
   
   Now, you will see the text “Grouping” below all created groups.

2. Select a group by clicking on its “Grouping” text.

3. Press [Backspace] or [Delete].
   
   The grouping is removed.

- If you need to remove all groups from the score, hold down [Shift] and double click on the first “Grouping” text.
  
  This selects all “Grouping” symbols, so you can delete them all at once by pressing [Backspace] or [Delete].
Removing a note from a group

There is no special “Ungroup” command, simply because it isn’t needed. A group can consist of one note if you wish. In other words...

- To remove one note at the end of a group, select it and proceed with grouping as above.
- If you select notes in the middle of a beam and then group, three groups are created.

![Before and after grouping.](image)

Automatic Grouping

The program can also go through the selected notes and automatically create grouping for you, where it’s deemed suitable. Proceed as follows:

1. Select the notes you want checked for auto-grouping.
   Typically, you could select all notes on the track by using the Select All command on the Edit menu.

2. Pull down the Scores menu and select Auto Group Notes from the Staff Functions submenu.
   In 4/4 you will for example get two groups of eighth notes per bar, in 3/4 you will get one group per bar, etc.

![Before and after using Auto Grouping in 4/4.](image)
Cross staff beaming

To create a beam that extends from one staff to another, proceed as follows:

1. Set up a Split or Polyphonic Voicing system or open the Score editor with more than one track.

2. Set up a beam of notes (using the group command) and adjust the pitches of them so that they are correct even though some of the notes are on the wrong staff.
   You want to use the Info Line to edit the pitches if they are very low or high.

3. Select the note(s) that should appear on the other staff.

4. Select “Move To Staff” from the Scores menu. Select a staff from the submenu that appears.

   ![Menu Screenshot]

   The notes are “graphically” moved to the selected system, but keep their actual pitch.

   ![Before and after moving a note]

   Before and after moving a note to the lower staff.
5. If needed, adjust the beam appearance (see page 144).

Cross staff beaming with the beam in the middle.

The Move To Staff operation does not actually move the note to another track. It only makes it “look” like the note belonged to the other staff.

Handling beam groups

There are two settings for groups under a beam, “Beam subgroups” and “16th Subgroups”, both found under the Options tab in the Staff Settings dialog. If Beam Subgroups is activated, the program displays subgroups after four sixteenth notes under a beam. If you also activate 16th Subgroups, subgroups appear after only two sixteenths.

Beam Subgroups Off, On and On with 16th Subgroups activated.
Beam appearance and Slant settings

Global Settings

The Notation Style dialog on the Scores-Global Settings menu has a tab called Beams and Bars. There you will find three options for how Beams should appear:

• Thick Beams. Activate this if you want beams to be displayed as thick lines.

• Show Small Slants as Flat Beams. When this is activated, beams that would be only slightly slanted will be displayed flat.

Without and with "Show Small Slants as Flat Beams".

• Slanted Beams only Slightly Slanted. Activate this if you only want a slightly slanted beam even though there might be a significant pitch difference between the notes under the beam.

Without and with "Slanted Beams only Slightly Slanted".

Please note that these settings apply equally to all staves.
Staff Settings

On the Options tab of the Staff Settings dialog, you will find a couple of settings for beams as well.

<table>
<thead>
<tr>
<th>Activate this:</th>
<th>When:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flat Beams</td>
<td>When you don’t want any slant at all, no matter the pitch difference of the notes under the beams.</td>
</tr>
<tr>
<td>No Beams</td>
<td>When you don’t want any beams at all.</td>
</tr>
</tbody>
</table>

Manual adjustment of beams

For very detailed control you can manually adjust the beam slant:

1. Group and flip notes and adjust the settings described above until the beams are as close as possible to how you want them.

2. Click on the corner made up by the beam and the stem. Handles appear.

3. Drag the handle up or down.

Mixed staff Direction

By dragging the beam handles you can put the beam between the note heads:

Putting the beam between the notes.
About tied notes

Sometimes, notes will be displayed as two or more notes tied together. Generally, there are three different occasions when this will happen:

- When a note is of an “uneven” length, that cannot be displayed without tying together two or more notes of different note values.
- When a note crosses a bar line.
- When a note crosses a “group line” within a bar.

The last case requires some explanation: Cubase SX uses a “cutting mechanism” that automatically creates tied notes depending on the length and position of the notes. For example, a quarter note is cut in two and tied if it crosses a half note beat, and an eighth note is cut in two and tied if it crosses a quarter note beat:

![This quarter note is cut. This eighth note is cut.](image)

However, this isn’t always what you want. There are three ways to affect the cutting mechanism:

Syncopation

When the Syncopation option in the Staff Settings dialog is activated, Cubase SX will be less prone to cut and tie notes. For example, the second quarter note in the figure above would not have been cut if Syncopation had been activated.

The Syncopation setting in the Staff Settings dialog affects the whole track, but you can also make Syncopation settings for separate sections in the score, by inserting Display Quantize events (see page 56).
Time signature changes

By inserting time signature changes, you can change the way notes are cut. This is done in the same way as when you specify how beamed notes should be grouped - see page 136.

With a regular 4/4 time signature.

With a composite time signature (3+2+3 eighth notes).

The Cut Notes tool

By using the Cut Notes tool, you can disable the automatic cutting mechanism in a bar, and insert manual cuts at any given position in the score:

1. Select the Cut Notes tool.

2. Set the Quantize pop-up menu to an appropriate value.
   As usual, this determines where you will be able to click.
3. Click in the bar containing the note(s) you want to cut manually, at the position you want them cut. This inserts a Cutflag event in the bar at the position you clicked. If you hold down [Alt]/[Option], a Cutflag event is inserted for all voices in a polyphonic staff.

A half note, placed at 2.1.3.0. This is by default cut at 2.3.1.0 (the middle of the bar). When you click at the position 2.2.1.0, a Cutflag event is inserted...

As a result, the regular cutting mechanism is disabled and the note is cut at the position you clicked instead.

The following rules apply to Cutflag events:

- If a bar contains a Cutflag event, the automatic cutting mechanism is disabled within that bar.
- All notes or rests that start before and end after a Cutflag event, will be cut at the position of the event.
- To display Cutflag events, make sure that “Cutflag” is activated on the filter bar.
- To remove a Cutflag event, either click again with the Cut Notes tool at the same position, or select it and press [Backspace] or [Delete].

Other options for tied notes

Tie direction

As described on page 134, you can set the direction of the tie manually in the Note Info dialog.

Flat ties

If you prefer ties to be displayed as flat lines, rather than regular “curved” ties, activate the option “Flat Ties” on the Options page in the Notation Style dialog on the Scores-Global Settings menu.
Graphic moving of notes

There might be instances where the “graphical” order of the notes isn’t the one you want. In this case you can move the note without affecting the score or playback in any way. There are two ways to do this:

**By using the Graphic Move tool**

1. Select the Graphic Move tool.

2. Click on the note and drag it right or left.
   Movement is restricted to horizontally only.

Before and after changing the “graphical order” of notes.
By using the computer keyboard

You can assign key commands for moving objects graphically. In the Key Commands dialog on the File menu, the commands are found under the Nudge category and called Graphical Left, Right, Bottom and Top (although only the Graphical Left and Right commands apply to notes).

After assigning key commands, you select the note(s) you want to move and press the assigned keys to adjust their graphical position.
Cue Notes

You can create cue notes by using voices or by converting individual notes into cue notes.

Setting a voice to display cue notes

1. Open the Staff Settings dialog and select the Polyphonic tab. This is described on page 105.
2. Click in the “Cue” column for the voice, so that a tick mark appears.
3. Decide for a rest handling for the voice. You might for example leave the “Rests–Show” activated and activate “Reduce”. If you do, you will get rests in this voice, but not as many as otherwise. Empty bars, for example, will not have any rests at all.
4. Close the dialog.
5. Move the notes into the cue voice. Polyphonic Voicing is described in detail on page 101.

An example of a Cue note Voice.
A quick example

Let’s say you have a flute part and want some cue notes for it.

1. Switch on polyphonic voices and activate voice 1 and 2.
2. Set voice 2 to “Auto” stem direction and centered rests.
3. Set up voice 1 to be a cue voice, with hidden rests and stems pointing up.
4. Insert the cue notes into voice 1.

Turning individual notes into cue notes

1. Select one or several notes.
2. Double click one of the notes or click the “i” icon on the extended tool-
bar.
   The Note Info dialog appears.
3. Select Cue from the Type pop-up.

   ![Note Info dialog](image)
   Note type set to Cue.

4. Click Apply.
   The settings are applied to the selected note(s).
5. If you like, select other notes and make settings for them.
   When you are done, close the dialog by clicking its close box.
Grace notes

You can turn any note into a grace note. Grace notes are considered to be notes without lengths. This means that once a note is turned into a grace note it doesn’t affect the rest of the score display in any way.

Before and after converting to grace notes. Note that after the conversion, the grace notes no longer “interfere” with the interpretation of the other notes.

Grace notes are always automatically positioned just before the next note on the staff. If there is no note after a grace note on the staff, the grace note will be hidden!

Creating grace notes manually

1. Locate the note for which you want a grace note.

2. Insert one or more new notes just before it.
   The note value and exact position of the note isn’t important. However, the pitch of course is.

   From here on there are two ways to go:

   • Select the note(s) and click the “i” icon on the extended toolbar.
     The Note Info dialog appears and you can select the Grace note type and make other settings if needed.

   • Select the note(s) and then select “Grace Note” from the Staff Functions submenu on the Scores menu.
     This turns the note into a grace note without opening any dialog.
Grace notes and beaming

- If two grace notes are at exactly the same position (the same tick), they will be put onto the same stem, as a chord.
- If multiple grace notes in front of the same note are put on different positions (even if they are only on tick apart), they will be grouped under a beam.
- Please note that it is possible to have beamed grace notes overlapping a beam of regular notes, as in the example below:

Grace notes in the middle of a group of regular notes.

Editing a Grace Note

1. Select one or several grace notes and open the Note Info dialog.

2. Select a note value for the stem.

3. Activate crossed, if you wish.
   When this is activated, the stem will be crossed by a slanted line, to further indicate that the note is a grace note.

4. Click Apply.
   The settings are applied to the selected note(s).

5. If you like, select other notes and make settings for them.
   When you are done, close the dialog by clicking its close box.
Converting grace notes to normal notes

1. Select the notes you want to convert.
   If you want to make sure that all notes in the score are normal notes, you can select all
   notes (using the Select All command on the Edit menu).

2. Double click on one of the selected grace notes.
   The Note Info dialog appears.

3. Select “Normal” from the “Type” pop-up.

4. Click Apply.
Tuplets

The regular Display Quantize values do not apply to any other divisions than triplets. To create quintuplets, septuplets etc., follow the instructions below.

There are basically two methods of creating tuplets:

- With permanent alteration to the MIDI data. This is the "drawing" mode to use when you want to build the tuplet from scratch. It doesn't put any demand on the notes' positions before the tuplet is created.
- As Display Quantize. This is the method you use when the tuplet is recorded and plays back as you want it, but it is not displayed correctly.

Actually, in the first case, you make permanent alterations and set Display Quantize settings, all in one go. In the second case you only make Display Quantize settings.

With permanent change to MIDI Data

1. Insert as many notes as the tuplet consists of.

   This would typically be 5, 7 or 9. If the tuplet contains rests, simply leave space for those, but make sure the current Display Quantize value allows them to be shown.

   ![Five sixteenth notes, about to be converted to a quintuplet.](image)

2. Select all the notes that make up the tuplet.

3. Select "Build N-Tuplet" from the Staff Functions submenu on the Scores menu.

   The Tuplets dialog appears.
4. Set the type of tuplet in the Type field.
   "5" means a quintuplet, "7" means a septuplet etc.

5. Set the length of the entire tuplet using the “Over” field.

6. Activate Change Length, if you need it.
   If you do, the program will alter the length of all notes so that they are exactly the note value the tuplet indicates. If you don’t, the lengths of the existing notes won’t be affected in any way.

7. If you want any other text than the standard above the tuplet, type it in the “Text” field.
   The standard text is simply the number in the type field. If the tuplet is put under a beam (see page 157) the “Text” is put just above it. If there is no beam, the “Text” is found in the middle of a bracket.

8. Click Build.
   The tuplet appears. The notes have now been moved to the tuplet positions and their length might have changed.

9. If needed, edit the lengths and pitches of the notes in the tuplet.
   You can also make various settings for the appearance of the tuplet - see below.

Without permanent change to MIDI data

1. Select the notes in the tuplet group.
   In this case, the notes play back correctly but aren’t displayed as a tuplet (yet).

2. Select “Build N-Tuplet” from the Staff Functions submenu on the Scores menu to bring up the Tuplets dialog.

3. Make settings in the dialog, as described above.

4. Click Quantize.
   Now the tuplet is displayed correctly. You can make additional settings for how the tuplet should appear, as described below:

5. If needed, adjust the notes.

☐ Lengths and positions in a tuplet group are probably best edited using the Info Line.
**Editing tuplet settings**

1. Double click on the Text above the Tuplet group to bring up the Tuplets dialog

![Double Click here.]

2. Adjust the Text setting.
3. Click Apply.
   The changes are applied to the tuplet, without affecting the tuplet type or length.

**Grouping**

If the Tuplet is a quarter note long or shorter, the notes will be automatically grouped under a beam. If it is longer you have to perform the grouping manually. See page 136 for details.

**Tuplet display options**

The Switches tab in the Notation Style dialog on the Scores-Global Settings menu contains the following settings for tuplets:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Tuplets without Brackets and Always Show Tuplet Brackets</td>
<td>These two options are mutually exclusive - turn one on and the other is turned off. When Display Tuplets without Brackets is activated, tuplets never have brackets. When the other option is active, tuplets always have brackets. When neither option is activated, tuplets may have brackets, depending on the position of the beam (above or under the note heads).</td>
</tr>
<tr>
<td>Display Tuplet values by the Beams</td>
<td>When this is activated, Tuplets will be displayed on the &quot;beam side&quot; of the notes instead of on the note head side.</td>
</tr>
<tr>
<td>Suppress Recurring Tuplets</td>
<td>When this is activated, and you have several Tuplets of the same type in the same bar, only the first of these are displayed as a Tuplet.</td>
</tr>
<tr>
<td>Show Tuplet Brackets as &quot;Slurs&quot;</td>
<td>When this is activated, the Tuplet brackets will be &quot;slur-like&quot; (rounded).</td>
</tr>
</tbody>
</table>
8

Working with symbols
In this chapter you will learn:

- What the different types of symbols are.
- How to insert and edit symbols.
- Details about special symbols.

Background: The Layout and Global layers

A score page is always made up of three layers – the Note Layer, the Layout Layer and the Global Layer. When you add symbols, these will be inserted into one of these layers, depending on the type of symbol. Those symbols that have a general relation to notes – accents, dynamic markings, slurs, lyrics etc. – will be put in the Note Layer. Other symbols – such as repeats, rehearsal marks, some types of text, etc. – can typically be put either in the Layout Layer (which is individual for each layout) or in the Global Layer (common for all layouts). Later in this chapter you will find detailed information about which symbols belong to which layer.

Layout Layer symbols

<table>
<thead>
<tr>
<th>1.</th>
<th>2.</th>
</tr>
</thead>
</table>

Note Layer symbols

mf

We will now look at the symbols in these three layers, in more detail:
Note Layer symbols

Let’s look at the Note Layer symbols first. These come in three flavors:

- Note symbols. These are each tied to a single note. Examples of note symbols are accents and lyrics. When you move the note, the symbols moves with it. The same is true if you cut the note and then paste; the symbol is cut and pasted at the same time.
- Note dependant symbols. Only a few symbols belong to this category, for example the arpeggio lines. In one way, these behave just like grace notes (see page 152). They must always be in front of a note or chord. If there is no note “after them” on a staff, they will disappear.
- All other Note Layer symbols (tempo, dynamics, chords etc.). These have their position related to the bar. No matter what you do to notes, they remain unaffected. However, their positions are tied to their position within a measure. If you for example change the spacing of the bars across the page (see page 256) this will affect the symbols’ positions.

Layout Layer symbols

Now let’s examine the Layout Layer symbols. As described above, there is a certain collection of symbols, which are drawn in a different “layer” on the page than all other graphic elements. These are called Layout Layer symbols. All these symbols are collected in the Layout symbol palette, see below.

How the Layout Layer is stored

It is very important to understand how the Layout layer is handled to avoid some otherwise potential confusion.

The Layout layer is not stored individually for each track, as the other symbols are. Instead it is common to a “set of tracks”. Let’s illustrate this with an example:

You have four tracks that make up a string quartet. You edit them all at the same time and add symbols to the score, both Note Layer symbols and Layout Layer symbols.
Now let's say you close the Score editor and open only one of the tracks for editing. All your Note Layer symbols are there just as you left them, but the Layout Layer symbols have disappeared!

Don't worry, close the editor again, and open all four tracks for editing and the symbols are back.

You have probably got a clue to what is going on by now. The Layout Layer symbols are part of a “bigger entity” called – the Layout. And a Layout is something that is stored not per track, but for a group of tracks. Each time you open the same combination of tracks for editing, you get the same layout.

There are also other things that are part of the layout – apart from the symbols in the Layout Layer. You will find more info about this in “Working with Layouts”.

Global Layer symbols

The Global Layer symbols are layout symbols that are present in all layouts. The Global Layer holds the symbols found in the Global symbol palette, but also barline types and bar number offsets.

Why three Layers?

There are several reasons for this division into layers:

• Many of the symbols that are in the Layout Layer can be stretched to span over several staves, or for other reasons make more sense to think of as belonging to a certain group of tracks.
• The Layout Layer is only one part of the bigger concept of Layouts. Layouts allows you to easily extract parts from a full score and perform automatic formatting. This is all described in “Working with Layouts”.
• Typically, you want to display some symbols - repeat bar lines, endings, score titles etc - for all layouts in a score. To make this easier, they can belong to the Global Layer.

On page 165 and onwards you will find out which symbols are part of which layer.
The symbol palettes

Displaying Palettes

From the main menus
1. Select Symbol Palettes from the Scores menu.
2. From the submenu that appears, select any of the symbol palettes.
3. If you want one more Palette, of some other type, select it as with the first one.

You can have more than one symbol palette on the screen at a time.
Directly from the palette

1. Right click in a palette. A pop-up menu appears.

2. If you want the new palette to replace the current one, simply select the desired palette from the list. The window will now show the selected palette.

3. If you want to display the new palette without closing the current one, hold down [Ctrl]/[Command] and select a palette from the list. A new window opens with the selected palette. The first palette window remains open.

Moving and Handling Palettes

Palettes are handled as any window, which means that you can:

- Move a palette around by dragging its title bar.
- Close a palette by clicking its close box.

In addition, you can select whether the palette should be shown horizontally or vertically, by right-clicking ([Ctrl]-clicking under MacOS if you're using a mouse with only one button, or haven't configured the mouse for right-clicking) and selecting “Toggle” from the context menu that appears.
The available symbols

The illustrations below show all the symbols available, divided by group (see above). The captions contain additional information about the symbols in the Group.

Clef change 🎼 Clef.etc 🎼 Time signature change

Key change (and/or Display Transpose change)

The “Clef etc.” Palette.

Dynamics

Crescendo
“Double” Crescendo/Diminuendo
Slur Down
Slur Up
Tie Down
Tie Up

The “Dynamics” Palette.
The “Note Symbols” Palette. These symbols are always tied to a note.

The “Lines and Trills Palette. Please note that the Arpeggios, Hand Indications and Strum symbols are all "note dependant"!
The "Graphic" Palette. This contains note heads, accidentals and rests that can be “drawn in” without affecting the score in any way. They do not affect MIDI playback!

The “Other” Palette.

The “Layout” Palette. All these symbols are drawn in their own “layer”.

Working with symbols
The “Global” Palette. These symbols will be present in all layouts.

The “Words” Palette. This is described on page 229.

Further details about many of the symbols can be found on page 199.

Creating a Custom Palette

On the Symbol Palette menu, you will find a palette called Custom. Cubase SX allows you to fill this palette with any selection of symbols from other palettes. In this way, you can have instant access to the symbols you use often:

1. Open the Custom palette.
   If it’s the first time you are using this, it will be empty.

2. Open another palette from which you want to copy a symbol.

3. Hold down [Alt]/[Option] and click on the symbol you want to add to the Custom palette.
   The symbol appears on the Custom palette.

4. Repeat this with other symbols.
   • To remove a symbol from the Custom palette, hold down [Alt]/[Option] and click on it.
Important! – Symbols, staves and Voices

Most symbols belong to a staff when inserted. Only note symbols, slurs and ties are an exception. They belong to notes and therefore to voices.

It is extremely important that the correct staff is active when you insert a symbol (if you are editing multiple staves, of course).

If you for example insert a symbol with the wrong staff active, the symbol might later appear to have disappeared, simply because you edit another configuration of tracks (the track you actually inserted the symbol to might not have been opened for editing).

The same is true for note symbols and their relation to voices. Make sure the correct voice is active when inserting symbols or they might wind up at the wrong position, fermats may be turned upside down etc.

Layout symbols work slightly differently. Instead of belonging to a certain staff or voice, they belong to a layout. Since different track combinations use different layouts, this means that if you insert a layout symbol in the score when you are editing two tracks (for example a trumpet and a saxophone part), it will not be there when you view each track by itself in Score edit. If you want the same symbols to appear in other layouts as well, you can copy the form of one layout to another. If you want a symbol to appear in all layouts, you can use the Global symbols.
Adding symbols to the score

Making space and handling margins

- If you find there isn’t enough space between staves to add symbols (like for example text) please see page 260 for info on how to separate the staves.
- If you find the score looks crammed after adding symbols, check out Automatic Layout on page 264.

☐ Symbols you add outside the margins will not be printed!

About the Pencil tool

Unlike the other MIDI editors, there is no Pencil tool among the tools on the Score editor toolbar. Instead, the Pencil tool is “automatically” selected when you insert symbols. There are various rules for how this is done:

- Normally, the Pencil tool is automatically selected when you click on a symbol in a Palette.

- However, if the option “Double Click Symbol to get Pencil tool” is activated in the Preferences–Scores dialog, you need to double click the symbol to get the Pencil tool. This is useful if you want to insert symbols using the Staff Functions menu as described below (and therefore don’t want the Pencil tool to appear every time you select a symbol).

- In the same Preferences dialog, you will find an option called “Display Arrow tool after Inserting Symbol”. When this is activated, the Arrow tool is automatically selected after you have inserted a symbol. If you want to insert a lot of symbols with the Pencil tool, you may want to deactivate this option.
Adding note symbols

Adding a symbol to one note

1. Make sure the Note symbol palette is visible.

2. Click (or double click) on the desired symbol in the Palette.
   As mentioned above, the “Double Click Symbol to get Pencil tool” preference determines whether you need to double click. In any case, the Pencil tool is automatically selected.

3. Either click on the note or above or below it.
   If you click on the note, the symbol is put in at a predefined distance from the note. If you instead click “above or below” the note, you decide for a vertical position yourself. In either case, the symbol is aligned horizontally with the note. It can later be moved up/down.

   ![Diagram of note symbols](image)

   Clicking on a note inserts the Note symbol (in this case a tenuto) at a predefined distance from the note head.

   There are two options in the Notation Style dialog (Switches tab) on the Scores-Global Settings menu that affect the vertical positioning of note symbols:

   • Accents above Stems.
     When this is activated, accent note symbols are displayed at the stem side of notes instead of the note head.

   • Accents above Staves.
     When this is activated, accent note symbols are displayed above the staff, regardless of the stem direction of the notes. This setting overrides the “Accents above Stems” option.
Adding a symbol to several notes using the Pencil

You might for example want to add a staccato symbol to all notes within a few measures. Proceed as follows:

1. Make sure the Note symbol palette is visible.
2. Select the notes to which you want to apply the symbol.
3. Click (or double click) on the desired symbol in the Palette.
4. Hold down [Alt]/[Option] and click on one of the notes.
   The symbol is added to each selected note, at a predefined distance. The symbols can be moved later.

![Symbol added to notes](image)

Adding a symbol to several notes using the Multi Insert function

1. Select the notes to which you want to apply the symbol.
2. Select the desired symbol from the Palette.
3. Pull down the Scores menu and select “Multi Insert” from the Staff Functions submenu.
   The symbol is added to the selected notes at a predefined distance from the note heads. The symbols can be moved later.

Adding a symbol without tying it to a note

Note dependant symbols can be entered freely too. This for example allows you to add a fermat to a rest symbol.

1. Make sure the correct staff is active.
2. Click or double click the symbol so that the Pencil tool is selected, as described above.
3. Hold down [Ctrl]/[Command] and click where you want to add the symbol
Adding other symbols

1. Make sure the desired symbol palette is visible.

2. Click (or double click) on the desired symbol in the Palette.
   As mentioned above, the “Double Click Symbol to get Pencil tool” preference determines whether you need to double click. In any case, the Pencil tool is automatically selected.

3. Click once or click and drag somewhere in the score.
   The symbol appears. For many symbols with a length, you can drag while holding the mouse button down, to set the length of the symbol directly. The symbol appears with its handles selected (if it uses handles) so that you can change its size directly if you wish. This is all described in detail on page 195.

Press the mouse button – drag – and release!

About note dependant symbols

Note dependant symbols like arpeggios and strum directions must be put in front of a note or they will be “invisible”.

Adding Text

There are special methods for working with text, described in their own chapter, “Working with Text”.

---

CUBASE SX
Working with symbols
8 – 173
Adding Slurs and Ties

Slurs can be drawn manually or inserted automatically for a group of notes. Ties are normally added by the program but can also be drawn in as "graphic" symbols.

Slurs, Ties and the Quantize Value

Since a slur or tie "musically" always spans from one note (or chord) to another, the beginning and end of a slur/tie in Cubase SX is always related to two notes in the score.

When you draw in a tie or slur, the program uses the Quantize value to find the closest two notes to “attach” the symbol to. In other words, if you want to add the slur/tie to a note at a sixteenth note position, make sure Quantize is set to 1/16th notes or smaller (this is only true for manual drawing of slurs and ties).

Please note that this does not mean that the symbol has to start or end exactly above/below two notes. You can position the end points as you like. Instead, what it means is that when you use the Graphic Move tool to move the note graphically to adjust the look of the bar, the slur/tie moves with it (see page 148). The same is true if you adjust the width of the measure, the slur/tie is adjusted accordingly.

Drawing the Slur/Tie

1. Check the two notes that the slur/tie should span and set the Quantize value accordingly.
   For example, if one of them is at a quarter note position and the other at an eighth note position, set Quantize to 1/8 note or a smaller note value.

2. Click or double click on the correct slur/tie in the symbol palette, so that the Pencil is selected.

3. Position the mouse close to the first note and drag to a position close to the second note.
   The end points of the slur/tie will snap to their default positions - holding down [Ctrl]/[Command] allows you to move the end points freely.

   There are two special functions for inserting a slur or tie that automatically spans from one note to another.
Adding a Slur/Tie between two notes

1. Select two notes.

2. Click or double click the correct slur/tie symbol from the Palette, so that the Pencil tool is selected.

3. Hold down [Ctrl]/[Command] and [Shift] and click on one of the two notes.

Inserting a Slur/Tie over a Selection of Notes

1. Select a span of notes.

2. To insert a slur, pull down the Scores menu and select “Insert Slur” from the Staff Functions submenu.
   A slur is created, starting at the first selected note and ending at the last.

3. To insert a tie, select the tie symbol and select “Multi Insert” from the Scores-Staff Functions submenu.
   This method can of course also be used to add slurs, but if you use the “Insert Slur” function, you don’t need to have the Symbols Palette visible. You can even create a key command for the “Insert Slur” function, for instant access.
Creating Trills

If you have recorded or entered a trill, Cubase SX can help you display this properly:

1. Select the notes that make up the trill.

2. Pull down the Scores menu and select Build Trill from the Staff Functions submenu.
   A dialog appears.

3. Select the options you want.
   The radio buttons determine how the trill should look. Activate the “Help Note” option if you want an extra note to indicate between which notes the player should trill.

4. Click OK.
   Now the following happens:

   • All notes except the first one (and possibly the second) are hidden.
   • The first note automatically gets a Display Length matching the length of the whole trill.
   • If you chose to include a help note, the second note is converted to a “Graphic” note, with brackets but without stem. Otherwise, the second note is hidden as well.
   • The trill symbols you indicated in the dialog are inserted.

Inserting symbols across staves

If you hold down [Alt]/[Option] while adding a symbol to one staff in a grand staff, this symbol will be put in at corresponding positions on all staves. This allows you to for example insert rehearsal marks, repeats, etc. for all instruments at the same time.
Adding a Keyboard symbol

The Other Palette contains a piano keyboard symbol, useful for example in educational scores. The symbol has the following properties:

- To insert the keyboard symbol, select it from the Palette, click with the Pencil tool at the desired position and drag a box to specify the approximate size of the keyboard.

- After you have inserted the keyboard symbol, you can drag its edges to resize it vertically or horizontally.

![Keyboard symbol](image)
• If you double click on an inserted keyboard symbol, a dialog appears, allowing you to specify further properties of the symbol.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Governs the width of the keys.</td>
</tr>
<tr>
<td>Start Note</td>
<td>This is the leftmost note in the keyboard symbol.</td>
</tr>
<tr>
<td>Show Note Names</td>
<td>When this is activated, each C key is displayed with note name and octave (C1, C2, etc.).</td>
</tr>
<tr>
<td>White/Black Keys</td>
<td>Activate these if you want the white and/or black keys to be transparent</td>
</tr>
<tr>
<td>Transparent</td>
<td></td>
</tr>
</tbody>
</table>
Adding Guitar Chord symbols

A fretboard symbol of a guitar chord can be inserted anywhere in the score. These guitar symbols are found in the “Other” symbol palette:

1. Make sure the “Other” Palette is visible.
2. Click or double click on the Guitar Chord symbol, so that the Pencil tool is selected.
3. Click in the score, at the position you want the symbol. The Guitar Symbol dialog appears.
• To put a black dot on any fret and string, click on it.
  To remove it, click again.

• To input a symbol just above the string, outside the fretboard, click there.
  Consecutive clicks allow you to select between a ring (open string), a cross (don’t play this string) and no symbol.

• To add a Capodaster number, click to the left of the symbol.
  Consecutive clicks allows you to step through the possibilities.

• You can also add a Capodaster symbol (a line over the strings), by setting the “Capo String” parameter to a value higher than 0.
  By adjusting the Capo End and Start values, you can create Capodaster symbols that span fewer strings.

• If you want a bigger symbol than the default one, activate the “Large” checkbox.

• If you want the symbol to be horizontal, activate the “Horizontal” checkbox.

• If you want to display more or fewer frets than the default six, change the “Frets” value.

• If you have defined guitar chord symbols in the Guitar Library (see below), these are available for selection on the “Library” pop-up menu.

4. Click Apply.
   The guitar symbol appears in the score.

• Clicking the Insert Notes button will insert the actual notes in the chord into the score.

   You can edit the symbol at any time by selecting it, changing the settings in the dialog and clicking Apply. If the dialog is closed, open it by double clicking the guitar symbol. Note also that you can access the symbols you have defined in the Guitar Library by right-clicking ([Ctrl]-clicking) a guitar symbol - see below.
Using the Guitar Library

The above method is fine if you only want to add a few chord symbols to your score. If you need a lot of chord symbols, or if you are using chord symbols in a lot of different scores, you can gather all your chord symbols in a “Guitar Library” instead. This way you don’t need to recreate the same chord symbol over and over again.

Defining chord symbols

1. Pull down the Scores menu and select Guitar Library from the Global Settings submenu. The Guitar Library dialog appears.

   ![Guitar Library Dialog]

   2. To add a guitar chord symbol to the library, click the New button. A chord symbol appears in the list to the left.

   3. To edit the chord symbol, double click it in the list. This opens the Guitar Symbol dialog, as when editing a chord symbol in the score.

      • The symbol you create will also be “interpreted” and displayed as a written chord to the right of the fretboard symbol. This can also be edited by double clicking if you like.
To remove a symbol from the library, select it in the list and click Remove.

To save the current library as a separate file, click the Save button. A file dialog appears, allowing you to specify a name and location for the file.

To load a guitar library file, click the Load button. In the file dialog that appears, locate and open the desired Guitar Lib file.

Loading a Guitar Lib file replaces the current library!

There are also two additional checkboxes in the Guitar Lib dialog:

<table>
<thead>
<tr>
<th>Checkbox</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inserting symbols from the library</td>
<td></td>
</tr>
</tbody>
</table>

Apart from the “Use for Make Chords” option above, there are two ways to insert symbols from the Guitar Library into the score:

- Use the Library pop-up menu in the Guitar Symbol dialog when creating or editing guitar symbols.
- Right-click on a guitar symbol in the score and select a chord symbol from the pop-up menu that appears.
Using Layout symbols

Symbols inserted from the “Layout” palette belong to the Layout layer. When you are editing a layout containing several tracks, you can have inserted Layout symbols automatically copied to any combination of tracks in the layout. You decide which tracks should display Layout symbols by ticking their “L” column in the Layout Settings dialog (opened by selecting “Setup” from the Layout Settings submenu on the Scores menu).

Here, Layout symbols will be displayed for the tracks “Strings” and “String 3”.

- Any editing you perform to Layout symbols is automatically duplicated in the other tracks.
- You can turn on and off the display of Layout symbols for different tracks at any time.
- Layout symbols can be copied between layouts, by using the Get Form function in the Layout List window.

One example of how to use Layout symbols:

Let’s say you are editing a full orchestra score, and want Rehearsal Marks inserted for more than one staff (typically, above each instrument group - brass, strings, percussion, etc.). Now all you need to do is insert the Rehearsal Marks from the Layout symbols palette for one of the tracks, open the Layout Settings dialog and tick the “L” column for the desired tracks. When you close the Layout Settings dialog, the inserted Rehearsal Marks are automatically duplicated to the specified tracks.
Using Global Symbols

Symbols inserted from the “Global” palette are part of the Global layer and will therefore appear in all layouts. The Global layer also continues changes to bar lines (e.g. repeats and double bar lines) and bar number offsets. Typically you use Global symbols when you know you want these shown for all combinations of tracks.
Selecting symbols

Almost all symbols can be selected simply by clicking on them. For symbols that have a length or size, one or more handles appear.

A selected crescendo.

An exception to this are the slurs and ties which can be selected by clicking on the end points or by making up a selection rectangle.
Using the Lock Layers

Sometimes it can be very hard to click on a symbol or other object in the score, without accidentally selecting other symbols near by. To remedy this, you can assign different types of objects to different “Lock Layers” (up to three) and instruct Cubase SX to “lock” one or two of these layers, making them “unmovable”. Furthermore, you can lock the Layout and Global layers separately if needed. Proceed as follows:

Setting up the Lock Layers

1. Open the Preferences dialog from the File menu, and select the Scores-Event Layers page.

2. Assign each event type to a layer (1, 2 or 3).
   It is a good idea to assign event types that might “conflict graphically” to different layers. For example, you might want to assign “Bar Numbers” and “Note Symbols” to different layers, if you find that you accidentally move bar numbers when editing note symbols and vice versa.

3. Click OK to close the dialog.
Alternatively, you can right-click on one of the Layer buttons (1-2-3) in the extended toolbar to bring up a pop-up menu, showing which object types are associated with that layer. A checkmark for an object type means it belongs to that layer. If no checkmark is shown, you can select the object type from the pop-up menu, thereby moving it to that layer.

### Locking a Layer

To “lock” a layer, click on its number in the Lock Layer button, so that it goes “dark”.

If you activate the option “Use Colors for Additional Meanings” in the Preferences-Scores dialog, locked layers will be “greyed out” in the score. This makes it very easy to find out which object belongs to which layer - perhaps especially useful for the Layout and Global layers. For example, to quickly spot all objects in the Layout layer, lock all other layers by clicking their buttons. Now, only Layout layer objects will be shown normally; all other objects will be greyed out.
Moving and Duplicating symbols

There are four general ways to move and duplicate symbols:

- By dragging them with the mouse (see below).
- By using the computer keyboard (moving only - see page 191).
- By using the Copy events function (see page 191).
- By using the Paste Note Attribute function (duplicating note symbols only - see page 193).

Moving and Duplicating by using the Mouse

This is done much as with other objects in Cubase SX. The following rules apply:

- Note symbols and Note Dependant symbols move with the notes/chords they belong to. In other words, if you move the note/chord, the symbols move with it/them.
- Note symbols (like for example accents and lyrics) can only be moved vertically. Some other symbols (like braces and brackets) can only be moved horizontally.
- All other symbols without handles can be moved freely. If you hold down [Ctrl]/[Command], movement is restricted to one direction only.
- If the symbol has one or more handles when it is selected, don’t drag it by the handles, or you will change its shape instead of moving it.
- The slurs and ties are an exception, they can only be moved by first dragging one handle and then the other. However, if you use the Graphic Move tool (see page 148) to move the notes they belong to, or if you change the measure width, they will be adjusted automatically.
- Duplicating is done by moving with [Alt]/[Option] pressed, as always in Cubase SX. Slurs, ties and bar lines cannot be duplicated with this method.

There are two features to help you position symbols (and other score objects) correctly: the rulers and the Position Window.
The rulers

Unlike other editors, Score edit does not have a meter/time position-based ruler. Instead, the rulers are "graphical", that is, they indicate the actual x-y position of objects (with "zero" at the upper left corner).

• The current pointer position is indicated by thin lines in the rulers.
• To hide the rulers, pull down the pop-up menu above the scrollbar to the right and select "Off". This pop-up menu can also be shown by right-clicking in the ruler.
• To display the ruler again, pull down the same pop-up menu and select one of the units (inches, centimeters or points). This setting will also affect the units used in the Position Window (see below).

The Position Window

If you need to fine-tune the graphical positions of symbols and other objects, you should use the Position Window. This makes positioning easier in two ways:

• You get a numerical indication of the exact position of the mouse pointer (and any object you are dragging).
• You can move objects or staves by typing in position values.
You display and hide the Position Window by clicking in the Ruler.

<table>
<thead>
<tr>
<th>Setting / Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure in</td>
<td>Click this label to change units for the Position Window. This choice will also affect the units used in the Rulers.</td>
</tr>
<tr>
<td>Abs/Rel. Pos</td>
<td>Click this label to select whether X-Y position values should be &quot;absolute&quot; (referring to the upper left corner of the current page) or &quot;relative&quot; (referring to the upper left corner of the Active staff).</td>
</tr>
<tr>
<td>X, Y</td>
<td>When a single object is selected, these values show the horizontal and vertical position of this object. When no objects or several objects are selected, these values show the current horizontal and vertical position of the pointer. If a single object is selected, you can click on these values and type in a new position for the object.</td>
</tr>
<tr>
<td>dX, dY</td>
<td>When you are moving an object, these values indicate the horizontal and vertical distance you have moved it. If one or several objects are selected, you can click and type in values - the objects will be moved the specify distances.</td>
</tr>
<tr>
<td>Sel. staff</td>
<td>If “Abs. Pos” is selected (see above), this value shows the distance from the top of the score page to the top of the Active staff. You can click and type in a value to move the Active staff. If “Rel. Pos” is selected, this value will always be 0, since vertical positions are related to the top of the Active staff!</td>
</tr>
<tr>
<td>To Prev staff</td>
<td>The distance between the Active staff and the staff above it. Clicking and typing in a value will move the Active staff.</td>
</tr>
<tr>
<td>To Next staff</td>
<td>The distance between the Active staff and the staff below it. Clicking and typing in a value will move the staves below the Active staff.</td>
</tr>
</tbody>
</table>
Dragging symbols across staves

If you drag a symbol across the staves, you will note how the “Active staff” indicator to the left follows the mouse pointer. Use this as an indication, to make sure that symbols end up in the correct staff.

• If you are editing several tracks at the same time, and want to make sure that a symbol isn’t accidentally moved to another track when you drag it vertically, click on the “L” button on the extended toolbar. When this is activated, you cannot move symbols across tracks by dragging.

Moving by using the Computer Keyboard

You can assign key commands for moving symbols, notes or rests graphically in the Key Commands dialog on the File menu. The commands are found under the “Nudge” category and are called “Graphical Left”, “Graphical Right”, “Graphical Top” and “Graphical Bottom”.

Selecting an object and using one of these commands is the same as dragging them with the Graphic Move tool, but this method offers higher precision.

Moving and Duplicating with the bar handles

This function allows you to move or copy the contents of a whole bar to one or several other bars. You can select which elements in the bar should be included in the operation. Proceed as follows:

1. Bring up the display filter bar by clicking the F button in the toolbar.

2. In the filter bar, make sure the “Bar Handles” option is activated. Now, each bar in the score is shown with a handle in the upper left corner.
3. Double click on the handle of the bar from which you want to copy or move symbols.
The Barcopy dialog appears.

4. Make sure that only those symbol types are checked, that you want to move/copy.

5. If you have several subsequent bars to which you want to copy symbols, set the “Repeats” value to this number of bars.
   If you only want to copy symbols from one bar to another, make sure “Repeats” is set to 1. This option is only available for copying, not for moving.

6. If you want this dialog to appear every time you perform the move/copy operation (see below), activate “Show Dialog”.

7. Click OK to close the dialog.

8. To copy the specified event types to another bar, hold down [Alt]/[Option], click on the bar handle of the first bar and drag it to the “target” bar.
   To move the event types instead of copying them, drag the bar handle without holding down [Alt]/[Option].

   • If you activated “Show Dialog” in step 6 above, the Barcopy dialog appears, allowing you to confirm your settings.
     Click OK to close the dialog and perform the operation.

Now, the following happens:
• If you activated “Note Symbols” in step 4 above, the note symbols are copied from the “source” bar and pasted onto notes at the same positions in the “target” bar. If there is a note symbol for a certain note in the “source” bar, but no note at the corresponding position in the “target” bar, the symbol will simply be removed.

If we move the Note symbols from the first bar to the second bar...

The actual position of notes are used as a basis for this operation - not the displayed position.

• If you activated other types of symbols in step 4 above, these will simply be moved to the same graphical position in the “target” bar.

• If you set “Repeats” to a number larger than 1 in step 5 above, the same symbols will be pasted into that number of bars (starting from the one you drag the bar handle to).

• If you didn’t hold down [Alt]/[Option] when dragging the bar handle, the symbols (and other event types specified in the dialog) are removed from the “source” bar.

If there already are symbols (or other objects) of the specified types in the “target” bars, these will be removed!

Duplicating Note symbols with the Paste Note Attributes function

By using the “Paste Note Attributes” function on the Scores-Staff Functions menu, you can copy the properties of one note (including all note symbols) to any number of other notes. This is described on page 135.
About moving note symbols

Note symbols, slurs and ties all have “Default Positions”. This determines the vertical distance between the note head(s) and the symbol.

- You can manually adjust the vertical positions of individual symbols, but if you move or transpose their notes, the symbols are automatically reset to their Default Positions.
  This also ensures that note symbols and slurs are positioned sensibly when you change the Display Transpose settings.

- To reset the vertical positions of all note symbols and slurs in a score, hold down [Ctrl]/[Command] and click on the Force Update (“UPD”) icon on the extended toolbar.
  All note symbols are reset to their default positions, and all slurs and ties are set to their original lengths and shapes (see below).
Changing length and shape

Generally you can change the shapes of any symbol that has a length. Proceed as follows:

Resizing

1. Select the symbol.
   The Handles appear.

   ![Symbols with two handles when selected]

2. Drag one of the handles.
   You might be restricted to vertically or horizontally only, depending on the type of symbol.

   ❑ In the Preferences–Scores dialog, there is a preference called “Keep Crescendi Symbols Horizontal”. When this is activated, crescendo and diminuendo symbols will never be slanted.

Altering the Shape and Direction of Slurs and Ties

There are two types of slurs and ties in the symbol palette. The up/down variation of each actually represent the same symbol but with different initial direction. You can perform the following editing to slurs and ties:

• By dragging the middle handle up/down you can change the shape of the curve.

   ![Dragging the middle handle of a slur changes its shape]
By selecting a slur or a tie and clicking the “Flip” symbol on the extended toolbar, you can change the direction and positioning of the slur or tie. Actually, there are three “modes” for a slur or tie. You step through these three modes by clicking the button:

- By holding down [Ctrl]/[Command] and dragging the end points of a slur or tie, you can change its shape without affecting its “relation” to the notes it belongs to. In other words, the end point of the slur/tie will then keep its relative distance to that note when the note is moved with the Graphic Move tool or when the measure width is adjusted.

You can restore all shape changes to the default, by [Ctrl]/[Command]-clicking the Force Update (UPD) icon on the extended toolbar. See page 194.

- To change the default shape and spacing of slurs and ties, open the Spacings dialog on the Scores-Global Settings submenu and edit the settings “Slur’s Start & End Distance from Note Head” and “Slur’s Middle Distance from Note Head”. These settings will be used for all new slurs and ties you create, as well as for all existing slurs for which you haven’t manually changed the shape.

**Double clicking symbols**

A number of symbols can be double clicked on. In these cases, a dialog or menu appears where you can input information that either affects the look of the symbol or the MIDI Data it creates. This is described for each type of symbol, in the “Symbol Details” section on page 199.
Deleting symbols

This is done as with all other objects in Cubase SX, either with the Eraser tool or by selecting and pressing [Delete] or [Backspace].

Copy and Paste

All symbols except those in the Layout and Global palettes can be copied and pasted just as any other object in Cubase SX. The following rule applies:

- Symbols that were tied to notes (like for example accents) will become “free-floating” objects when pasted. That is, they are not tied to any note any more. If this is not what you want, consider using the “Copy events” function instead, as described on page 191.
Alignment

Symbols can be aligned as in drawing programs. Proceed as follows:

1. Select all objects you want to align.

2. Select one of the options from the Scores-Align Elements submenu.

Note: Symbols, like staccato and accents can only be aligned horizontally.

The “Dynamics” option is a special function for aligning dynamic symbols, as described on page 201.
Symbol Details

This section contains additional information about some of the symbol palette options.

The “Clef” Palette

Clefs

You can insert a clef symbol anywhere in the score. This will have an effect on the notes, just as the first clef on the staff has. And just as with the first clef, the type is selected from a dialog that appears as soon as you click. More details on page 88 and page 30.

When you double click on an existing clef the same dialog appears allowing you to change the type.

Time signatures

You can insert a time signature symbol at the beginning of any bar. Inserting a new time signature will insert a change into the Tempo track, as described on page 88.

When you click with the Pencil tool, a dialog box appears allowing you to specify the time signature. When you double click on an existing time signature symbol the same dialog appears allowing you to change the type. This dialog is described in detail on page 30.

• You can select a font and size for time signatures in the Text dialog on the Scores-Global Settings submenu (Global Text tab). The default font for this is the included “Steinberg Notation” font.

Key Signatures

Inserting a Key Signature change is functionally similar to inserting a new Clef (see above). Details about Key Signatures in general is found on page 35.

• In the dialog that appears when you insert a key change symbol, you can also insert Display Transpose changes.
The “Dynamics” Palette

Dynamics

There are dynamic symbols ranging from ffff to pppp, plus “special” dynamic symbols such as sforzando, fortepiano, etc.

• By selecting a dynamic symbol and clicking the “+” and “−” buttons on the extended toolbar, you can quickly edit dynamics in the score. You can use this feature to step between ppp, pp, p, mp, mf, f, ff and fff.

• In the Lines and Trills Palette you will find a line symbol which allows you to create the following type of change in dynamics:

\[
\text{ppp} \quad \text{fff}
\]

Crescendo and Diminuendo (Decrescendo)

In the Dynamics palette, there are three kinds of crescendo symbols: regular crescendo, regular diminuendo and a “double” crescendo (diminuendo - crescendo).

• To insert a crescendo ( < ) or diminuendo ( > ), select the corresponding symbol from the Palette and drag from left to right.

\[
\text{Crescendo symbol}
\]

• If you draw a crescendo symbol from right to left, the result will be a diminuendo symbol, and vice versa.

• To insert a crescendo-diminuendo ( <> ) symbol, select the double crescendo symbol from the Palette and drag from left to right.

\[
\text{Crescendo-diminuendo symbol}
\]
• To insert a diminuendo-crescendo (><) symbol, select the double crescendo symbol from the Palette and drag from right to left.

• When you have inserted a crescendo/diminuendo symbol, you can move it and resize it by dragging its handles.

• If the option “Keep Crescendi Symbols ‘Horizontal’” is activated in the Preferences–Scores dialog, crescendo/diminuendo symbols will never be slanted when you draw them, but stay horizontal. Also, this option prevents you from accidentally dragging an endpoint up or down when moving the symbol.

• It’s also possible to “flip” crescendo symbols, by clicking the Flip button on the extended toolbar:

Aligning Dynamics

There is a special command for aligning dynamic symbols (including crescendos) horizontally. Unlike the regular Align function (see page 198), Align Dynamics takes the “baseline” of the dynamic letters into account, aligning them as text rather than as graphic symbols. Furthermore, the Align Dynamics feature doesn’t require that you select the dynamic symbols by hand:

1. Use the Select All command to select all objects in the Score. This selects all dynamic symbols, along with other symbols, notes, etc. If you only want to align some of the dynamic symbols, select these manually instead of using Select All.

2. Pull down the Scores menu, and select the Dynamics option from the Align Elements submenu. The dynamic symbols are correctly aligned, leaving all other symbols and elements untouched.

The “Graphic” Palette

There are a number of note head, rest and accidental symbols in the “Graphic” symbol palette. These work only as drawing elements, i.e. they do not insert any note data into the track.
The “Line and Trills” Palette

Octave symbols

The octave symbols (8va and 15va) act as a “local Display Transpose” (see page 37) - they shift the display of the score one/two octaves down.

- By dragging the end of the dotted line, you can specify exactly which notes should be affected by the octave symbol. Only notes beneath the dotted line are display transposed.

Tuplet Group symbols

- These are “graphical” tuplet group symbols, as opposed to the “real” tuplets.
- After inserting a tuplet group symbol, you can double click on its number and enter any number from 2 to 32.
- You can specify globally how tuplets should be displayed in the Notation Style dialog on the Scores-Global Settings submenu. You can also select a font and size for the tuplet numbers in the Global Text dialog on the same menu.

Vertical symbols

The Vertical symbols in the Lines & Trills Palette are “note dependent”, This means that they must be inserted in front of a note. For more information see page 161 and the text about Grace notes (which behave similarly) on page 152.

The “Other” Palette

Lyrics and Text symbols are described in “Working with Text”. Chord symbols are described on page 208.
Pedal Down and Up symbols

When you insert a Pedal Down or Up symbol, you will also insert an actual MIDI event (Damper Pedal, Control Change 64) at that position. Similarly, inserting or recording a Damper Pedal event in another Editor will display a Pedal Down/Up symbol in the score.

- If the option “Hide Pedal Markers” is activated on the Switches tab in the Notation Style dialog (Scores-Global Settings submenu), all Pedal Markers are hidden.
  Use this if you have recorded a lot of Damper Pedal messages, but don’t want these to show in the score (for example if you are writing for another instrument than piano).

Repeats

Repeat signs (one and two bars) have a special feature: if you hold down [Shift]+[Ctrl]/[Command] when entering them, notes in the bars they relate to are automatically hidden (for more info on Hiding symbols, see page 246).

Box (rectangle) symbol

This is a “generic” box symbol, which may be useful for different purposes. If you double click on a box, a dialog opens in which you can specify whether the box should be transparent or not, and whether the border should be visible.

The box symbol is available both in the Other palette and the Layout palette.

The Keyboard symbol

This is described on page 177.
The “Layout” Palette

Rehearsal Marks

These come in two flavors, as numbers and as letters.

When you place the first of these in the score, it will be labelled 1 or A (depending which you chose in the palette), the second will then automatically be labelled 2 or B, the next 3 or C etc. If you delete one, the labelling of the others will be shifted so that they always make up a complete series of numbers/letters.

• You can select a font and size for Rehearsal Marks in the Text dialog (Global Text tab) on the Scores-Global Settings submenu. This dialog also allows you to add a box or an oval around the Rehearsal Mark.

• Rehearsal Marks can be added automatically, at the start position of each Marker part in the Arrangement. This is done using the “Marker track to Form” function.

Endings

There are two types of endings, closed (“1”) and open (“2”). Both can be stretched to any length or height by dragging the handles. You can also double click on the existing number and enter any text you like.

Endings are available both in the Layout palette (for the Layout layer), the Global palette (for the Global Layer) and the Lines & Trills palette (for the Note Layer). Which one to choose depends on the score; while it's handy to insert endings once and for all as Global symbols, this won't allow you to make individual adjustments for the different parts.
**Tempo**

This always shows the current tempo according to the Tempo track. In other words, to make this symbol display a certain tempo, insert the value into the Tempo track.

Normally this symbol shows the number of beats (quarter notes) per minute but if you right-click on it and keep the mouse button pressed, a menu appears that allows you to select any note value. The number then changes accordingly.

**Tempo Change as Note symbol**

This symbol allows you to specify a tempo change as a change from one note value to another. The example above would mean "lower the tempo by a third."

To change the note value for either symbol, right-click on it and keep the mouse button pressed. A pop-up with the available note values appears.
9

Working with Chords
Chord Symbols

Inserting Chord Symbols manually

How to use the Pencil tool and the Symbols Palette to enter symbols is described in general in the chapter “Working With Symbols”, see page 170.

When you insert a chord symbol, a dialog box opens up where you can fill in the type of chord.

1. Enter the key (root) note in the Key Note field.
   You can either type in a chord letter or select a note from the pop-up menu to the right.

2. Specify a chord type in the “Type” field.
   You can either type it in (for example, by typing a “7”) or select an option from the pop-up menu to the right.
3. If you wish, specify a tension in the “Tension” field. Again, this can be done by typing or by using the pop-up menu. However, there are some special display options which you can only get by typing (see the table below). You might also want to add some text here (such as “no third”, etc.). If you wish, you can select the basic tensions from the pop-up menu, and then add special options by typing.

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
<th>Example:</th>
<th>Result:</th>
</tr>
</thead>
<tbody>
<tr>
<td>()</td>
<td>The tensions will be enclosed in brackets.</td>
<td>9(#5)</td>
<td>C9(#5)</td>
</tr>
<tr>
<td>/</td>
<td>The tensions will be separated by a slash sign.</td>
<td>9/5</td>
<td>C9/5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The tensions will be placed above one another.</td>
<td>9</td>
</tr>
</tbody>
</table>

You can also combine several options. This is a combination of two options, along with a space to put the “9” above the “5”. Note that only one “("-sign is needed when the “|” option is used.

4. If you want to have a special bass note (like for example to have a C major with a D bass note) set the Bass Note pop-up menu to anything but the Key Note. The program will “remember” the relation between key and bass note, so that if you change the key note, the bass note will follow.

5. If you want the Key note to be displayed in lower case, activate the “Keynote in lower case” checkbox.

6. If needed, click on the button labelled “Enharm. Shift”, to turn this on or off.

7. Click Apply. The Chord Symbol appears in the score.

- You can make further settings to determine how the chords should be displayed - see page 213.

- If you want to edit a chord, select the symbol, adjust the settings in the dialog and click Apply. If the dialog is closed, you can open it by double clicking the chord symbol.
Using presets

As with many other functions in Cubase SX, you can create presets for instant use. Each preset contains all settings in the dialog - in other words, the preset list is a “library” of chords. The preset handling is the usual:

- Click Store to store the current settings as a preset. A dialog will appear, allowing you to enter a name for the preset.
- To load a stored preset, select it from the Presets pop-up menu. Note that this only loads the settings into the dialog - you need to click Apply to apply the settings to a selected chord symbol.
- To remove a preset, select it on the pop-up menu and click Remove.
Using Make Chord Symbols

If you have already recorded the chords for a song, Cubase SX can analyze them and create Chord Symbols:

1. Open the recording in the Score editor.
   If you want the chords to be inserted on another track, you can create an empty part on that track and open it along with the recording.

2. If you like, make settings for how the chords should be displayed in the Chord Symbols dialog on the Scores-Global Settings submenu.
   You can change all these settings after you inserted the chords as well.

3. Select the notes for which you want chord symbols to be created.
   If chord symbols should be created for all chords on the track, use the Select All function on the Edit menu.

4. Use the arrow keys to make the desired staff active.
   This should be the staff in which you want the chord symbols to end up.

5. Select “Make Chord Symbols” from the Scores-Staff Functions submenu.
   The chords appear. They can be moved, duplicated and deleted as any other symbol.
   You can also double click on a chord symbol to edit it in the Chord Symbol dialog (in the same way as when creating Chords manually - see above).

A staff after using Make Chord Symbols.

- Instead of using the “Make Chord Symbols” menu item, you can click on the Make Chord Symbols icon on the extended toolbar.

- If the option “Use for Make Chord Symbols” is activated in the Guitar Library dialog (see page 179), guitar chord symbols will be added as well (if the Guitar Library contains any guitar symbols that match the chords).
About the analysis

- The MIDI Chords are expected to be played in their most basic inversion. If not, an extra bass note is added. For example, the notes CEG are interpreted as C major, but GCE is interpreted as C Major with a G bass note. If you don't want any interpretation of the inversion (no special bass notes) hold down [Ctrl]/[Command] while selecting Make Chords.

- All selected notes on all staves are taken into consideration. Whenever there is any change on any staff, the notes are reinterpreted and a new Chord Symbol added. This means you should probably avoid having the melody track in the Score editor when you use Make Chords, or you will get a lot more Chords than you expect, possibly with strange tensions.

- In addition to the above, the Quantize value is used. At the most, there will be a new chord at each Quantize position.

- There must be at least three notes at a certain position for the program to interpret it as a chord. Also some combinations of notes simply don't make any sense to the program and won't produce any chords.

- The analysis method isn't infallible. It can't be because the same set of notes can be interpreted differently depending on context. Some editing may be needed. If you record the track solely to create chords automatically, play the chord as simple as possible, in the correct inversion, without added octaves, etc.
Global Chord Settings

In the Chord Symbols dialog on the Scores-Global Settings menu, there are several global settings that affect how chords are displayed. These settings affect all chords in the Project.

The dialog has two tabs, Types and Font:

**Chord Types**

- Use the four sections of radio buttons to specify how the four most common chord types should be displayed.

- If you want the Root (key) note to be aligned with the Bass note, so that they both are displayed at the same vertical position, activate “Align Root Note”.

- If you want the tensions to be displayed at the same vertical position as the Root note (rather than a bit above the Root note), activate the “Tension Bottom” checkbox.

- Activate the “Scale Chords” option if you want to scale a staff (using the Size setting in the staff Options dialog), and want the chords to be scaled accordingly.

- To apply the settings to the currently displayed score, click “Apply to Chords”.
Chord Font

- Use the Font pop-up to select a font for the chords. Cubase SX comes with a special font for this (Steinberg Chord Symbols), but you can use any font you like.

- Use the four Size value fields to select sizes for the four different chord "elements". You can type in values or use the pop-up menus. Normally, you would want the “Root” size to be the largest and the “Tension” size the smallest.

- Use the radio buttons to the left to select a chord display mode. This affects how the Key and Bass notes are displayed:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>Regular notation.</td>
</tr>
<tr>
<td>DoReMi</td>
<td>“Do-Re-Mi-...” are used instead of “C-D-E-...”</td>
</tr>
<tr>
<td>German</td>
<td>As English notation, but “B” is displayed as “H”, and “Bb” or “A#” are displayed as “B”.</td>
</tr>
</tbody>
</table>
10

Working with Text
In this Chapter you will learn:

• About the different types of text.
• How to enter and edit text.
• How to set Font, Size and Style.
• How to enter lyrics.

Adding and Editing Text Symbols

This section describes the general procedure for adding and editing Text Symbols. As described on page 224, there are several different types of text symbols, but the basic procedures are the same (except for Global page text symbols - see page 227):

Inserting a Text Symbol

1. If you wish, select a font, size and style for the text (or select a Text Attribute) as described on page 220.
   The text you insert will use the text settings made when no text is selected, but you can change all settings after you inserted the text.
2. Make sure the desired symbol palette is visible.
   The different Text Symbols are found on the “Other”, “Layout” and “Global” Palettes.
3. Click or double click on the Text Symbol in the Palette, so that the Pencil tool is selected.
4. Make sure the correct staff is selected, and click in the score at the position you want the text.
   If you are adding lyrics, you should click above or below a note (lyrics are centered around each note and positioned vertically to where you clicked). See page 224.

5. Enter the text in the text box that appears.
   You can use [Backspace] to delete letters, and move the cursor with the arrow keys.
6. When you are done, press [Return].
   The text appears. You can move, duplicate or delete it as with any symbol.
About the Melisma Lines

When you add a text symbol, you will find a handle at the right edge of the text block. By dragging this handle to the right, you can extend a “melisma line” from the text. This has several uses:

• If you are adding lyrics and want to indicate that a syllable should be sung over several notes:

\[ \text{you’re my …………………. ba – by} \]

• If the text is an advice about articulation or playing style, and you want it to apply to a certain musical phrase only:

\[ \text{Growl} \]

• If the text is an advice about articulation or playing style, and you want it to apply from that point on in the score:

\[ \text{Molto furioso!} \]

In the Text Settings dialog (see page 220) you will find two settings that determine the appearance of the melisma lines:

• The Melisma Style pop-up is where you specify whether the line should be solid or dotted.
• The Melisma End pop-up allows you to choose whether the end of the line should be plain, have an arrow, or form a “bracket” up or down.
Making Space

- If you find there isn’t enough space between staves to add for example lyrics please see page 260 for info on how to separate the staves.
- If you find the score looks crammed after adding text, check out Automatic Layout on page 264.

Editing the Text

If you made a mistake when typing or for some other reason wish to change text, double click on a text block with the arrow tool, edit the text and press [Return] to close it.

- It is also possible to replace all occurrences of a certain word in the score, without having to edit the texts manually - see page 230.

Selecting Font, Size and Style for the Text

1. Select the Text Symbol(s) you want to make settings for. If nothing is selected, the settings you make will be the “default settings”. The next time you insert text, these settings will be used.

2. Pull down the Scores menu and select “Font Settings” from the Text submenu. The Font Settings dialog appears.

3. Select a Font from the pop-up. How many and which fonts appear depends on what typefaces you have installed on your computer.

   For regular text you should probably avoid the “Steinberg” fonts. These are the fonts Cubase SX uses for all scoring symbols, etc.

4. Select a text size from the “Size” pop-up menu (or enter one manually in the text field).
5. If you wish, add one or several text style options from the checkboxes and pop-ups.
Most of the options are common text style variations such as bold, italic, underline, etc.
But there are also a few special style options:

<table>
<thead>
<tr>
<th>Option:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Melisma options</td>
<td>These determine the appearance of the “melisma line”, as described on page 219.</td>
</tr>
<tr>
<td>Frame</td>
<td>Allows you to put the text in a rectangular (“Box”) or oval frame.</td>
</tr>
<tr>
<td>Positioning</td>
<td>Allows you to select which side of the text block (left or right) should be used for calculating its position. This has an effect in situations where that text block is moved automatically (as a result of an Auto Layout function, when you move bar lines manually, etc.). If, for example, the text block appears just in front of a note (to the left of it), it will appear in a more sensible position after the adjustment, if the “Right” option is selected.</td>
</tr>
<tr>
<td>Alignment :</td>
<td>Allows you to specify the alignment of the text.</td>
</tr>
<tr>
<td>Left/Center/Right</td>
<td>These options are only valid for texts with more than one line.</td>
</tr>
</tbody>
</table>

6. Click Apply to apply the settings to the selected text.
   Note that you can select other text blocks while the dialog remains open - the dialog will be updated to reflect the settings of the currently selected text.

7. When you are done, close the dialog by clicking its close box.
Using Text Attribute Sets

A Text Attribute Set can be seen as a “preset” containing all font, size and style settings. By creating Text Attribute Sets for the settings you use most often, you can save a lot of time.

Creating a Text Attribute Set

1. Pull down the Scores menu and select Text from the Global Settings submenu.
   The Global Text settings dialog appears.
2. Select the Text Attribute Sets tab.
3. Pull down the Set pop-up menu and select the “Empty” set.
4. Select a font, specify a size and add style options with the check-boxes.
   The options are the same as when you make text settings on the Scores menu (see above).
5. Click in the name field and enter a name for the new text attribute set.
6. Click Store to store the new text attribute set.

Using a Text Attribute Set

To apply the settings in the text attribute set to one or several text blocks, select them, select the Set from the Set pop-up menu in the Text Settings dialog (Scores-Text-Set Font) and click Apply. You can also apply a text attribute set to a text block directly in the score by right-clicking it and selecting the set from the pop-up menu that appears.

• If you select a text attribute set in the Text Settings dialog when no text is selected in the score, the settings will be used the next time you insert some text.

• After you've selected a set for a text block, there will be a “link” between the text and the attribute set. Any changes to the attribute set (see below) will affect all texts that use it.
   You can still edit any text settings manually (on the Scores-Text menu) but then the “link” to the attribute set will be removed.
Editing Text Attribute Sets

If you edit the settings in a Text Attribute Set, all texts using that Set will be affected. This is very practical, since it allows you to use the same number of “generic” Sets for all your Projects (for titles, comments, lyrics, etc.), and simply change the fonts, sizes, etc. for a different Project if necessary. This will also make it easier to move Projects between computers (which may not have the same fonts installed).

1. Select the Attribute Sets tab in the Global Text settings dialog.
2. Select the attribute set you want to edit from the Set pop-up menu.
3. Change the settings as desired.
   This includes the name of the set.
4. Click Store.
Different Types of Text

Regular Text

The Regular Text option selected.

This type of text is inserted by selecting “Text” in the “Other” Symbols Palette.

The text is tied to the bar and staff position. If you move the bar or the entire staff, it moves with it.

Inserting the same Text to all staves

If you hold down [Alt]/[Option] when clicking with the Pencil, the text you type in will be added to all staves you are currently editing.

Lyrics

The Lyrics option selected.

This type of text is inserted by selecting “Lyrics” in the “Other” Symbols Palette.

When you insert Lyrics, you should click below or above the note the syllable belongs to. The text will then appear horizontally centered around the note and vertically positioned to where you clicked. You can later move it up or down, as with any symbol.

This text is tied to note position. If you move the note, the text moves with it. The spacing between notes is also adjusted to make the lyrics fit.
Inserting Lyrics for a number of Notes

1. With Lyrics selected, click below or above the note with the pencil tool.

Click below the first note.

2. In the text dialog that appears, type in the syllable for that note.

3. Hit [Tab].
   The program moves on to the next note.

4. Input text for this note and hit [Tab] again.

5. Proceed until the last note and then press [Return] or click outside the text box.

   Normally when you insert lyrics this way, the positions of the notes will automatically be adjusted so that no lyric “block” overlaps another. If this is not what you want, you can activate the option “Don’t Sync Lyrics” in the Notation Style dialog - Switches page (accessed from the Scores - Global Settings submenu). If this is activated, the note positions will not be affected, which may be preferable.
Lyrics and Measure Widths

When you first enter lyrics, it will probably look cramped, since the words take up more space than the notes (the lyrics are also selected just after entering the last word, which make them look a bit odd when overlapping). To remedy this, use Auto Layout to automatically adjust the measure widths (see page 264).

Before and after using Auto Layout.

Inserting Lyrics into Voices

Each voice can have it’s own lyrics. If you for example have a vocal arrangement with several voices, you can add lyrics to them, one by one.

1. Click or double click on the Lyrics Symbol in the “Other” Palette, so that the Pencil tool is selected.
2. Make sure the right voice is selected (on the extended toolbar).
3. Click on the first note in the selected voice.
4. Enter the lyrics for this voice, with [Tab] as described above.
5. Start over, by activating the next voice, clicking on the first note in that voice and proceed as with the first voice.
6. If needed, adjust the position of the lyrics for each voice (see below).
Moving Lyrics

If you want to move the lyrics up or down, for example to make room for a second verse, proceed as follows:

1. Hold down the [Shift] key and double click on the first word in the lyrics.
   All lyric “blocks” get selected.
2. Drag one of the lyric blocks up or down.
   All selected lyric blocks are moved accordingly.

Layout Text

The Text symbols in the Layout palette are part of the Layout layer, and can thus be hidden or shown for different tracks in the layout, by adjusting the settings in the “L” column in the Layout Settings dialog. In all other ways it is exactly the same as regular Text (see above). This means it is tied to the bar and staff position. If you move the bar or the entire staff, it moves with it.

Global Page Text

The Page Text symbol in the Global palette is different from regular text. It is part of the Global layout, and will therefore appear in all layouts. The text’s position isn’t tied to a note, bar or staff position. In other words, it doesn’t matter if you move other objects on the page, the Page Text stays where you put it. Typically, it’s used for score titles, page numbers, copyright information and other text elements that you want displayed with all parts (on all pages if you like).

Page Text is entered in a special way:

1. Bring up the Global symbol palette.
2. Click or double click on the Page Text symbol to bring up the Pencil tool.
3. Click in the score.
   It doesn’t matter where you click - the positioning is made from the dialog that appears.
4. Enter the text you want displayed in the field at the top of the dialog.
   You can use special characters to add “variables” such as page numbers - see below.
5. Adjust the settings for how the text should be positioned:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show on all pages</td>
<td>When this is activated, the text will be shown on all pages. The “Except First” checkbox allows you to exclude the very first page.</td>
</tr>
<tr>
<td>Show on first page</td>
<td>When this is selected, the text will only be shown on the first page.</td>
</tr>
<tr>
<td>Line</td>
<td>This determines how many lines of text should be used.</td>
</tr>
<tr>
<td>Toggle Position</td>
<td>When the Left or Right position option is selected to the right, activating this checkbox will make the text alternate between left and right alignment on even/odd pages.</td>
</tr>
<tr>
<td>Position buttons</td>
<td>Determines where on the page you want the text, vertically (Top/Bottom) and horizontally (Left, Center, Right).</td>
</tr>
</tbody>
</table>

6. Select a Text Attribute Set for the text, or make manual settings for font, size and style.

7. Click OK.
   The text is inserted. You can adjust the positioning manually by dragging the text block.

Inserting variables

When you enter the text to be displayed, you can insert special characters or "place holders" for special attributes. When the text is displayed, these characters will be replaced by their actual values (e.g. page numbers). The following variables are available:

<table>
<thead>
<tr>
<th>Text to enter</th>
<th>Text that will be displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>%p</td>
<td>The current page number.</td>
</tr>
<tr>
<td>&amp;l (lower case L)</td>
<td>The long staff name.</td>
</tr>
<tr>
<td>&amp;s</td>
<td>The short staff name.</td>
</tr>
<tr>
<td>%r</td>
<td>The name of the Project.</td>
</tr>
</tbody>
</table>

For example, if you enter the text “%l, %r, Page %p”, it might be shown as “1st Violin, Quartet No.2, Page 12” in the score.
Text Functions

The Words Palette

If you have certain words that you use a lot, you can “store” these on the Words palette. This will save time, since you don’t have to type the same word several times.

Storing a Word

1. Display the Words symbol palette.
2. Double click on an “empty” symbol field in the palette.
   The Edit Words dialog appears.
3. Type in the desired word(s) in the text field at the top of the dialog.
4. Specify the text type (regular text or lyrics) with the Type pop-up.
5. Make settings for font, size and style.
   You can also use a Text Attribute Set if you like.
6. Click Exit to close the dialog.
   The word(s) you entered appear in the selected symbol field on the palette.

Image: Custom Text Editor dialog with settings for font, size, and style.
Inserting a Word

You insert Words from the palette as you would insert any regular symbol, by selecting the appropriate Word and clicking in the score. However, you can edit the Word after inserting it, just as with text inserted by typing.

Find and Replace

This function allows you to replace all occurrences of a certain word or group of words, with another word or group of words. The replacement is done once and for all, for all text symbol types, regardless of font, size and style settings. Proceed as follows:

1. Pull down the Scores menu and select “Find and Replace” from the Text submenu.
   A dialog appears.

2. Enter the word(s) to replace in the “Find” value field.

3. If you want all instances of the word(s) to be replaced, regardless of upper/lower case, deactivate the “Case Sensitive” option.

4. If you don’t want to replace the word(s) if they are a part of another word, activate the “Entire Word” option.
   For example, if you want to replace the word “string” but not the word “stringendo”, you should activate “Entire Word”.

5. Enter the word(s) that should be used as replacement in the “Replace” field.

6. Click OK.
   Now all occurrences of the “Find” word(s) will be replaced with the “Replace” word(s).
Staff Names

Settings for staff names are done in several places:

- In the Layout Settings dialog, you specify whether the staff names should be shown at all, and whether to use the names of the actual edited tracks in the score. In a multi-track layout, you can choose which tracks should have staff names shown, by clicking in the “N” column for each track.

- You specify a long and short staff name in the Staff Settings dialog. These will be used if you don’t use the “From Tracks” option in the Layout Settings. The Long name will be displayed for the first system only, and the Short name will be displayed for the following systems. If you want a name at the top of the page only, leave the “Short” name field empty.

- If the option “Show Long staff Names on new Pages” is activated in the Notation Style dialog (Switches tab), the Long name will be displayed for the first system on every page.

- The Text dialog on the Global Settings submenu allows you to select a font for the staff names:
  1. Pull down the Scores menu and select Text from the Global Settings submenu.
  2. Select the Global Text tab.
  3. Use the “Font for” pop-up menu to select “Track Names”.
  4. Select font, size and styles for the Staff Names (or use a Text Attribute Set).
  5. Click OK to close the dialog.

You can also edit the text settings for staff names directly from the score, as described on page 234.

Additional staff Name Settings

- If you activate the option “Show Staff Names to Left of staff” in the Notation Style-Switches dialog, the staff names will be shown to the left of the staves, instead of above them.
- You can fine tune the vertical and horizontal position of Staff Names in the Spacing dialog on the Global Settings submenu.
Bar Numbers

Bar number settings can be made in several places as well:

General Settings

1. Pull down the Scores menu and select Notation Style from the Global Settings submenu.
2. Select the Beams & Bars tab.
3. Use the “Show Bar Numbers every X bars” setting to specify “how often” bar numbers should be shown.
   The options are “First” (bar numbers shown for the first bar on each staff), “Off” (no bar numbers shown) and any number.
4. If you like, activate the “Show Bar Number Range with Multi-Rests” option.
   When this is activated, and you have a multi-rest, the bar number at the beginning of the multi-rest will show a range, indicating the length of the multi-rest.
5. If you want the bar numbers to be displayed below the bar lines, activate the “Show Bar Numbers below Barlines” option.
6. Click OK to close the dialog.

Text Settings

As with many of the other fixed text elements, you can select a font, size and style for the bar numbers in the Scores–Global Settings–Text dialog (Global Text tab), or directly from the score, as described on page 234.
Spacing

In the Scores–Global Settings–Spacing dialog you will find four settings that relate to bar numbers:

<table>
<thead>
<tr>
<th>This Option</th>
<th>Is Used To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Bar number - Vertical Offset</td>
<td>Set the vertical distance between the bar number and the bar line for the first bar on each staff.</td>
</tr>
<tr>
<td>First Bar number - Horizontal Offset</td>
<td>Set the horizontal distance between the bar number and the bar line for the first bar on each staff.</td>
</tr>
<tr>
<td>Other Bar numbers - Vertical Offset</td>
<td>Set the vertical distance between the bar number and the bar line for all other bars.</td>
</tr>
<tr>
<td>Other Bar numbers - Horizontal Offset</td>
<td>Set the horizontal distance between the bar number and the bar line for all other bars.</td>
</tr>
</tbody>
</table>

Offsetting Bar Numbers

If you double click on a bar number, a dialog appears, allowing you to skip a number of bars in the otherwise continuous bar numbering.

This is used for example when a section repeats. Say, you have a repeat of bar 7 and 8, the first bar after the repeat should have the number 11, not 9. To achieve this you double click on the “9” and insert an offset of “2”.

It is also useful if the score starts with an upbeat, and you want the first “real” bar to be numbered 1. In that case you would specify an offset of “-1” for the second bar, and make sure the bar number for the upbeat bar is hidden.

- Bar Number Offsets belong to the Global layer and are shown for all tracks and layouts.
Settings for other Fixed Text Elements

You can make text settings for virtually all text and numbers that appear in the score. There are two ways to do this:

Making text settings in the Global Text dialog

1. Select Text from the Scores-Global Settings submenu.
2. Select the Global Text tab.
3. Use the “Font for” pop-up menu to select a text type to make settings for.
4. Use the options in the dialog to change the settings.
5. Click OK to close the dialog and apply the settings to all elements of the selected type.
   You can also click the Apply button, to apply the settings without closing the dialog.

Making text settings in the score

Most of the Global Text settings can be edited directly in the Score window, without having to open the dialog:

1. Select an object for which there is a Global Text category.
   These include Bar Numbers, Track Names, Time Signatures, Marker parts, Tuplets, Rehearsals, Tablatures and Multi Rests.
2. Open the Text Settings dialog (“Set Font” on the Scores-Text submenu, adjust the settings and click Apply.
   Or, you can right-click directly on the text element and select a text attribute set from the pop-up menu that appears.
   Either way, the settings for the Global Text category are changed, and the changes are applied immediately to all objects of the category.
11

Working with Layouts
In this chapter you will learn:

- What Layouts are and what they contain.
- How to Create Layouts.
- How to use Layouts for opening combinations of tracks.
- How to Apply, Load, Save and Delete Layouts.
- An example of how Layouts can be used.

Background: Layouts

Layouts can be viewed as “presets” containing settings for the Layout layer: staff spacing, bar lines, layout symbols etc.

When to use Layouts

- You will need to format the score differently when you print the entire score and when you extract parts for single instruments (or groups of instruments) Layouts allow you to keep different sets of “looks” for the same track or set of tracks. You might for example have one Layout for each single Instrument and one for the entire Score.
- By using the Show function in the Layout List window, you can switch to another combination of tracks without having to leave the Score editor.

What is in a Layout?

A layout contains the following items and properties:

- Symbols inserted from the Layout palette.
- All settings in the Layout Settings dialog.
- The vertical spacing of the staves.
- Bar line spacing.
- Broken bar lines.

However, Global palette symbols, bar line types and bar number offsets are part of the Global layer, and will appear in all layouts.

How Layouts are stored

Layouts are created automatically when you edit a single track or a combination of tracks. They are an integral part of the specific track combination, which means you do not have to store them separately.
Creating a Layout

Layouts are created automatically when you perform the following steps:

1. Open a new combination of tracks for editing.
   Each track may have been edited before, individually or together with other tracks, it doesn’t matter. What matters is that you open precisely these tracks. For example, to create a Layout for a string quartet, select parts on the tracks Violin 1, Violin 2, Viola and Cello, and press [Ctrl]/[Command]-[R].

   □ The order of the tracks does not matter - you can reorder them in the Project window without removing the Layout. However, the spacing of the staves in the Layout is related to the order of the tracks.

2. Perform some type of editing that affect the Layout.
   Check the list above. You might for example add Layout symbols to one or more staves, drag bar lines, adjust staff spacing, add braces in the Layout Settings dialog, etc.
The Layout List

Selecting “Show List” from the Scores-Layout Settings submenu brings up the Layout List window. This lists all existing layouts in the Project, with the current one selected. Here you can perform a number of operations:

Opening the tracks in a layout

To select another combination of tracks for editing, select the corresponding layout in the list and click Show.

- You can keep the Layout List window open while you are editing, and use this function for selecting which tracks to edit.

Importing layout symbols

By selecting another layout and clicking Get Form, you import all Layout symbols (inserted from the Layout symbol palette) from the selected layout into the current layout.
Managing layouts

• To rename a layout, double click its name in the list and type a new one.
  Initially, a layout gets the name of one of the edited tracks - it may be a good idea to give each layout a more informative name. You can also rename the current layout in the Layout Settings dialog (Scores/Layout Settings/Setup).

• To remove a layout you no longer need, select it and click Remove.

• To remove all layouts for which there no longer are track combinations, click Clean Up.

Using Layouts – An example

The following text outlines the basic steps for extracting a musical part from a full score.

1. Prepare the entire Score, including all formatting. Create a named Layout for it (for example “Full Score”). Make notes of which changes you make that are actually part of the Layout and not the individual tracks.

2. Close the Score editor.

3. Open a single track, for example a woodwind part.
  The Global Layer settings (global symbols, bar line types, etc.) will automatically appear in the new single track layout.

4. If you need, open the Layout List, select the “Full Score” Layout and click Get Form to extract the Layout symbols from the Full Score Layout.

5. Prepare a Layout for the woodwind part.
  You might for example move bar lines, add endings, turn on multiple rests, etc.

Be careful not to change any of the properties of the track which are not part of the Layout (or you will modify the “Full Score” too).

6. Name this Layout in the Layout List window.
Marker Track to Form

If you have created markers in the Project window, so that each marker denotes the start of a new “section” in your music (verse, bridge, chorus, etc.), you can automatically transfer these markers to the current layout:

1. Pull down the Scores menu and open the Layout Functions submenu.
2. Select “Marker Track to Form”.
   Now, Rehearsal markers and double barlines are inserted in the score, at the position of each marker.
3. If you want the names of the markers shown as well, select “Show Marker Track” from the Layout Functions submenu.

• The Marker Track to Form function will only include “regular” markers, not cycle markers.
Designing your Score - Additional Techniques
In this chapter you will learn:

- How to change the staff size.
- How to create multi rests.
- How to add and edit bar lines.
- How to create upbeats.
- How to set measure spacing and the number of bars across the page.
- How to control staff and grand staff spacing.
- How to use Auto Layout.
- How to use Clean Up Layout
- How to break bar lines.

Before you start designing the score page layout, you should open the Page Setup dialog on the File menu, and make settings for paper size, print scale and margins!

Layout Settings

The Layout Settings dialog (opened by selecting "Setup" from the Layout Settings submenu on the Scores menu) contains a number of settings that affect the display of the current layout.
The track list

The display to the left lists the tracks included in the layout and allows you to make the following settings for each track:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brackets</td>
<td>These two columns allow you to add braces or brackets, encompassing any number of tracks in the layout. See page 263.</td>
</tr>
<tr>
<td>T</td>
<td>This is relevant if the Modern Time Sign is activated to the right. In that case, you use this column to specify for which tracks the time signature should be shown - see below.</td>
</tr>
<tr>
<td>N</td>
<td>Determines whether the staff name should be shown for each track in the layout.</td>
</tr>
<tr>
<td>L</td>
<td>If this is ticked for a track, any Layout symbols will be shown; otherwise they will be hidden. This allows you to e.g. have Rehearsal markers shown for the top track only in a multi-staff layout.</td>
</tr>
</tbody>
</table>

Multi Rests

Whenever more than one-bar rests occur, the program can replace these with a multi-rest symbol. The parameter allows you to set how many empty bars should be “allowed” before Cubase SX should collect them into a multi-rest. “Off” means “never”. See page 249 for more info on Multi Rests.

Size

Changes the size of all staves. See page 245.

Real Book

When this option is turned on, Clef symbols are not set out at the beginning of each staff, only on the first staff on each page.
Staff Separators

When this option is turned on, separator symbols are inserted at the beginning of each grand staff.

A Staff Separator between two systems.

Modern time signature

When this is activated, time signatures are shown above the staves rather than in them. You can set the size of the Modern time signature in the Notation Style dialog on the Global Settings submenu (Switches tab). Also note that when Modern time signature is selected, you use the "T" column in the track list in the Layout Settings dialog, to specify for which tracks time signatures should be displayed.

• If you generally prefer to display the score in a more modern way, check out the options in the Notation Style dialog on the Global Settings submenu (Options tab)!
  For descriptions of the options in the dialog, use the Help button in the dialog.
Staff Size

For one staff

You can set the staff size as a percentage of normal size.

1. Open Staff Settings for the staff you are interested in.
2. Select the Options tab.
3. Adjust the Size parameter in the System Sizes section.
   The values range from 25% up to 250% of normal size.
4. Click Apply.

For all tracks in a layout

1. Open the Layout Settings dialog.
2. Change the Size parameter.
   The values range from 25% up to 250% of normal size.
3. Click OK.

   All staves will now get the desired size. Staves that have individual
   size settings (as described above) will still be proportionally smaller/
   larger.

   This setting is part of the Layout and can for example be used when
   printing a full score slightly smaller than the parts for each instrument.
Hiding/Showing Items

“Any” object on a page can be hidden, including notes, rests, symbols, clefs, bar lines, even entire staves, you can make a page totally blank by hiding! (well, actually, one staff has to remain shown). Applications are found below.

Hiding

To hide items proceed as follows:

1. Select all the items you want to hide.
2. Select Hide from the Staff Functions submenu or click on the Hide button on the extended toolbar.

• Notes can also be hidden by selecting them, selecting “Get Info” from the Edit menu, and ticking the “Hide Note” checkbox in the Note Info dialog (see page 132).

Hiding in this Layout only

If you want the Hiding to be “local” to the current layout, hold down [Ctrl]/[Command] when selecting Hide as described above.

This is not possible when hiding notes, only other symbols.

Viewing hidden objects

If you switch the Score editor to Edit mode, all objects will be visible. Switch back to Page mode, and hidden objects will be invisible again.

The display filter bar (shown by clicking the F button on the toolbar) contains two options related to hidden objects:

• If you activate the “Hidden Notes” option, all hidden notes in the score are shown.
  Deactivating “Hidden Notes” will hide the notes again.
• If you activate the “Hide” option, all hidden objects (except notes) will be indicated by a “Hide” text marker.

![Hide marker example]

**Showing one object**
1. Make sure “Hide” is activated on the display filter bar.
2. Click on the “Hide” text marker below the object you want to reveal. The text gets selected.
3. Press [Backspace] or [Delete]. The object appears. Undo is available if you change your mind.

**Showing all objects**
If you select “Show” from the Scores-Staff Functions submenu, all hidden objects are revealed.

• You can also use the Clean Up Layout function to permanently reveal hidden notes and objects, as described on page 267.

**Showing a hidden note**
While all hidden notes can be made visible by ticking the Hidden Notes checkbox on the display filter bar, you may want to make some of them “permanently” visible again:
1. Activate the Hidden Notes checkbox on the display filter bar.
2. Select the notes that you want to “un-hide”. If the option “Use Colors for Additional Meanings” is activated in the Preferences-Scores dialog, hidden notes are shown in a different color.
3. Double click one of the notes.
4. Turn off the Hide Note option in the Note Info dialog and click Apply.
Applications Of Hiding

Printing Scales

If you for example want to create scale examples, enter the notes and hide time signatures, bar lines and other unnecessary objects.

A scale created with hidden bar lines, time signatures etc.

Graphic Notation

By hiding bar lines, you can produce graphic notation.

Hiding notes meant for playback only

If you have recorded your music, you may have added glissandos, falls, etc. that sound fine but result in a lot of unnecessary notes. You probably want to hide those notes and insert the suitable symbols instead.
Multiple Rests

Multiple consecutive rests can be automatically consolidated into multi-rest measures as follows:

1. Open the Layout Settings dialog by selecting “Setup” from the Scores-Layout Settings submenu.

2. Set Multi Rests to specify how many empty bars should be “allowed” before Cubase SX should collect them into a multi-rest.
   For example, a value of 2 means that three or more consecutive empty bars will be collected into a multi-rest. The value “Off” means “never”.

3. Click OK to close the dialog.
   The multi rests now appear in the score.

   A Multi Rest over three bars.

Splitting Multi Rests

To divide one long multiple rest into many shorter, proceed as follows:

1. Double click on the Multi Rest symbol.
   The Split Multi Rest dialog appears:

2. In the dialog box, enter the bar number where you want the first split.

3. Click OK.
   If you need more splits, double click on any multi rest symbol and proceed as above.

   The program automatically splits multi rests wherever there is a change of Time signature, at double bar lines or repeat signs, or if a Rehearsal mark appears.
Multi Rest Appearance

On the Beams & Bars tab in the Notation Style dialog (Scores-Global Settings submenu), you will find a couple of settings that determine the appearance of multi rests:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Multi-Rest number above Symbol.</td>
<td>When this is activated, the numbers are shown above the multi-rest symbol, instead of below it.</td>
</tr>
<tr>
<td>Show Multi-Rests in Church Style</td>
<td>When this is activated, multi-rests are shown in “church style” (vertical bars), rather than with the regular, horizontal symbols.</td>
</tr>
<tr>
<td>Show Barnumber Range with Multi-Rests</td>
<td>When this is activated, and barnumbers are displayed, the barnumbers of a multi-rest will be shown as a range.</td>
</tr>
</tbody>
</table>

It is also possible to adjust the height and width of the multi-rest symbol (in the Scores–Global Settings–Spacing dialog) and to select a font for the multi-rest numbers (in the Scores–Global Settings–Text dialog).
Adding and Editing Bar Lines

Editing existing Bar Lines

For each bar line, you can choose whether you want a regular, single bar line, a double bar line, a repeat sign, etc.:

1. Double click on the bar line for which you want to edit the settings.
   A dialog appears with a number of bar line types.

2. If you wish the bar line to be shown with “brackets”, activate the Brackets checkbox.
   This is only relevant for repeat signs.

3. Click on the desired bar line type.
   The dialog closes and the bar line type is changed.
   - The bar line types are part of the Global layer - any changes you make will be reflected in all layouts.
The “Hide” option

One of the options in the bar line dialog is called Hide. This can be used as an optional way of hiding bar lines. Bar lines hidden this way will not get a “Hide” text marker, nor will they be revealed if you select the “Show” command on the Staff Functions submenu. The bar spacing, bar numbers etc. will behave just as if the bar line was visible. To show the bar line again, double click on it and select another type of bar line.

- If you have trouble finding a “hidden” bar line, try selecting it by dragging a rectangle around it.
  When selected, the bar line will be visible and it will be easy to double click it.
Creating Upbeats

By using the Pickup Bar feature

With this method, the upbeat actually contains exactly the number of beats displayed. That is, if you have a upbeat of one beat, your Project starts with one bar in 1/4 time.

1. Change the time signature of the first bar to the length of the upbeat.

2. Insert a time signature of the correct kind (the time signature used throughout the Project) in the second bar.
   Time signatures are inserted by selecting the time signature symbol from the "Clefs etc." symbol palette and clicking with the Pencil tool.

3. Enter the notes in the upbeat into the first bar of the song.

   The first bar before any adjustments.

4. Double click the time signature for the upbeat bar.
   The Edit time signature dialog appears.

5. Activate the option “Pickup Bar” and click OK.
Now, the time signature of the first bar takes on the look of the second bar’s signature, while the time signature in the second bar is hidden:

6. If you use bar numbers, double click on the first bar number and enter an offset of -1.

7. Adjust the display of bar numbers and hide the “0” in the first measure.

By hiding rests

With this method, the first bar will actually have the same time signature as the following bars - it will only look like an upbeat bar:

1. Enter the notes in the upbeat into the first bar of the song.

   The first bar before any adjustments.

2. Hide the rests that precede the notes.

3. Drag the bar line between measure one and two to adjust the width of the bar.

   After hiding the rest and dragging the bar line.

4. If you like, move the notes in the upbeat measure, using the Graphic Move tool.
5. If you use bar numbers, adjust them as in the previous example.

The final upbeat.
Setting the number of bars across the page

“Automatically”

- When you open a new combination of tracks for editing, the number of bars across the page is determined by the setting “Default Number of Bars per Staff” in the Preferences-Scores dialog.
- When you use the “Bars and Staves” Auto Layout function (see page 264), you will be asked for the maximum allowed number of bars across the staff.

Manually

In Page Mode you have full control of how many bars appear across the page, by using the Number of Bars dialog or the tools.

- If you want to use the “Bars and staves” Auto Layout function (see page 264), you should do this before you adjust the number of bars manually.

Using the Number Of Bars Dialog

1. Make a staff active in the system where you want to make changes. This means that if everything looks fine until for example the fifth system, make one of the staves active in this system.

2. Pull down the Scores menu and select “Number Of Bars” from the Layout Functions submenu. The Number of Bars dialog appears.

3. Set the desired number of bars across the page.

   - If you want to change the number of bars for the active staff only, click This Staff.

   - If you want to change the number of bars for the active staff and all following staves, click All Staves. In other words, to set all systems on all pages to the same number of bars, make the very first staff active and use the All Staves option.
Using the Tools

- To make a measure “fall down” on a new staff, use the Scissors tool to click on its bar line.

Before and after moving the third measure one staff down.

- To bring the measure back up to the previous staff, use the Glue Tube tool to click on the last bar line on the upper of the two staves. This will in fact move all measures in the lower staff up to the upper.
Moving Bar Lines

The following operations can be made using the regular Arrow or the Layout Arrow tool, it doesn’t matter.

Moving a Bar Line

If you drag a bar line to the left or right, the surrounding measures are adjusted proportionally.

Moving Bar Lines on All staves

If you hold down [Alt]/[Option] when dragging a bar line, all bar lines below the one you drag will be moved accordingly.

Moving a single Bar Line separately

If you hold down [Ctrl]/[Command] while dragging a bar line, the widths of the surrounding bars are not affected.

Making an indent on one line

• To create an indent, simply drag the first or last bar line on a staff. The sizes of all measures are adjusted proportionally.

Before and after dragging the first bar line on the first staff.
Making indents on several lines

If you hold down [Alt]/[Option] and drag the first or last bar line in a system, all following systems will get the same indent. If you want all lines on all pages to be indented in the same way, hold down [Alt]/[Option] and drag the appropriate bar line on the first system of the score.

The last bar line in the piece

Cubase SX attempts to move the last bar line and space the bars on the last line in a sensible way, but you can change this manually by dragging the last bar line if you like. You can also double click on it if you want another type of bar line than the default.

Resetting bar spacing

To reset the bar spacing to standard values for several lines, proceed as follows:

1. Locate the first line for which you want to reset the bar spacing, and make one staff in that system active.
2. Select "Number Of Bars" from the Format submenu on the Scores menu.
3. Specify the number of bars that you already have on the line.
4. Click on “This Staff”. Optionally, you might reset “All Staves” lines at the same times, as described on page 256.
5. Click OK to close the dialog.

The bar spacing is reset for the currently selected staff and all following staves.
**Dragging staves**

The following operations can be made using the regular Arrow tool or the Graphic Move tool, it doesn't matter. However, dragging staves can only be done in Page Mode.

**Adding Space between two Grand staves**

1. Locate the first staff in the lower of the two systems you wish to spread apart.

2. Clicking just to the left of the first bar line and keep the mouse button down. The entire staff is inverted.

3. Drag downwards or upwards and then release the mouse.
   
   The system you dragged has now moved down and all the systems below it have moved with it.

   ![Before and after](image)

   Before...

   ... and after dragging the upper system, to make room.
Setting the same distance between all grand staves

1. Hold down the [Alt]/[Option] key.
2. Drag the first staff of the second system, until you have the correct distance between this and the first system.
   All systems will now be the same distance apart as the one you dragged and that above it.

❕ This operation affects the system you drag and all following systems.

Setting the distance between staves within a grand staff

1. Locate the staff you wish to spread apart.
   Click just to the left of its first bar line and keep the mouse button down. The entire staff gets inverted.
2. Drag downwards or upwards and then release the mouse.
   The staff you dragged has now moved down and all the other staves in the system are adjusted accordingly.

Dragging the staves in a piano system apart.
Setting the same distance between staves in several systems

1. Hold down the [Alt]/[Option] key.
2. Drag the desired staff as described above.
3. Release the mouse button and [Alt]/[Option] key.
   The corresponding staves in all following systems are moved accordingly.

Moving one staff only

You may wish to move one staff without affecting any other staff in any way:

1. Hold down the [Ctrl]/[Command] key.
2. Drag any staff as described above.

Moving staves between pages

By using the “Move To Next/Prev. Page” commands on the Layout Functions submenu, you can quickly edit the page breaks:

Moving staves to the next page

1. Locate the staff you want to move to the top of the next page, and make it the Active staff.
   This can be any staff except the first staff one on the page.
2. Pull down the Scores menu and select “Move To Next Page” from the Layout Functions submenu.
   The Active staff (and any following staves on the page) are moved to the next page.

Moving staves to the previous page

1. Make the staff at the top of the page the Active staff.
   If any other staff is Active, Move To Prev. Page will be greyed out. Also, the function will not work for the first staff on the first page.
   The Active staff, and as many of the following staves as there are room for, are moved to the previous page. If the previous page is “full” already, nothing will happen.
Adding Brackets and Braces

Brackets and Braces (curly brackets) are added in the Layout Settings dialog. The settings you make are specific for the current layout, meaning you can have different brackets or braces set up for different track configurations.

1. Pull down the Scores menu and select “Setup” from the Layout Settings submenu.
   In the track list, you will find columns for “Braces” ( { ) and “Brackets” ( [ ).

2. Click in one of the columns and drag downwards in the list to encompass the desired tracks.
   The column indicates graphically which tracks will be encompassed by the brace/bracket.

   ![Click at the first track for which you want a Bracket or Brace...](image1)
   ![...and drag downwards in the list to enclose the desired tracks.](image2)

3. Close the Layout Settings dialog.
   The score is displayed with brackets or braces according to the settings you made.

   • You can edit brackets and braces in the dialog by dragging the ends of the indicator in the list.

   • To remove a bracket or brace, hold down [Ctrl]/[Command] and click on its indicator in the list, at the topmost track.

   • You can automatically get broken bar lines based on the brackets you have added - see page 268.

   • If the option “Show Braces in Edit mode” is activated in the Preferences-Scores dialog, brackets and braces are shown in Edit mode as well.
Auto Layout

This item on the Scores menu brings up a submenu with nine options. Selecting one of these makes the program “walk through” the score and make adjustments to measure widths, staff distances etc. automatically. Exactly which parts and properties of the score are affected depends on which option you select, as described below. For many of the Auto Layout functions, you can make default settings in the Spacings dialog on the Global Settings submenu (see the online help).

- The Auto Layout adjustments are done just as if you yourself had made them manually. This means that if there’s something you don’t like, you can always change it manually, as described above.

Move Bars

This option looks at the currently active grand staff, and attempts to adjust the measure widths, so that all notes and symbols get as much room as possible. The number of bars on the staff is not affected.

- You can perform this function for several staves in one go, by dragging a selection rectangle over their left edges, and then selecting Move Bars.
• You can also perform the Move Bars function by clicking on the Auto Layout button on the extended toolbar.

For this to work, an entire staff must be selected (black) - otherwise a “Bars and staves” operation is performed (see below).

**Move All Bars**

This works like Move Bars, but affects all grand staves from the active one to the end of the score.

**Move Staves**

This changes the measure width (as with Move All Bars) but also the vertical staff distance, of the active staff and all following staves.

**Hide Empty staves**

This hides all empty staves, from the active staff to the end of the score. Note that polyphonic/split staves are in this case treated as one entity, if the clef in the upper system differs from that in the lower system. That is, a piano staff is considered “empty” only if there are no notes on either staff.

• If you have activated the “Hidden” option on the Filter Bar, hidden staves are indicated by a marker with the text “Hidden:Name” (where “Name” is the staff Name).

To reveal hidden staves, either delete their “Hidden” markers, or select Show from the Staff Functions pop-up menu.

• If you activate the option “Auto Layout: Don’t hide first staff” in the Preferences-Scores dialog, staves in the very first grand staff will not be hidden, even if they are empty.

This is useful for example if you are creating an orchestra score, and want to show the complete “layout” of the orchestra on the first page of the score, without hiding anything.
Bars and staves

This is a combination of Move All Bars and Move staves, plus automatic calculation of the number of bars across the page.

When you select this function, you will be asked to specify the maximum number of bars across the page.

• The Bars and staves operation can also be performed by clicking on the Auto Layout icon on the extended toolbar.

For this to work, no staves must be selected (black) - otherwise a “Move Bars” operation is performed (see above).

Spread Page

This corrects the vertical layout of the staves on the current page, so that they “fit onto the page”. In other words, this removes white space at the bottom of the page.

Spread All Pages

This is the same as Spread Page, but affects all pages from the current and onwards.

Optimize All

All of the above in one fell swoop. This procedure might take some time but usually yields great results.
Clean Up Layout

This function allows you to delete invisible layout elements, which in effect restores the score to default settings.

1. Select “Clean Up Layout” from the Layout Functions submenu on the Scores menu.
   A dialog box appears with options as described below.

   ![Clean Up Layout Dialog Box]

2. Turn on the items you want delete or reset to standard settings.

3. Click on the This Staff button to clean up the active staff only, or the All Staves button to clean up all staves.

<table>
<thead>
<tr>
<th>Activate this:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hidden Notes</td>
<td>Make all Hidden Notes permanently visible again.</td>
</tr>
<tr>
<td>Hidden</td>
<td>Make all other hidden objects permanently visible again.</td>
</tr>
<tr>
<td>Quantize</td>
<td>Delete all Display Quantize elements.</td>
</tr>
<tr>
<td>Layout tool</td>
<td>Reset all positions of notes, clefs, slurs and ties altered using the Graphic Move tool.</td>
</tr>
<tr>
<td>Grouping</td>
<td>Reset the grouping under beams to standard values.</td>
</tr>
<tr>
<td>Cutflag</td>
<td>Delete all Cutflag events.</td>
</tr>
<tr>
<td>Stems/Beams</td>
<td>Reset the length of all stems and reset the slant of beams that have been manually adjusted.</td>
</tr>
<tr>
<td>Coordinates</td>
<td>Removes all manual spacing of note symbols and slurs.</td>
</tr>
</tbody>
</table>
Breaking Bar Lines

Sometimes you may not want a bar line to stretch all the way across a grand staff. In this case you might “break it”.

Manually

Breaking Bar Lines in one Grand staff
1. Select the Eraser tool.
2. Click on a bar line connecting the two staves.
   All bar lines between these two staves (except the first and last) are broken. To break the first or last bar line in a Grand staff, you need to click directly on these.

Before and after splitting the bar lines between two staves.

Breaking Bar Lines in several Grand staves
If you hold down [Alt]/[Option] and click on a bar line as above, the corresponding bar lines are broken in all following Grand staves.
Re-connecting Broken Bar Lines

If you have broken the bar lines, you can use the Glue Tube tool to connect them again.

1. Select the Glue Tube tool.

2. Click on one of the bar lines in the staff above the broken bar lines. All bar lines between these staves in this Grand staff are connected.

- To re-connect bar-lines in several Grand staves, hold down [Alt]/[Option] and click with the Glue Tube tool as above. The bar lines between the corresponding staves are connected in all following Grand staves.

Automatically

If you have added brackets for some staves in the Layout Settings dialog (see page 263), you can have bar lines broken between each bracketed “section”, giving a clearer indication of which staves belong together:

1. Pull down the Scores menu and select Notation Style from the Global Settings submenu.

2. Select the Switches tab.

3. Locate and activate the option “Break Bar Lines with Brackets”.

- The option Break Last Brackets determines whether the breaking of bar lines should also apply to the bar line at the end of each row.
Scoring for Drums
In this chapter you will learn:

- How to set up the score drum map.
- How to set up a staff for drum notes.
- How to enter and edit drum notes.
- How to use a Single Line drum staff.

Background: The drum maps and Score edit

When scoring for drums, you can assign a unique note head to each pitch. There is even the possibility to set up different note heads for different note values!

However, in order for you to make full use of this fact you need to understand a bit about drum maps, and the interaction between these and the Score editor.

The Score Drum Map

Cubase SX handles drum editing by assigning drum maps with named drum sounds (this is all described in the MIDI Editing chapter in the Operation manual). In Score edit, an “additional” map is needed to display different note heads for different pitches. This “Score Drum Map” can be looked upon as an extension to the drum map assigned for a MIDI track.

- This means there is one score drum map (with separate settings) for each “regular” drum map in the Project.
You access the Score Drum Map from the Global Settings submenu on the Scores menu.

![Drummap Settings - MIDI01](image)

**Pitch vs. Display Pitch**

In the Drum Maps you will find a Pitch setting and a Display Pitch setting.

- The Pitch setting corresponds to the I-Note for the drum sound and cannot be edited here.
- The Display Pitch value is used to set where vertically on the system the note should be displayed. It can be thought of as a display transpose setting that is individual for each note. Again this only affects how the note is displayed, not how it is recorded etc.
Use Drum Map On/Off

For the Drum Map settings to actually be used in the score, you need to activate the "Use Drum Map" checkbox. This is found in two places: in the Staff Settings dialog (Options tab) and in the Drum Map dialog. Note that these two checkboxes are duplicates - activating one of them will automatically activate the other and vice versa.

Edit in Scores

This is displayed on page 277.
Setting up the Drum Map

Basic Settings

1. Open Score edit for the track for which you plan to score for drums. This should be a MIDI track for which you have assigned a drum map.

2. Select Drum Map from the Global settings submenu on the Scores menu. The Drum Map dialog box appears.

3. If “Use Drum Map” isn’t active, turn it on.
   • When “Use Drum Map” is activated, selecting a note in the score will automatically select the corresponding sound in the Drum Map dialog. This helps you find the desired sounds quicker.

4. Make settings for the sounds/MIDI notes you need. The options are described below.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the drum sound in the map.</td>
</tr>
<tr>
<td>Pitch</td>
<td>This corresponds to the I-Note of the sound in the drum map, and cannot be edited here.</td>
</tr>
<tr>
<td>Disp.</td>
<td>The Display Pitch, i.e. the pitch at which the note will be shown in the score. For example, you typically want all three hi-hat sounds to be shown on the same system line in the score (but with different symbols). Therefore, you set these to the same Display Pitch.</td>
</tr>
<tr>
<td>Head</td>
<td>Clicking in this column opens a window in which you can select a note head symbol for the sound. If “Use Head Pairs” is activated above, you will select a note head pair instead.</td>
</tr>
<tr>
<td>Voice</td>
<td>This allows you to make all notes with this pitch belong to a certain Voice, so that they get a common rest handling and stem direction, for example.</td>
</tr>
</tbody>
</table>

Again, please note that there are as many score drum maps as there are regular drum maps in the Project. Which one you get depends on which drum map is assigned for the edited track. The score drum maps are totally independent of one another. In other words, each pitch can have different settings in different drum maps.
Initializing the Display Pitches

If you click the "Initialize Display Notes" button, all Display Pitch values are reset, so that actual pitch and Display Pitch is the same for each Sound/note.

Using Note Head Pairs

Not only can you have different drum sounds displayed with different note heads, you can also display different note heads for different note values:

1. Activate the "Use Head Pairs" checkbox.
   The "Head" column now shows two heads for each drum sound.

   ![Drummap Settings - MIDI 01](image)

   As you can see, all head symbols are arranged in pairs - by default an "empty" head paired with a "filled" head. Just as with regular notes, the "empty" note heads are used with half notes and larger note values, and the "filled" heads are used with quarter notes and smaller note values.

2. To select a head pair for a Drum Sound/note, click in the Head column to pull down the pop-up menu as usual.
   You will only be able to select the left note head in the Head column (the one used for half notes and longer) - the right note head is automatically selected.
Customizing the Note Head Pairs

If you don't like the default pairs of note heads, you can edit these:

1. Click the “Edit” button.
   Another dialog appears.

2. To change a symbol in a pair, click on it and select a new symbol from the pop-up menu that appears.

3. When you’re done, click Exit to close the dialog.

Editing the Drum Map in the Score

If you activate the checkbox “Edit in Scores” in the Drum Map dialog, you can change the settings for the Score Drum Map directly in the score:

• Transposing a note will change the display pitch of its drum sound - the actual note will not be transposed.

• Double clicking a note allows you to make note head settings for that drum sound.

• Using the “Move to Voice” function will change the Voice assignment of the drum sound.

⚠️ This requires that you leave the Drum Map dialog open - closing the dialog will automatically turn this option off, allowing you to perform normal editing.
Setting up a staff for Drum Scoring

1. Open Staff Settings and select the Options tab.

2. Make sure “Use Score Drum Map” is activated.
   As mentioned above, this can also be activated from the Drum Map dialog.

3. If you want a Single Line Drum staff, activate this option.
   This is described in detail below.

4. If you want Flat Beams, activate this option (see page 136).

5. If you want all stems to end at the same position, activate fixed stems and set a length for Up/Down stems.

   An example of Drum Staff Settings.

   • You may also want to use Polyphonic voices, for separate rest and stem handling.
     However, you can still activate “Fixed Stem Length” in the staff Options dialog if you like. See the chapter “Polyphonic Voicing” for more information about Polyphonic Voices.
Entering and Editing Notes

This is just as entering notes on a normal note system. However, please note:

• Notes are edited using their Display Pitch when the Drum Map is used. This means that when you move a note vertically, you move it to another Display Pitch. What actual pitch it gets depends on which Pitch uses the Display Pitch you now “dropped it on”.

Using Single Line Drum staff

When this option is activated in the Staff Settings (Options tab), there is only one line in the system. Furthermore, notes can only appear below the line, on the line and above the line.

To decide which notes go where, proceed as follows:

1. Open Staff Settings and select the Options tab.
2. Activate Score Drum Map and Single Line Drum staff.
3. Set up the two pitch values to decide which pitches go on the line. Notes below this range automatically wind up below the line and notes above wind up above the line.

When you enter and edit the pitch of notes on a single line drum staff, the best way is to drag the note up or down while watching the Mouse box on the toolbar.
14

Creating Tablature
In this chapter you will learn:

- How to create Tablature, automatically and manually.
- How to control the appearance of the Tablature notes.
- How to edit Tablature.

Cubase SX is able to produce score in Tablature format. This can be done automatically, by “converting” recorded MIDI information. You can also create a Tablature staff from scratch and enter the notes “by hand”.

⚠️ Even though we use the term “converting” in this chapter, please note that Tablature is a mode. You can switch between regular notation and Tablature at any time.

Automatic Creation

This assumes you have a regular score on screen already. We also suggest you perform basic editing like quantizing, to make the score as legible as possible as regular notes, before converting into Tablature.

1. Make sure the notes in the score are inside the range of the instrument.
   Notes with a pitch lower than the open tuning of the lowest string cannot be converted.

2. Open the Staff Settings dialog and click the Tablature tab.
3. Select one of the predefined instruments from the pop-up menu.

4. Activate “Tablature Mode”.

5. If you are not using one of the predefined instruments, set the open tuning of each string using the six value fields. If one string isn’t used, set it to Off, the lowest value.

6. If so desired, activate “No Stems/Rests” and “MIDI Channel 1-6”. No Stems/Rests will give you a score where the notes have no stems and where all the rests are hidden. The “MIDI Channel 1-6” feature is described below.

7. Click Apply.
The Tablature appears. You will get as many note lines as you have activated strings. All the notes will now have a fret number instead of their regular note heads.

8. Edit the Score, if needed.
Generally you can make Display Quantize settings, add symbols etc. as usual. However, editing the actual notes is a bit different from regular notes. See below.
Using “MIDI Channel 1-6”

This feature will make notes automatically appear on the correct string according to their MIDI Channel value.

Normally, the program automatically decides on which string to display a note, by looking at the pitch and then putting the note at the lowest possible string. While you can then manually move note to the correct strings, using the “MIDI Channel 1-6” is automatic, at least if you make the right preparations.

1. Many guitar synthesizers are able to transmit each string on a different MIDI Channel. If you have such an instrument, set it up so that the highest E string transmits on MIDI Channel 1, the B string transmits on MIDI Channel 2 etc.

2. Record the piece. Quantize and edit it as desired.

3. Convert the piece into Tablature, as described above, with the “MIDI Channel 1-6” feature activated.

4. Now, the notes will automatically appear on the right string.
   For example if you played a “B” on the low E-string, it will appear as a “7” on that string, not as a “2” on the A-string.
What the Automatic Tablature Function actually does

The following table describes all the changes made to your staff when you automatically create Tablature. This will help you adjust or "undo" anything you like changed. Details about the functions are found in the "Manual Creation" section, below.

<table>
<thead>
<tr>
<th>Score:</th>
<th>Function:</th>
<th>Setting:</th>
</tr>
</thead>
<tbody>
<tr>
<td>New number of note lines</td>
<td>Staff Settings (Options) – System Lines</td>
<td>Changed to the number of strings on the instrument</td>
</tr>
<tr>
<td>Wider Spacing between note lines</td>
<td>Staff Settings (Options) – Add Space</td>
<td>Raised to &quot;1&quot;</td>
</tr>
<tr>
<td>New Clef</td>
<td>Staff Settings (Main) – Clef</td>
<td>The Tablature clef is selected</td>
</tr>
<tr>
<td>Note heads have numbers</td>
<td>Staff Settings (Tablature) – Tablature Mode</td>
<td>Activated</td>
</tr>
<tr>
<td>Stems disappear (If &quot;No Stems/Rests&quot; was used)</td>
<td>Staff Settings (Tablature) – Tablature Mode</td>
<td>Activated</td>
</tr>
<tr>
<td>Rests disappear (If &quot;No Stems/Rests&quot; was used)</td>
<td>Staff Settings (Tablature) – Tablature Mode</td>
<td>Activated</td>
</tr>
</tbody>
</table>
Manual Creation

To set up an empty system for inputting Tablature, proceed as follows:

1. Change the Clef to the Tablature symbol.

![Edit Clef](image1)

The Tablature clef.

2. Open Staff Settings and select the Options tab.

3. Set the “System Lines” to as many strings as the instrument you are scoring for has.

4. Raise the Add Space value to 1 or 2.

   You will need a little extra space between note lines to make room for the numbered note heads.

![System Sizes](image2)

Suggested system line settings for guitar tablature.

5. On the Tablature tab, activate “Tablature Mode”.

![Tablature Mode](image3)

Tablature Mode activated.

6. Set up whatever other parameters you need in the Staff Settings dialog, and click Apply.
7. Select the Note tool and move the pointer over the score.

8. Press the mouse button (without releasing it) and drag up and down until the note appears on the desired string with the correct fret number (you can also verify the actual pitch on the toolbar, as usual). When you drag up and down, the program automatically selects the lowest possible string. If you want a fret number higher than 4 on a guitar tablature, for example, you have to use “Move To String”, see below.

9. Release the mouse button.
The note appears.

**Tablature Number appearance**

In the Global Text settings dialog (Scores-Global Settings-Text), you will find text settings for the Tablature numbers. This allows you to select any font, size and style for the number note heads.
Editing

Editing Tablature is done as with any score. You can move notes, handle beaming, stem direction etc., as described in other parts of the manual.

Move Notes to another String

If you want for example a “C” to appear as a “8” on the low E-string rather than a “3” on the A-string, on a guitar, proceed as follows:

1. Select one note or a number of notes that you all want to move to a new string.

2. Pull down the Scores menu, select Move To String and from that menu select the desired string.
   The Fret number is automatically adjusted according to the tuning of the instrument (as set up in the Tablature dialog).

Moving Notes

Moving notes in pitch in a Tablature score is just as entering notes manually, see above.

Editing on the Info Line

Using the Info line you can change the pitch of notes as usual. The string and fret number will then be updated automatically in the score.
Note Head Shape

If all you want is a fret number for your notes, you can use the Note Info dialog on regular notes.

1. Double click on the head of a note.
   The Note Info dialog appears.

2. Activate the Tablature option and set a fret number in the value field just beside this.

   ![The Tablature settings in Note Info.]

3. Click Apply and close the dialog.
Printing and Exporting Pages
Printing

Printing from the Score editor

1. Go into Page Mode.
   You cannot print from Edit mode.

2. Select Page Setup from the File menu and make sure all your Printer settings are correct. Close the dialog.

   □ As mentioned earlier in this manual, you should have made settings for paper size, scale and margins before you started working on the page layout. Changing these settings at this point may cause the score to look different.

3. Select Print from the File menu.

4. The standard Print dialog appears. Fill out the options as desired.

5. Click Print.

Exporting pages as image files

You can export a section of a page, or a complete page, in various file formats. This allows you to import your scores into Desktop Publishing and Painting applications.

Selecting a section of a page for exporting

If you only want to export a part of a certain page, proceed as follows:

1. Make sure you are in Page Mode.

2. Pull down the Scores menu and select Select Range from the Global Functions submenu.
   The pointer turns into a cross hair.

3. Drag over the section of the Score you want to include.
   The area is indicated by a black rectangle.
4. If needed, adjust the size of the rectangle by dragging its handles (in the corners) with the Arrow tool. The selection rectangle disappears as soon as you click elsewhere in the score.

5. Proceed with Exporting as described below.

**Exporting**

To Export the Score, proceed as follows:

1. Make sure you are in Page Mode.

2. Pull down the Scores menu and select “Export Scores...” from the “Global Functions” submenu. The Export dialog appears.

3. Select a picture format.
   You can select bitmap, jpeg, portable network graphics (png) or Adobe Photoshop format.

4. Specify a resolution for the file.
   This determines the accuracy with which the image will be created. 300dpi, for example, is the resolution many laser printers use for printing. If the image file will only be displayed on screen in other programs, select 72 or 96 (depending on screen resolution) and it will have the same size as it had in VST.

5. Specify a name and a location for the file and click “Save”.
   The specified section of the score is exported and saved as a file. It can now be imported into any program supporting the selected file format.
Troubleshooting
In this chapter you will learn:

- Reasons to problems you might encounter and how to solve them.

How to use this Chapter

This chapter contains a number of questions that might arise when you use Score edit, and answers to each one. For more information about the functions referred to below, please check the previous chapters. If you don’t know where to look, use the Index.

Adding and Editing Notes

I enter a note with one value and it is shown as a note with another value.

Change the Rest Display Quantize to a smaller note value. Try turning off Auto Quantize, especially if you don’t have any triplets or triplets only.

Notes are not displayed on correct positions.

Try changing the Note Display Quantize value.

There are a number of short rests after my notes.

Your Rest Display Quantize might be set to too small a note value. Raise it. Also check Clean Lengths.

When I change the length of a note, nothing happens.

This is because the Display Quantize value puts a restriction on what note values can be displayed. Check that Display Quantize is actually set to the smallest note value you have in your piece.

I have adjusted Display Quantize and the other Staff Settings best I can.

The notes are still shown with the wrong values.

You might need to use one of three features: inserting Display Quantize events, using Polyphonic Voicing, or applying Score Note To MIDI.
I change the Display Quantize settings in the Staff Settings dialog and nothing happens.

Did you remember to click Apply? Maybe you have already inserted Display Quantize events in the score? These override the Staff Settings.

Suddenly many Display Quantize events appear in the score.

This is not a malfunction. If you have had Auto Quantize on and start inserting Display Quantize events, the Auto Quantizing is automatically transformed into Display Quantize events.

One long note is shown as many tied notes.

Do other notes occur at the same positions but with different lengths? Then you need to use Polyphonic Voicing. Are the note(s) syncopated? Then you should try the syncopation feature.

Even though I've tried the above, notes are not tied as I want them.

The way notes are tied in Cubase SX follows basic notation rules. You may need to make exceptions to these rules, by using the Cut Notes tool.

I have an unnecessarily large amount of rests.

Especially with Polyphonic Voicing, superfluous rests may be created. Try turning off rests for one or more voices. You might also leave the rests on in the Staff Settings dialog (Polyphonic tab) and then Hide the rests you don’t need, one by one.

When using Polyphonic Voices, a number of rests are drawn on top of each other.

As above, you should try Hiding rests (in the Staff Settings dialog, Polyphonic tab), Center Rests and possibly manually moving or hiding rests.
In Polyphonic Voices, notes that are on the same musical position are not displayed exactly vertically above each other.

This is not a malfunction. Cubase SX has built-in automatic algorithms for making the score as legible as possible. Sometimes this will include adjustments of the "graphic" position of notes, especially with small intervals like seconds. You can always move the notes using the Graphic Move tool.

When using Polyphonic Voices, notes with small intervals “collide”.

As described above, Cubase SX tries to avoid this, but only for Voices 1 and 2 in the upper staff and Voices 5 and 6 in the lower. For other Voices, please use the Graphic Move tool to manually move the notes.

When I select a note, nothing is shown on the Info Line.

The note is probably tied to another note. This means that the second note doesn't really exist, it is just a graphic indication that the main note is long. Try selecting the main note instead.
Symbols and Layout

Symbols from the Layout part of the symbol palette are sometimes invisible when I open the score.

This is not a malfunction. Those symbols are part of a Layout. If you open the score with another Layout, for example because you open another combination of tracks, you will see another Layout which might not contain any Symbols at all. See the chapter “Working With Layouts”.

I can’t select an object on the screen, or I can’t select an object without selecting another object.

Use the selection rectangle to drag up (or down) and around the objects. Then hold down [Shift] and deselect all the objects you don’t want included, by clicking on them. You should also check out the Lock Layer function.

Symbols have disappeared.

Are they Layout symbols? Then maybe they belong to another Layout than the one you are editing now.

If that is not the reason, maybe you have inserted the symbol into the wrong staff. Please observe the warning on page 169.

A Symbol doesn’t move with its staff. Auto Layout produces far too wide spacing.

Maybe you have inserted the symbol into the wrong staff. Please observe the warning on page 169.

A Note symbol appears too far from the note I wanted it inserted on.

Do you have the correct voice activated? Note symbols are inserted into voices, just like notes.
In this chapter you will learn:

- A number of useful techniques to help you work more efficiently with Cubase SX Scoring.

Don't forget to check out the example files in the Score Tutorial folder (included on the Cubase SX program CD). They provide a lot of hands-on tips on how to use the program efficiently.

Moving a Note without Transposing it

If you hold down [Ctrl]/[Command] while moving a note (or a number of notes), and drag sideways, you don't have to worry about it being transposed. Another way is to assign key commands (under the Nudge category in the Key Commands dialog on the File menu) for moving notes and other objects.

Moving and Spacing Several staves

If you have a number of staves that you want displayed with an equal distance (for example, all strings of a grand staff in a full orchestra score), this can be done using the Position window:

1. Open the Preferences–Scores dialog and deactivate the option “Global staff Spacing with [Alt-Gr]/[Option]-[Command].”
2. In the score, select the staves that you want to set to an equal distance.
3. Open the Position Window (by clicking on the Ruler).
4. Use the To Previous staff or To Next Staff Settings to specify the desired distance between the staves. Don't close the value box yet!
5. Hold down [Alt Gr]/[Option]-[Command] and press [Return] to close the value box. All selected staves are spaced according to your settings.

- If you do this with the “Global staff Spacing with [Alt-Gr]/[Option]-[Command]” option activated, all staves in the score are affected.
Polyphonic Voicing Tip

If you are working on a full score with more than one instrument in one staff (2 flutes, 2 trumpets etc.), you should use polyphonic voices. And even if both instruments play the same notes, you should insert notes for both instruments (you can mute the notes of the second voice, if playback is an issue). If you do this, it will be much easier to extract single parts later (by using the “Extract Voices” command).

Using the Bar Handles

These are great for copying accents, but you can also use them for copying drum phrases, etc.

• If you hold down [Shift] and double click on a bar handle, this and the next bar are selected. This is handy when copying phrases of two or more bars in one go.

Copying a Section with “Invisibles”

If you want to Copy and paste a section which contains hidden elements, adjusted beams and stems etc., there are two ways to proceed:

• Use the Filter Bar to make indicators appear in the score. Then select these indicators together with the notes before you Copy. This ensures the notes are copied with their formatting etc.

• Double click the bar handle of one of the bars, and make sure all relevant event types are checked in the dialog. Then select the bars you want to copy by [Shift]-clicking their bar handles, and copy them by [Alt]/[Option]-dragging the bar handles.

Using “Score Notes To MIDI”

This function converts the score data, as displayed, to MIDI data. You might run into a situation when your score is displayed to 99% of perfection. That last 1% forces you to turn off functions in Staff Settings (like Clean Lengths, No Overlap and Auto Quantize) which makes the other parts of the score illegible. In this case, try “Score Notes To MIDI”. But work on a copy of the track! For more info, see page 58.
Optimizing Rests

If you have a number of consecutive empty bars you can replace them with one multiple rest. See page 249.

Zero System Lines

Having no System lines at all might seem like a stupid idea to start with. But, this option allows you to create chord sheets really quickly. See the Make Chords feature described on page 211.

![Lead sheet example](image)

A lead sheet created by specifying “0” system lines.

Examples and Scales

If you are creating scale examples and similar, you can use the Real book option and manually hide all symbols at the beginning of the first staff to make the score appear like separate unconnected “lines”.

For scales, remember you can also hide the bar lines.

![Scale example](image)

An example scale without bar lines.
Controlling the order and appearance of Grace Notes

Grace Notes are normally beamed. Their order under the beam is controlled by their order in the track. It is enough to put a grace note one tick before the next grace note to make them appear in the desired order under the beam.

Initially the grace notes are put in with a 32nd note beam. By double clicking the note and changing the “flag” type in the Note Info dialog, you can change this. If you click the “As Default” button in the dialog, your selection will be used as default for all subsequent grace notes.

![Complex grace notes.](image)

Speeding up Inserting Key Changes

If you have a grand staff with many instruments, inserting key changes one by one can take an awful lot of time.

If you instead insert the new key on one staff and hold down [Alt]/[Option] when clicking with the Pencil tool, this key change is inserted on all staves in the Grand staff.

Speeding up Inserting Staccato and Accents

Symbols linked to notes can also be put in for a number of notes at the same time, even on different staves. See page 172.

Setting the Distance between staves in a Piano Score

Hold down [Alt]/[Option] while dragging the first bass staff on the first page. This will copy the spacing to all staves. Please note that this can only be done in Page Mode.
If you wish you had a faster computer

Here are some tips for those who find some operations slower than they would like:

- Work on a smaller section of the score at a time. Break the piece up into parts and work on those parts individually until the final layout stage.
- Switch on Multi Rests as late as possible.
- When working in Edit mode, set Default Bars Across The Staff to a small value, for example 2.
- In Edit mode, resize the window so that only one grand staff at a time is visible.
- Consider upgrading your computer hardware.
Index
A
Accents above Staves 171
Accents above Stems 171
Accidentals
  About 129
  Distance From Note 133
Active Staff 23
Add Space 99
Adding Notes 68
Align
  Dynamics 201
  Symbols 198
  Text 221
Apply closes Property Windows 29
Auditioning 76
Auto Clef 34
Auto Group Notes 140
Auto Layout
  About 264
  Bars and Staves 266
  Hide Empty Staves 265
  Icon 265, 266
  Move All Bars 265
  Move Bars 264
  Move Staves 265
  Optimize All 266
  Spread All Pages 266
  Spread Page 266
Auto Quantize 47
Auto scroll 21

B
Bar Handles 191, 303
Bar Lines
  Breaking 268
  Hidden 252
  Indent 258
  Moving 258
  Selecting Type 251
Bar Numbers
  Offsetting 233
  Settings 232
  Spacing 233
Bars
  Moving to Next/
    Previous Staff 257
  Number Across Page 256
  Resetting Spacing 259
Bars and Staves 266
Bass To Lowest
  Explode Function 59, 113
Beam Subgroups 52
Beams
  Appearance 143
  Group Settings 142
  Grouping 136
  Manual Adjustment 144
  On/Off 136
  Slant 143
  Stem Direction 125
Bow Up/Down 133
Box symbol 203
Braces 263
Bracket Head 133
Brackets 263
Build N-Tuplet 155, 156
Build Trill 176

C
Chord Symbols
  Global Settings 213
  Inserting Automatically 211
  Inserting Manually 208
Clean Lengths 47
Clean Up Layout 267
Clefs
  Editing 89
  Inserting 88
  Moving 90
  Setting Initial 32
Common Time 30
Consolidate Rests 52
Copy 79, 197
Crescendo
  Drawing 200
  Flipping 201
  Keeping Horizontal 201
Cross Staff Beaming 141
Crossed Voicings 118
Cue Notes 150
Custom Palette 168
Cut 79
Cut Notes Tool 146
Cut Time 30
Cutflag Events 146

D
Damper Pedal Symbols 203
Default Bars Across The Page 256
Delete
  Notes 74
  Symbols 197
Dialogs 29
Diminuendo
  Drawing 200
  Keeping Horizontal 201
Display Arrow after Inserting Symbol 170
Display filter bar 25, 28
Display Length 84, 133

Display Quantize
  About 10
  Auto 47
  In Polyphonic Voices 116
  Inserting Changes 56
  Rest 12
  Setting 46
  Tool 14
Display Quantize Tool 56
Display Transpose 37, 50
Double Click Symbol to get Pencil Tool 170
Drum Map
  About 272
  Display Pitch 273
  Initializing 276
  Setting Up 275
Drum Notes
  About 272
  Adding and Editing 279
  Head Pairs 276
  Setting Up The Staff 278
  Single Line 279
Duplicate
  Notes 78
  Symbols 188
  Using Bar Handles 191

E
Edit All Parts on Track 19
Edit Drum Map in Scores 277
Edit Mode 20
Ending Symbols 204
Enharmonic Shift
  Manual 130
Eraser Tool 74, 268
Event Lock Layers 186
Explode 58, 113
Exporting as Image Files 292
Extract Voices 121
F
F button 25
Filter bar 25, 28
Find and Replace 230
Fit Page/Width 22
Fixed Stem Length 100
Flat Beams 52
Flat Ties 147
Flip
Crescendo 201
Slurs and Ties 196
Stems 125
Fonts 220, 234
For Grouping Only option 31, 137
Force Update 39

G
Get Form 238
Global Layer 160
Global Staff Spacing 302
Global Symbols 162
Global Text 227
Glue Tube Tool 83, 257
Grace Notes
  Converting to Normal 154
  Creating Manually 152
  Order of 305
  Settings 153
Graphic Move Tool 90
Graphic Move tool 148, 174
Graphic Note Type 134
Graphic Notes (Symbols) 201
Group Icon 137
Grouping
  Automatic 140
  Manual 137
  Removing 139
Guitar Chord Symbols 179
Guitar Library 181

H
Help Lines 133
Hide Empty Staves 265
Hide Pedal Markers 203
Hiding Objects 246

I
Indent 258
Info Line 25, 83
Insert buttons 110
Insert Slur 175
Interpretation Flags 47, 96

K
Keep Crescendi Horizontal 201
Keep Moved Notes within Key 69, 76
Key
  Editing 89
  Inserting Changes 88
  Setting Initial 35
Keyboard Symbol 177

L
L Button 77
Layout Layer 160
Layout Settings dialog 242
Layout Symbols 161
Layouts
  About 236
  Creating 237
  Opening Tracks In 238
Length of Notes 82
Lines To Voices
  Explode Function 59, 113
Lock button 77
Lock Layers 186
Lyrics
   About 224
   In Voices 226
   Inserting Manually 225

M
Magnification 22
Magnifying Glass tool 23
Make Chord Symbols 211
Marker Track to Form 240
Melisma Lines 219
Merge All Staves 120
MIDI In Button 81
Modern Time Signature 244
Mouse Position Box 67
Move All Bars 265
Move Bars 264
Move Staves 265
Move To Next/Prev. Page 262
Moving
   Between Voices 112
   Notes 75
   Staves 260
   Symbols 188
   Using Bar Handles 191
   Using key commands 77
   Using the Arrow Keys 149
Multi Insert 172
Multi Rests
   Creating 249
   Settings 250
   Splitting 249

N
No Beams 52
No Overlap 48
No Stems 133
Non-modal dialogs 29
Note Dependant Symbols 161
Note Info Dialog 131, 132
Note Layer
   About 161
Note Symbols
   About 161
   Adding 171
Note Values 65
Notes
   Adding 68
   Deleting 74
   Display Length 84
   Duplicating 78
   Editing Via MIDI 81
   Graphic 134
   Graphic Move 148
   Grouping 137
   Head Shape 131
   Help Lines 133
   Info Dialog 127
   Length 82
   Moving 75
   Note Values 65
   Selecting 72
   Splitting 84
Nudge key commands 191
Nudging notes 77
Number Of Bars Dialog 256

O
Octave Symbols 202
Offset Bar Numbers 233
Optimize All 266
Optimize Two/Four Voices 108
Page mode 20
Page Numbers 227
Page Setup 24
Page Text 227
Page Up and Down keys 21
Page, selecting 21
Paste 79, 197
Paste Note Attributes 135
Pedal Symbols 203
Pencil tool 170
Piano Staff
  Fixed Split Point 85
  Variable Split Point 108
Pickup Bar 253
Polyphonic Presets 108
Polyphonic Voicing 101
  About 102
  Automatic 120
  Checking Notes 111
  Display Quantize 116
  Entering Notes 110
  Moving Notes To Voices 112
  Presets 108
  Rest Handling 115
  Setting Up 105
  Stem Direction 125
Position cursor 20
Position Window 189
Printing
  From Score Edit 292
  Making Settings 24
Project cursor 20
Q
Q Tool 56
Quantize Tool 14
Quantize Value 66
Real Book 243
Rehearsal Marks 204
Repeats Symbols 203
Rests
  Creating Multi Rests 249
    In Polyphonic Voices 106, 115
  Ruler 25, 189
Scale pop-up menu 22
Scissors Tool 84, 257
Score Title 227
Score Toolbar
  Showing and Hiding 25
Scores Notes To MIDI 59
Scrolling 21
Selecting
  Layouts 238
  Notes 72
  Symbols 185
Show Braces in Edit mode 263
Show command 247
Show Long Staff Names on new
  Pages 231
Show Long Track Names on new
  Pages 95
Show Marker Track 240
Show Note Info
  by the Mouse 68, 76
Shuffle 50
Single Line Drum Staff 279
Size (System) 99
Slurs
  Adding 174
    Shape and Direction 195
Speaker Icon 76
Spectacle Bass 139
Split Note
  Explore Function 59, 113
  Piano Staff 86
Split Staff
  Normal 85
Spread All Pages 266
Spread Page 266
Staff Mode
  Split 85
Staff Names
  Displaying 231
  Long and Short 231
Staff Options 98
Staff Presets 94
Staff Separators 244
Staff Settings
  About 44, 62
  Options tab 51
  Switching Staves 44, 63
  Values For Note Input 64
Staff Size 245
Staves
  Moving 260
  Relation to Tracks 19
Stem Direction
  About 124
  In Polyphonic Voices 125
  Manual Flip 125
  Note Info Dialog 134
Stems Hidden 133
Stems Length 128
Symbol Palettes
  About 27
  Available Symbols 165
  Customizing 168
  Displaying 163
  Moving and Handling 164
Symbols
  Adding 173
  Adding to Notes 171
  Aligning 198
  Deleting 197
  Duplicating 188
  Guitar Chords 179
  In Palettes 165
  Moving 188
  Moving with Keyboard 191
  Note Dependant 161
  Note Symbols 161
  Relation to Staves and Voices 169
  Resizing 195
  Selecting 185
Syncopation 49
System Lines 99
System Sizes (Staff Settings) 99
T
Tablature
  Automatic Creation 282
  Clef 286
  Editing 288
  Manual Creation 286
  MIDI Channels 284
  Number Note Head 287
Tempo Change Symbol 205
Tempo Symbols 205
Text
  Adding 218
  Aligning 221
  Editing 220
  Font, Size and Style 220
  Lyrics 224
  Melisma Lines 219
  Page Text 227
  Regular 224
  Replacing Words 230
Text Attribute Sets
   - About 222
   - Creating 222
   - Using 222

Ties
   - About 70, 145
   - Adding As Symbols 174
   - Direction 134
   - Flat 147
   - Shape and Direction 195
   - Splitting 84
   - Using the Cut Notes Tool 146

Time Signature
   - Composite 31
   - Editing 89
   - Grouping 31
   - Inserting 88
   - Modern 244
   - Relation to Tempo Track 32
   - Setting Initial 30

Track/Staff relation 19
Transcription 42
Transposing 80
Transposing Instruments 37
Trills 176
Tuplets 155
   - Display Options 157
   - Group Symbols 202

U
   - Upbeats 253
   - Upd button 39
   - Use Colors for Additional Meanings 134, 187

V
   - Variable Split 108
   - Voice Insert buttons 110
   - Voices
      - About 102
      - Checking Notes 111
      - Converting to Tracks 121
      - Display Quantize 116
      - Entering Notes Into 110
      - Moving Notes To 112
      - Rest Handling 115
      - Setting Up 105
      - Stem Direction 125

W
   - Words Palette 229

X
   - X-stem (spoken) 133

Z
   - Zoom pop-up menu 22